Reports
Version 9 Release 1.2
September 23, 2015

Installation and Configuration Guide

IBM

Note
Before using this information and the product it supports, read the information in “Notices” on page 161.

This edition applies to version 9, release 1, modification 2 of IBM Reports and to all subsequent releases and
modifications until otherwise indicated in new editions.
© Copyright IBM Corporation 1999, 2015.
US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract
with IBM Corp.

Contents
Chapter 1. Installation overview . . ..

1

Installation roadmap. .
How the installers work
Modes of installation .
Installation files . .

1
4
5
5

.
.
.
.

.
.
.
.

.
.
.
.

.
.
.
.

.
.
.
.

.
.
.
.

.
.
.
.

.
.
.
.

..
..
..
..

Chapter 2. Planning the IBM EMM
reports installation . . . . . . . . ..

7

Prerequisites . . . . . . . .
Prerequisites for eMessage Reports .

7
8

.
.

.
.

.
.

.
.

..
..

Chapter 3. Installing reporting
components . . . . . . . . . . ..

11

Assigning a role to or removing a role from a user
Configuring a user with the ReportsSystem role
Installing reporting schemas on the IBM EMM
system . . . . . . . . . . . . . . ..
Creating JDBC data sources . . . . . . . ..

11
12

Chapter 4. Install and test IBM Cognos
BI . . . . . . . . . . . . . . . ..

15

IBM
IBM
IBM
IBM

Cognos
Cognos
Cognos
Cognos

BI
BI
BI
BI

applications . . . . . . . ..
installation options . . . . ..
web applications and the web server
and locale . . . . . . . ..

Chapter 5. IBM EMM and Cognos
integration . . . . . . . . . . . ..
Installation checklist: IBM Cognos integration . ..
Obtain the JDBC driver for the Marketing Platform
system tables . . . . . . . . . . . . ..
Installing the reporting models and integration
component on the IBM Cognos system . . . ..
Creating IBM Cognos data sources for IBM EMM
application databases . . . . . . . . . ..
Setting up email notifications . . . . . . ..
Configuring IBM Cognos Application Firewall for
IBM EMM . . . . . . . . . . . . . ..
For eMessage reports, installing stored procedures
for delta processing. . . . . . . . . . ..
For eMessage reports, creating stored procedures,
staging tables, and indexes . . . . . . . ..
Loading templates for Reports SQL Generator . ..
Generating view or table creation scripts . . ..
SQL scripts by data source . . . . . . ..
Creating views or materialized views for Campaign
or eMessage . . . . . . . . . . . . ..
Creating views or materialized views for Interact ..
Creating and populating reporting tables for
Campaign . . . . . . . . . . . . . ..
Creating and populating reporting tables for Interact
Importing the reports folder in Cognos Connection
Configuring and publishing the data model . ..
Enabling internal links in the reports . . . . ..
© Copyright IBM Corp. 1999, 2015

11
11

15
15
16
16

17
17
17
18
19
20
20
21
22
23
23
24
25
26
28
29
29
30
31

Verifying data source names and publishing . ..
Configuring Cognos reporting properties in
Marketing Platform. . . . . . . . . . ..
Setting report folder permissions . . . . . ..
Configuring report folder permissions . . ..
Running and scheduling stored procedures for
eMessage . . . . . . . . . . . . . ..
Stored procedures for the Interact Event Pattern
report . . . . . . . . . . . . . . ..
Enabling the stored procedures for the Interact
Event Pattern report . . . . . . . . . ..
For Interact Event Pattern report, changing the
degree of parallel execution . . . . . . . ..
How to read the UARI_DELTA_REFRESH_LOG
table for the Interact Event Pattern report . . ..
Testing your configuration before enabling
authentication . . . . . . . . . . . ..
Configure IBM Cognos to use IBM EMM
authentication . . . . . . . . . . . ..
Creating the reports system user . . . . ..
Configuring Cognos authentication properties in
IBM EMM . . . . . . . . . . . . ..
Configuring IBM Cognos to use IBM EMM
Authentication Provider . . . . . . . ..
Configuring additional settings for Marketing
Platform . . . . . . . . . . . . ..
Testing your configuration with authentication
configured. . . . . . . . . . . . . ..

Chapter 6. Configuring reporting . ..
Reporting and security . . . . . . . . ..
Report folder permissions . . . . . . ..
Using IBM EMM Authentication Provider to
secure IBM Cognos BI system . . . . . ..
Reporting permissions reference . . . . ..
Reporting schemas . . . . . . . . . . ..
Reporting SQL Generator . . . . . . . ..
Reporting deployment options . . . . . ..
Control groups and target groups in the reports
Audience levels and the reports . . . . ..
Audience keys in reporting schemas . . . ..
Partitions and reporting schemas . . . . ..
Framework Manager data models . . . . . ..
Report Studio reports . . . . . . . . . ..
Folders, subfolders, and access settings . . ..
Report styles and appearance . . . . . ..
Setting up schedules for generating reports . ..
Customizing reporting schemas . . . . . ..
Reporting schema . . . . . . . . . ..
Adding contact or response metrics . . . ..
Adding custom attributes. . . . . . . ..
Adding response types . . . . . . . ..
Adding contact status codes . . . . . . ..
Specifying the calendar time periods for
performance reports . . . . . . . . ..

31
32
32
33
33
40
42
45
46
48
49
49
50
51
52
52

55
56
56
57
58
59
59
60
61
61
61
61
62
62
63
63
64
64
64
64
65
66
66
66

iii

Configuring audience level for performance
reports and response history. . . . . . ..
67
Reporting schemas for extra audience levels or
partitions . . . . . . . . . . . . . ..
67
Creating a Campaign Offer Response Breakout
schema . . . . . . . . . . . . . ..
68
Creating a Campaign Offer Contact Status
Breakout schema . . . . . . . . . ..
69
Creating an Offer Performance schema . . ..
69
Creating a Campaign Performance schema . ..
70
Creating a Campaign Custom Attributes schema 70
Creating an Interact Performance schema . ..
71
Customizing the IBM Cognos Model . . . . ..
71
Adding attributes to an existing view or table in
a data model . . . . . . . . . . . ..
72
Adding new views to IBM Cognos data model
73
Customizing or creating Cognos reports for IBM
EMM applications . . . . . . . . . . ..
74
Guidelines for creating new Campaign reports . 74
Configuring the Interaction Point Performance
dashboard portlet . . . . . . . . . ..
75
Guidelines for creating new, custom dashboard
reports . . . . . . . . . . . . . ..
75

Chapter 7. User authorization for
Cognos folders and reports. . . . ..
How to implement CJAP security . . . . . ..
Performing backups for CJAP . . . . . ..
Editing and synchronizing the property file ..
Configuring the new namespace provider in
Cognos . . . . . . . . . . . . . ..
Verifying synchronization. . . . . . . ..
Assigning Cognos permissions to the new roles
Removing the Everyone group from the Cognos
System Administrators role . . . . . . ..
Giving all Reports users read-only permissions in
public folders. . . . . . . . . . . ..
Securing public folders . . . . . . . ..
Verifying user permissions in Cognos. . . ..
Removing the CJAP implementation from your
environment . . . . . . . . . . . . ..

Chapter 8. Configuring reporting for
multiple partitions . . . . . . . . ..
Configuring the IBM Cognos Reports for multiple
partitions . . . . . . . . . . . . . ..
Prerequisites for multiple partitions . . . . ..
Running the reporting partition tool to create a copy
of the reports archive zip file . . . . . . ..
Creating a copy of the Cognos model for Campaign
Creating a copy of the Cognos model for eMessage
Updating the partition's report properties on the
IBM EMM Configuration page . . . . . . ..
Updating the partition's report properties . ..

Chapter 9. Upgrading reports . . . ..
Upgrade prerequisites . . . . . . . . . ..
Generating SQL to drop views, materialized views,
or tables and run SQL in product databases . ..

iv

Reports: Installation and Configuration Guide

77
77
78
78
79
79
80
80
81
81
82
82

83
83
83
84
84
85
86
86

89
89
91

Upgrading reporting schemas on Marketing
Platform . . . . . . . . . . . . . ..
Upgrading reporting templates in the Marketing
Platform . . . . . . . . . . . . . ..
Upgrading IBM EMM integration components. ..
Updating lookup tables for eMessage and Interact
Upgrading views or tables in the product databases

Chapter 10. Upgrading reports from
version 7.5.1 . . . . . . . . . . ..

92
93
93
94
94

95

Upgrading 7.5.1 model and installing new reports
Updating the old Campaign Performance by Cell
reports . . . . . . . . . . . . . . ..
Fixing the cross-object Performance by Cell
reports . . . . . . . . . . . . . ..
Fixing the object-specific Performance by Cell
reports . . . . . . . . . . . . ..
Updating the old Offer Performance Summary by
Campaign reports . . . . . . . . . . ..
Fixing the Offer Performance Summary by
Campaign cross-object report . . . . . ..
Fixing the single object Offer Performance
Summary by Campaign report . . . . ..

95
99
99
101
102
102
104

Chapter 11. Upgrading the 8.x or 9.x
model and installing new reports . ..

107

Appendix A. Report configuration
properties . . . . . . . . . . . ..

113

Reports | Integrations | Cognos [version] . . ..
Reports | Schemas | [product] | [schema name] |
SQL Configuration . . . . . . . . . ..
Reports | Schemas | Campaign . . . . . ..
Reports | Schemas | Campaign | Offer
Performance . . . . . . . . . . . . ..
Reports | Schemas | Campaign | [schema name]
| Columns | [Contact Metric] . . . . . . ..
Reports | Schemas | Campaign | [schema name]
| Columns | [Response Metric] . . . . . ..
Reports | Schemas | Campaign | Campaign
Performance . . . . . . . . . . . . ..
Reports | Schemas | Campaign | Campaign Offer
Response Breakout . . . . . . . . . ..
Reports | Schemas | Campaign | Campaign Offer
Response Breakout | Columns | [Response Type] .
Reports | Schemas | Campaign | Campaign Offer
Contact Status Breakout . . . . . . . . ..
Reports | Schemas | Campaign | Campaign Offer
Contact Status Breakout | Columns | [Contact
Status]. . . . . . . . . . . . . . ..
Reports | Schemas | Campaign | Campaign
Custom Attributes | Columns | [Campaign
Custom Column] . . . . . . . . . . ..
Reports | Schemas | Campaign | Campaign
Custom Attributes | Columns | [Offer Custom
Column] . . . . . . . . . . . . . ..
Reports | Schemas | Campaign | Campaign
Custom Attributes | Columns | [Cell Custom
Column] . . . . . . . . . . . . . ..
Reports | Schemas | Interact . . . . . . ..

113
116
117
118
119
120
121
122
122
123

124

125

126

127
127

Reports | Schemas | Interact | Interact
Performance . . . . . . . . . . . . ..
Reports | Schemas | eMessage . . . . . ..
Campaign | partitions | partition[n] | reports ..

.
.
.
.
.
.

.
.
.
.
.
.

.
.
.
.
.
.

.
.
.
.
.
.

.
.
.
.
.
.

.
.
.
.
.
.

.
.
.
.
.
.

.
.
.
.
.
.

133
..
..
..
..
..
..

133
135
136
138
139
141

Appendix C. Formatting the Campaign
and eMessage Cognos reports . . .. 143
Global report styles .
List report styles . .

.
.

.
.

.
.

.
.

.
.

.
.

.
.

.
.

Crosstab report styles. .
Chart styles . . . . .
Dashboard report styles .

.
.
.

.
.
.

.
.
.

.
.
.

.
.
.

.
.
.

.
.
.

..
..
..

Appendix D. Reports and reporting
schemas by product . . . . . . ..

Appendix B. Formatting the Cognos
reports . . . . . . . . . . . . ..
Global report styles .
Report page styles . .
List report styles . .
Crosstab report styles.
Chart styles . . . .
Dashboard report styles

128
129
129

..
..

eMessage Reports and Reporting Schemas.
Interact Reports and Reporting Schemas .

.
.

148
149
150

153
..
..

155
156

Before you contact IBM technical
support . . . . . . . . . . . . ..

159

Notices . . . . . . . . . . . . ..

161

Trademarks . . . . . . . . . . . . ..
Privacy Policy and Terms of Use Considerations

163
163

143
147

Contents

v

vi

Reports: Installation and Configuration Guide

Chapter 1. Installation overview
An installation of the IBM® EMM reports is complete when you install IBM
Cognos® BI and configure it for IBM EMM applications. The IBM EMM Reports
Installation and Configuration Guide provides detailed information about
configuring IBM Cognos BI, and integrating IBM Cognos BI and IBM EMM.
If you are using eMessage reports, you must complete additional steps to install or
upgrade reports. Also, you must involve your database administrator in the
process of installing or upgrading eMessage reports.
Use the Installation Roadmap section to obtain a broad understanding about using
the IBM EMM Reports Installation and Configuration Guide.

Installation roadmap
Use the installation roadmap to quickly find the information that you need for
installing IBM EMM reports.
The following table provides a high level overview of the IBM EMM reports
installation process, with brief descriptions of the steps involved and information
on where to find detailed instructions:
Table 1. Installation roadmap for reports.
Step

Description

Where to find details

Installing reporting components
Understanding
prerequisites.

Understand system prerequisites that are required for
installing reports.

See IBM Enterprise
Marketing Management
Products Recommended
Software Environments and
Minimum System
Requirements.

Understanding
prerequisites for
eMessage.

Understand additional prerequisites for installing
eMessage reports.

See “Prerequisites for
eMessage Reports” on page
8

Installing IBM EMM
products.

Install the products that provide the data that is used in
reports.

See the individual product
installation guides.

Setting up a system user.

Configure a user with access to the Settings >
Configuration and Settings > Report SQL Generator
pages so you can log in as this user when you need to
configure the reporting properties and generate the SQL
used to create reporting schema.

See “Configuring a user
with the ReportsSystem
role” on page 11.

Installing the reporting
schemas on the machine
where the Marketing
Platform is installed.

Place the IBM master installer and the report pack
installers in the same directory and launch the master
installer.

See “Installing reporting
schemas on the IBM EMM
system” on page 11

Creating JDBC data
sources.

In the application server where the Marketing Platform is
deployed, create JDBC data source connections to the
system table databases for the products you want to use
for reporting.

See “Creating JDBC data
sources” on page 12.

Installing and testing IBM Cognos BI

© Copyright IBM Corp. 1999, 2015
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Table 1. Installation roadmap for reports (continued).
Step

Description

Where to find details

Installing IBM Cognos BI

Use the IBM Cognos documentation to guide your
installation, and then test the system.

See Chapter 4, “Install and
test IBM Cognos BI,” on
page 15.

Installing IBM EMM integration components and report models on the Cognos system
Obtaining the JDBC driver Copy the JDBC driver used for Marketing Platform to the
used for the Marketing
machine where the Cognos Content Manager is installed.
Platform system tables.
When IBM authentication is implemented, Cognos uses
this when it obtains user information.

See “Obtain the JDBC
driver for the Marketing
Platform system tables” on
page 17.

Installing the reporting
models and integration
component on the Cognos
system.

Place the IBM EMM master installer, Marketing Platform
installer, and product report pack installers in the same
directory on the machine where the Cognos Content
Manager is installed, and launch the master installer.

See “Installing the reporting
models and integration
component on the IBM
Cognos system” on page
18.

Creating the Cognos data
sources for the IBM EMM
application databases.

The Cognos applications need to connect to the IBM EMM
application data sources for the reports. Use the
Administration section of Cognos Connection to create
these data sources.

See “Creating IBM Cognos
data sources for IBM EMM
application databases” on
page 19.

Setting up email
notification.

If you want to enable an option for sending a report as an See “Setting up email
email attachment, configure notification in Cognos
notifications” on page 20.
Configuration.

Configuring the Cognos
firewall.

In Cognos Configuration, specify the IBM EMM system as See “Configuring IBM
a valid domain or host.
Cognos Application
Firewall for IBM EMM” on
page 20.

For eMessage, running
Run the scripts that are necessary to create staging tables,
scripts to create staging
indexes, and stored procedures for eMessage reports.
tables, indexes, and stored
procedures.

See “For eMessage reports,
creating stored procedures,
staging tables, and indexes”
on page 22

Loading the templates for
the Reports SQL
Generator.

To implement reporting for Campaign, eMessage, and
Interact, you create reporting views or tables from which
the reports extract reportable data. The reports packs
contain templates that the Reports SQL Generator uses
when generating SQL scripts for creating these views or
tables. In this step, you load these templates into the
Marketing Platform system table database.

See “Loading templates for
Reports SQL Generator” on
page 23.

Generating the view or
table creation scripts.

Set some required configuration properties, and then use See “Generating view or
the Report SQL Generator to produce the SQL for creating table creation scripts” on
the reporting views or tables.
page 23.
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Table 1. Installation roadmap for reports (continued).
Step

Description

Where to find details

Creating the reporting
views or tables.

Create the views or tables in the IBM EMM product
system table databases.

See one of the following
topics:
v “Creating and populating
reporting tables for
Campaign” on page 28
v “Creating and populating
reporting tables for
Interact” on page 29
v “Creating views or
materialized views for
Campaign or eMessage”
on page 25
v “Creating views or
materialized views for
Interact” on page 26
.

Importing the reports
folder.

In Cognos Connection, import the compressed file for
reports.

See “Importing the reports
folder in Cognos
Connection” on page 29.

Configuring and
If the data source login you used when you created the
publishing the data model. Cognos data sources is not the owner of the IBM EMM
system tables, perform this step.

See “Configuring and
publishing the data model”
on page 30.

Enabling internal links in
the reports.

The IBM EMM reports have standard links. To enable
them, you must configure the redirect URL in the Cognos
data model.

See “Enabling internal links
in the reports” on page 31.

Verifying the data source
names and publish.

This step varies, depending on whether you used the
default data source names in Cognos Connection, as
described in that step.

See “Verifying data source
names and publishing” on
page 31.

Configuring the Cognos
reporting properties in
IBM EMM.

Log in to IBM EMM and set Cognos reporting properties.

See “Configuring Cognos
reporting properties in
Marketing Platform” on
page 32.

Configuring report folder
permissions.

To give users permission to run reports from within IBM
EMM applications, assign the default ReportsUser role to
the appropriate user groups or users.

See “Setting report folder
permissions” on page 32.

For eMessage, running
and scheduling stored
procedures.

eMessage reports use data that is contained in staging
tables, which are populated by stored procedures that
perform a delta refresh operation. The scheduling of the
procedures depends on your database. Scheduling the
procedures must be done by a database administrator
who is familiar with your IBM Campaign and eMessage
environments and with your business requirements.
Note: You cannot see data in eMessage reports until you
run the stored procedures.

See “Running and
scheduling stored
procedures for eMessage”
on page 33.

Stored procedures for the
Interact Event Pattern
report.

The Interact Event Pattern report uses the data that is
See “Stored procedures for
contained in staging tables, which are populated by stored the Interact Event Pattern
procedures. The stored procedures perform a delta refresh report” on page 40.
operation.
The Interact ETL triggers the report data aggregation
automatically so you do not need to configure database
jobs to perform a delta refresh.

Chapter 1. Installation overview
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Table 1. Installation roadmap for reports (continued).
Step

Description

Enabling the stored
The Interact Event Pattern report uses the delta refresh
procedures for the Interact process for data aggregation process so that reports can
Event Pattern report
render faster.
For Interact Event Pattern
report, changing the
degree of parallel
executions

Where to find details
See “Enabling the stored
procedures for the Interact
Event Pattern report” on
page 42.

Increase the degree of parallel execution for the Interact
See “For Interact Event
Event Pattern report aggregation process to increase speed Pattern report, changing the
and improve performance.
degree of parallel
execution” on page 45.

Testing your configuration After the reports are installed and configured, but before
See “Testing your
without authentication
you enable authentication, test the setup by running some configuration before
enabled.
reports.
enabling authentication” on
page 48.
Configuring Cognos to use The IBM EMM Authentication Provider enables the
IBM EMM authentication. Cognos applications to use IBM EMM authentication to
communicate with the Marketing Platform as if it were
another application in the suite. This step has several
sub-steps.

See “Configure IBM Cognos
to use IBM EMM
authentication” on page 49.

Testing your configuration After you configure Cognos to use IBM EMM
with authentication
authentication, test the system again.
configured.

See “Testing your
configuration with
authentication configured”
on page 52.

Customizing reports
Completing customization
steps.

At this point, reporting is working properly and the
example reports are in their default state. You may need
to customize the reports or reporting schemas for
Campaign, Interact, or Marketing Operations.

See “Customizing reporting
schemas” on page 64.

How the installers work
You must use the suite installer and the product installer when you install or
upgrade any IBM EMM product. For example, for installing Marketing Platform,
you must use the IBM EMM suite installer and the IBM Marketing Platform
installer.
Make sure that you use the following guidelines before you use the IBM EMM
suite installer and the product installer:
v The suite installer and the product installer must be in the same directory on the
computer where you want to install the product. When multiple versions of a
product installer are present in the directory with the master installer, the master
installer always shows the latest version of the product on the IBM EMM
Products screen in the installation wizard.
v If you are planning to install a patch immediately after you install an IBM EMM
product, make sure that the patch installer is in the same directory as that of the
suite and product installers.
v The default top-level directory for IBM EMM installations is /IBM/EMM for UNIX
or C:\IBM\EMM for Windows. However, you can change the directory during
installation.

4

Reports: Installation and Configuration Guide

Modes of installation
The IBM EMM suite installer can run in one of the following modes: GUI mode,
console mode, or silent mode (also called the unattended mode). Select a mode
that suits your requirements when you install Marketing Platform.
For upgrades, you use the installer to perform many of the same tasks that you
perform during the initial installation.

GUI mode
Use the GUI mode for Windows or the X Window System mode for UNIX to
install Marketing Platform by using the graphical user interface.

Console mode
Use the console mode to install Marketing Platform by using the command line
window.
Note: To display the Installer screens correctly in console mode, configure your
terminal software to support UTF-8 character encoding. Other character encoding,
such as ANSI, will not render the text correctly, and some information will not be
readable.

Silent mode
Use the silent or unattended mode to install Marketing Platform multiple times.
The silent mode uses response files for installation, and does not require user input
during the installation process.
Note: Silent mode is not supported for upgrade installations in clustered web
application or clustered listener environments.

Installation files
Installation files for all IBM EMM products are named according to the version of
the product and the operating system on which they must be installed, except
UNIX. For UNIX, different installation files exist for the X Window System mode
and the console mode.
Example
The following table displays examples of the installation files that are named
according to the product version and the operating system:
Table 2. Installation files.
Operating system

Installation file

Windows: GUI and console mode

Depending on your product, the installation
file can be Product_N.N.N.N_win64.exe or
Product_N.N.N.N_win.exe, where Product is
the name of your product, N.N.N.N is the
version number of your product.

Chapter 1. Installation overview
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Operating system

Installation file

UNIX: X Window System mode

Depending on your product, the installation
file can be Product_N.N.N.N_solaris64.bin
or Product_N.N.N.N_solaris.bin, where
Product is the name of your product,
N.N.N.N is the version number of your
product.

UNIX: Console mode

Product_N.N.N.N.bin, whereProduct is the
name of your product, and N.N.N.N is the
version number of your product. This file
can be used for installation on all
UNIX-based operating systems.

Reports: Installation and Configuration Guide

Chapter 2. Planning the IBM EMM reports installation
When you plan your IBM EMM reports installation, you must ensure that you set
up your system correctly, and that you configure your environment to deal with
any failures.

Prerequisites
Before you install or upgrade any IBM EMM product, you must ensure that your
computer complies with all the prerequisite software and hardware.

System requirements
For information about system requirements, see the Recommended Software
Environments and Minimum System Requirements guide.

Network domain requirements
The IBM EMM products that are installed as a suite must be installed on the same
network domain to comply with the browser restrictions that are designed to limit
the security risks that can occur with cross-site scripting.

JVM requirements
IBM EMM applications within a suite must be deployed on a dedicated Java™
virtual machine (JVM). IBM EMM products customize the JVM that is used by the
web application server. If you encounter errors that are related to the JVM, you
must create an Oracle WebLogic or WebSphere® domain that is dedicated to the
IBM EMM products.

Knowledge requirements
To install IBM EMM products, you must have a thorough knowledge of the
environment in which the products are installed. This knowledge includes
knowledge about operating systems, databases, and web application servers.

Internet browser settings
Make sure that your internet browser complies with the following settings:
v The browser must not cache web pages.
v The browser must not block pop-up windows.

Access permissions
Verify that you have the following network permissions to complete the
installation tasks:
v Administration access for all necessary databases.
v Read and write access to the relevant directory and subdirectories for the
operating system account that you use to run the web application server and
IBM EMM components
v Write permission for all files that you must edit
© Copyright IBM Corp. 1999, 2015
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v Write permission for all directories where you must save a file, such as the
installation directory and backup directory if you are upgrading
v Appropriate read/write/execute permissions to run the installer
Verify that you have the administrative password for your web application server.
For UNIX, all installer files for IBM products must have full permissions, for
example, rwxr-xr-x.

JAVA_HOME environment variable
If a JAVA_HOME environment variable is defined on the computer where you install
an IBM EMM product, verify that the variable points to a supported version of
JRE. For information about system requirements, see the Recommended Software
Environments and Minimum System Requirements guide.
If the JAVA_HOME environment variable points to an incorrect JRE, you must clear
the JAVA_HOME variable before you run the IBM EMM installers.
You can clear the JAVA_HOME environment variable by using one of the following
methods:
v Windows: In a command window, enter set JAVA_HOME= (leave empty) and
press Enter.
v UNIX: In the terminal, enter export JAVA_HOME=(leave empty) and press Enter.
export JAVA_HOME= (leave empty)
After the environment variable is cleared, the IBM EMM installers use the JRE that
is bundled with the installers. You can reset the environment variable after the
installation is complete.

Prerequisites for eMessage Reports
If you are using eMessage reports, you comply with specific prerequisites in
addition to the system requirements for installing reports.
See “Prerequisites” on page 7 for information about the system requirements for
installing reports.
For better performance, you might need 40% of the data size as temp table space.
Work with your database administrator to regularly fine-tune your database. For
best results, you can store eMessage system tables in a separate tablespace that is
mounted on a separate, unshared disk.

Settings for IBM DB2®
You must use IBM DB2 version 9.7.8 or higher.
Important: You must set the following value before you begin applying the
eMessage Reports:
db2set DB2_COMPATIBILITY_VECTOR=ORA
Example of sizings for DB2
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For an IBM DB2 Campaign database of approximately 600 GB with most of the
data population in the reporting tables (UCC_*), you might use the following
settings:
v
v
v
v
v
v
v
v

Tablespace page size: 16K
Temp tablespace: 250 GB
db2 update db cfg using auto_reval DEFERRED_FORCE;
db2 update db cfg using decflt_rounding ROUND_HALF_UP;
db2 update db config using LOGFILSIZ 102400;
db2 update db config using logprimary 13;
db2 update db config using LOGSECOND 25;
db2stop force

v db2start
Important: The size of your transaction log can affect reports processing. Review
your database environment requirements, especially the size of the transaction log,
with your database administrator.

Settings for Oracle
You must use Oracle 11g or higher. Review your environment requirements with
your database administrator.
Example of sizings for Oracle
For an Oracle Campaign database of approximately 650 GB with most of the data
population in the reporting tables (UCC_*), you might use the following settings:
v Temp tablespace: 250 GB
v Size for REDO logs: 2 GB
v Number of REDO logs: 4

Settings for Microsoft SQL Server
You must use Microsoft SQL Server 2008 or higher. Review your environment
requirements with your database administrator.
Example of sizings for Microsoft SQL Server
For Microsoft SQL Server database of approximately 520 GB with most of the data
population in the reporting tables (UCC_*), you might use the following settings:
v Temp tablespace: 250 GB

Settings for Internet Explorer
If you use the Internet Explorer browser, make sure that your security settings of
the browser allow automatic prompting for file downloads. Complete the following
steps to verify that the browser allows automatic prompting for file downloads:
1. Open Internet Explorer and go to Tools > Internet Options..
2. In the Security tab, click Custom Level.
3. Scroll down to the Downloads section.
4. Make sure that the Automatic prompting for file downloads option is set to
Enable.
Chapter 2. Planning the IBM EMM reports installation
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Chapter 3. Installing reporting components
To install IBM EMM reporting for your products, you must install reporting
components. Reporting components include IBM EMM integration components
and report models on the IBM Cognos system, and the reporting schemas.

Assigning a role to or removing a role from a user
Use the Edit Roles window to assign a role to or to remove a role from a user.
Complete the following tasks to assign or remove a role from a user:
1. Click Settings > Users.
2. Click the name of the user account that you want to work with.
3. Click Edit Roles.
Roles that are not assigned to the user are shown in the Available Roles box
on the left. Roles that are currently assigned to the user are shown in the Roles
box on the right.
4. Select a role in the Available Roles box. Complete one of the following tasks:
v To assign a role to a user, select a role in the Available Roles box, and click
Add.
v To remove a role from a user, select a role in the Roles box, and click
Remove.
5. Click Save Changes, and then click OK.

Configuring a user with the ReportsSystem role
You must configure a user with the ReportsSystem role to configure reporting
properties and to generate the SQL script that is used to create reporting schemas.
A user with the ReportsSystem role can access the Configuration and Report SQL
Generator pages for configuring reporting properties and generating the SQL script
that is used to create reporting schemas. Configure a user with access to the IBM
EMM Settings > Configuration and Settings > Report SQL Generator pages so
you can log in as this user when you need to configure the reporting properties
and generate the SQL used to create reporting schema.
Complete the following tasks to configure a user with the ReportsSystem role:
1. Create a user. You can also use the platform_admin user.
2. Go to User Roles and Permissions > Report > PartitionN, and assign the
ReportsSystem role to the user that you created.
3. Verify that the user has access to the Settings > Configuration and Settings >
Report SQL Generator pages.

Installing reporting schemas on the IBM EMM system
Use the IBM EMM suite master installer and the reports package installers to
install reporting schemas on the computer where the Marketing Platform is
installed.
Complete the following tasks to install reporting schemas:
© Copyright IBM Corp. 1999, 2015
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1. In the Reports Pack Product Components window, select Reporting Schema.
2. If more than one option appears in the Schema Type Selection window, it
means that the IBM application has prepackaged custom attributes. Complete
one of the following tasks depending on whether custom attributes exist:
v To install reporting schemas that include custom attributes, select Custom.
The sample reports for Campaign are configured to use custom attributes.
Therefore, if you are installing the Campaign report package and you want
the sample reports to function correctly, you must select Custom.
v To install reporting schemas that do not include custom attributes, except
eMessage, select Base. For eMessage, always select Custom.
The installer places the reporting schema in the file system and registers the
schema with Marketing Platform.
3. Complete the following tasks to verify that the reporting schemas are registered
in Marketing Platform:
a. Log in to the IBM EMM system as the platform_admin user.
b. Go to Select > Configuration.
c. Expand Reports > Schemas > ProductName.
If you see the schema configuration properties for your application, your
installation is complete.
If the schema configuration properties for your application do not exist, the
report package has not been registered, and you must register the reports
package manually. Complete the following tasks to register the configuration
properties manually:
a. Open the import_all script from the tools directory under your reports
package installation.
The script is in the tools directory under your reports package installation.
b. Set the value of the MANAGER_TOOLS_BIN_DIR variable to the path of the
tools/bin directory under your Marketing Platform installation.
c. Run the import_all.bat or the import_all.sh script.
The script starts the Marketing Platform configTool utility and registers the
schemas.
d. Verify that the schema configuration properties are present.

Creating JDBC data sources
You must configure a JDBC data source for every IBM EMM for which you want
to enable reporting. The IBM EMM Reports SQL Generator tool must be able to
connect to the IBM EMM application databases to generate SQL scripts that create
reporting tables. The SQL Generator can generate SQL scripts that create views or
materialized views without access to the application databases. However, the SQL
generator cannot validate the SQL without a data source connection.
When you configure JDBC data sources, use the default JNDI name that is listed in
the following table:
Table 3. Default JNDI names
IBM application

Default JNDI name

Campaign

campaignPartition1DS
If there are multiple partitions, create a data source for
each partition.
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Table 3. Default JNDI names (continued)
IBM application

Default JNDI name

Interact

+
campaignPartition1DS for the design-time database
InteractRTDS for the runtime database
InteractLearningDS for the learning tables

If you do not use the default JNDI names, make a note of the names that you use.
You must specify the correct name of the data source when you run the SQL
Generator tool.
If you need more help with this task, see the application server documentation.

Chapter 3. Installing reporting components
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Chapter 4. Install and test IBM Cognos BI
If your license agreement with IBM grants you an IBM Cognos BI license, you can
download the IBM Cognos BI installation media from the IBM Customer Central
website.

IBM Cognos BI applications
IBM Cognos BI is a collection of several applications, servers, and services, that is
organized in a multi-tiered architecture.
When you use IBM Cognos BI with your IBM EMM suite, you use the following
subset of Cognos BI applications:
v IBM Cognos BI Server, which provides storage for reports and folders (plus the
queries and metadata models), the Content Manager.
v IBM Cognos Connection, a web application that you use to import, configure,
and schedule the reports. The application also provides access to the following
additional components:
– Cognos Viewer. Used for displaying reports. Cognos Viewer is the module
that displays the reports in your IBM EMM applications.
– Report Studio. Used for customizing reports and creating new ones.
– Cognos Administration Used for configuring data sources.
v IBM Cognos Framework Manager, the metadata modeling tool that you use to
configure and customize the Cognos data model that supports the IBM Cognos
BI reports for your IBM EMM application.
v IBM Cognos Configuration, the configuration tool that you use to configure
individual Cognos BI components.

IBM Cognos BI installation options
You can install IBM Cognos BI applications in a distributed environment or you
can install all the applications on one computer.
Before you install IBM Cognos BI, use the IBM Cognos BI Architecture and
Deployment Guide to learn about the various components, the installation options,
and the configuration approaches recommended by IBM Cognos.
The IBM Cognos documentation uses two general categories to describe
installations: installing in a distributed environment versus installing all the
components on one computer. For best results, do not install all components on
one computer unless it is for a proof of concept or is a demonstration environment.
Installing the subset of IBM Cognos BI applications that IBM reporting uses
requires that you use two IBM Cognos installers. One provides the IBM Cognos BI
server, the Content Manager, Cognos Configuration, and the web-based user
interfaces. You use a separate installer to install Framework Manager, the metadata
modeling tool because it must be installed on a Windows computer.
See the Cognos documentation for complete installation details.

© Copyright IBM Corp. 1999, 2015
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IBM Cognos BI web applications and the web server
You can host the Cognos Connection and the IBM Cognos BI web applications by
using Microsoft IIS (Internet Information Services) or you can use the Apache
HTTP web server.
IBM does not provide the web server that hosts Cognos Connection and the other
IBM Cognos BI web applications. For Windows, the IBM Cognos documentation
assumes that you are using Microsoft IIS (Internet Information Services) but you
can also use Apache HTTP.
If you use the Apache HTTP server, take care to set up the web aliases for the
Cognos web applications in the VirtualHost configuration directive of the Apache
httpd.conf file correctly: be sure to order the most specific alias first (the script
alias) and set directory permissions for each alias.
Example httpd.conf code snippet
The following example is from an Apache installation on a Windows system. The
Apache server is running on the default port 80.
<VirtualHost *:80>
ScriptAlias /ibmcognos/cgi-bin "C:/cognos/cgi-bin"
<Directory "C:/cognos/cgi-bin">
Order allow,deny
Allow from all
</Directory>
Alias /ibmcognos "C:/cognos/webcontent"
<Directory "C:/cognos/webcontent">
Order allow,deny
Allow from all
</Directory>
</VirtualHost>

Note: The httpd.conf file snippet is an example only. Be sure to configure your
web aliases appropriately for your systems.

IBM Cognos BI and locale
You can install a localized version of the IBM EMM application report package
(other than English) by setting the product language to match the language of the
application report package.
On the system that runs the Cognos Content Manager, open IBM Cognos
Configuration, select Actions > Edit Global Configuration, and configure the
locale for the IBM Cognos BI system. For more information, see the IBM Cognos
Configuration User Guide, available from the Help menu in Configuration Manager.
You can change the product language for the specific user by setting the product
language to match the language of the application report package. To set the
product language, open the Cognos connection, and under User Preferences set
the corresponding product language. You should not change the content language.
If the content language is changed, then the corresponding xpath for the reports
should also be changed.
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Chapter 5. IBM EMM and Cognos integration
After you install IBM Cognos, you must integrate the IBM EMM suite with IBM
Cognos.

Installation checklist: IBM Cognos integration
Integrate IBM Cognos with IBM EMM applications by creating IBM Cognos data
sources and configuring the IBM Cognos application firewall. You must also create
reporting, configure Cognos reporting properties in Marketing Platform, and
configure and test IBM Cognos to use IBM EMM authentication.
The following list provides a high-level overview of how to install and configure
the IBM components and reports on the IBM Cognos system:
1. “Obtain the JDBC driver for the Marketing Platform system tables.”
2. “Installing the reporting models and integration component on the IBM
Cognos system” on page 18.
3. “Creating IBM Cognos data sources for IBM EMM application databases” on
page 19.
4. “Setting up email notifications” on page 20.
5. “Configuring IBM Cognos Application Firewall for IBM EMM” on page 20
6. “For eMessage reports, installing stored procedures for delta processing” on
page 21.
7. “For eMessage reports, creating stored procedures, staging tables, and
indexes” on page 22.
8. “Loading templates for Reports SQL Generator” on page 23.
9. “Generating view or table creation scripts” on page 23
10. “Creating views or materialized views for Campaign or eMessage” on page 25
11. “Creating views or materialized views for Interact” on page 26
12. “Creating and populating reporting tables for Campaign” on page 28
13.
14.
15.
16.

“Creating and populating reporting tables for Interact” on page 29
“Importing the reports folder in Cognos Connection” on page 29
“Configuring and publishing the data model” on page 30.
“Enabling internal links in the reports” on page 31.

17.
18.
19.
20.
21.
22.
23.

“Verifying data source names and publishing” on page 31.
“Configuring Cognos reporting properties in Marketing Platform” on page 32.
“Setting report folder permissions” on page 32.
“Running and scheduling stored procedures for eMessage” on page 33
“Testing your configuration before enabling authentication” on page 48.
“Configure IBM Cognos to use IBM EMM authentication” on page 49.
“Testing your configuration with authentication configured” on page 52.

Obtain the JDBC driver for the Marketing Platform system tables
You must obtain the JDBC driver for the Marketing Platform system tables so that
Cognos can obtain the user information from the Marketing Platform system
tables. Cognos requires the user information for IBM EMM authentication.
© Copyright IBM Corp. 1999, 2015
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Obtain the JDBC drivers and any required associated files that you used to
configure the JDBC data source for the Marketing Platform system tables when
you set up the IBM EMM system. You must also configure Cognos to use IBM
EMM authentication later.
Important: If the JDBC driver exists in the webapps\p2pd\WEB-INF\lib directory,
then you do not need to copy it to the webapps\p2pd\WEB-INF\AAA\lib directory.
Copy the JDBC driver to the computer where the Cognos Content Manager is
installed, to the webapps\p2pd\WEB-INF\AAA\lib directory under your Cognos
installation.

Installing the reporting models and integration component on the IBM
Cognos system
You must install the reporting models and integration components on the IBM
Cognos system. If your installation of Cognos is a distributed installation, you
must install the reports package on the server where Cognos is installed.
Important: If you are installing eMessage reports pack on IBM DB, make sure that
you set the following value before you begin applying the eMessage Reports:
db2set DB2_COMPATIBILITY_VECTOR=ORA
Complete the following steps to install the reports pack:
1. On the server where Cognos Content Manager is installed, place the following
IBM EMM installers in a single directory:
v IBM EMM master installer
v Marketing Platform
v The reports pack installer or installers for the products for which you want
to implement reporting
2. Run the IBM EMM master installer, and select Marketing Platform and the
Reports packages you want to install.
3. Following the prompts, enter the connection information for the Marketing
Platform system table database.
4. When the Marketing Platform installer launches and the Platform Installation
Components window appears, select the Reports for IBM Cognos 10 BI option
and clear the other options
5. When the Marketing Platform installer prompts for the path to the JDBC driver,
enter the fully qualified path for the JDBC driver you copied to the Cognos
system.
6. When the Marketing Platform installer prompts for the location of the IBM
Cognos installation, enter or browse to the top level of the IBM Cognos
installation directory.
The default value that is provided in this field is a static value that is not based
on the actual file structure of your IBM Cognos system.
7. When the report pack installer or installers displays installation options, select
Product Reports Package, and clear the option for the reporting schemas.
This option copies the reports archive to the Cognos computer. You must
import this archive later.
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Creating IBM Cognos data sources for IBM EMM application databases
The IBM Cognos applications need their own data sources that identify the source
of the data for IBM EMM application reports.
The IBM Cognos data models that are provided in the IBM EMM reports packages
are configured to use the data source names that are given in the following table:
Table 4. Cognos data sources
IBM EMM application

Cognos data source names

Campaign

CampaignDS

eMessage

eMessageTrackDS

Interact

InteractDTDS for the design time database
InteractRTDS for the runtime database
InteractLearningDS for the learning database
InteractETLDS for the ETL database

Marketing Operations

MarketingOperationsDS

Leads

LeadsDS for the data mart tables

Distributed Marketing

CollaborateDS for the Distributed Marketing database
CustomerDS for the customer database
CampaignDS for the Campaign database

Use the following guidelines to create Cognos data sources for the IBM application
databases:
v Use the Administration section of Cognos Connection.
v Use the default data source names that are shown in the Cognos data sources
table. Do so, you avoid having to alter the data model.
v The database type that you select must match that of the IBM application
database. Use the Cognos documentation and help topics to determine how to
fill database-specific fields.
For Campaign and eMessage, the appropriate database is Campaign.
v Be sure that you identify the IBM EMM application database and not the
Cognos content store.
v When you configure the Signon section, select the Password and Create a
Signon that the Everyone group can use options.
v In the Signon section, specify the user credentials for the IBM EMM application
database user.
v Consult the Cognos data sources table and ensure that you create all the data
sources that are required by the data model for the reports you are configuring.
For example, the reporting data for Interact is in three databases so you must
create separate Cognos data sources for each one.
v If the Campaign system has more than one partition, create separate data
sources for each partition. For example, if Campaign and eMessage are
configured for multiple partitions, create a separate Campaign and eMessage
data source for each partition.
v Verify that you configured each data source correctly by using the Test
Connection feature.
Chapter 5. IBM EMM and Cognos integration

19

For more information about configuring Cognos data sources, see IBM Cognos
Administration and Security Guide and the Cognos online help.

Setting up email notifications
You can configure IBM Cognos to send IBM EMM reports as email attachments.
This step is optional. When an IBM Cognos report is displayed in the IBM EMM
interface, the Cognos Viewer toolbar in the window includes an option for sending
the report as an attachment in an email.
Before you can set up email notifications, obtain the following information:
v Host name or IP address of your SMTP server
v User name and password for the account on that server
v Email address for the default sender email
Complete the following tasks to set up email notifications:
1. In the Cognos Configuration window, select Data Access > Notification.
2. Specify the host name or IP address of the SMTP mail server and the port by
using one of the following formats:
v host:port
v IPAddress:port
For example, serverX:25 or 192.168.1.101:25. The default SMTP port is
usually 25.
3. To set the user name and password of the account, click in the Value column
and click the pencil icon to open the Value dialog box.
4. Specify the default sender by using the user@company.com format.

Configuring IBM Cognos Application Firewall for IBM EMM
IBM Cognos Application Firewall analyzes and validates requests before the
requests are processed by IBM Cognos servers. To configure the IBM Cognos
Application Firewall for IBM EMM, you must specify the IBM EMM system as a
valid domain or host.
Complete the following tasks to configure IBM Cognos Application Firewall for
IBM EMM
1. In the Cognos Configuration window, select Security > IBM Cognos
Application Firewall.
2. In the Valid domains or hosts property window, enter the fully qualified
computer host name that includes the domain and the port for the computer
where, Marketing Platform is running. For example:
serverXYZ.mycompany.com:7001
Important: If you have a distributed IBM EMM environment, you must
complete the preceding step for every computer on which an IBM EMM
product that provides Cognos reports is installed.
For example, Marketing Platform, Campaign, and Marketing Operations
provide reports.
3. Save the configuration.
4. Restart the IBM Cognos service.
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For eMessage reports, installing stored procedures for delta
processing
IBM eMessage reports require staging tables that are associated with the eMessage
system tables. The system tables are part of the Campaign schema. You must
periodically run stored procedures that process message response data for use in
eMessage reports.
For more information about schema changes, see IBM eMessage System Tables and
Data Dictionary.
The initial setup for the eMessage stored procedures relies on the following new
database scripts:
v acer_indexes_dbname.sql
v acer_scripts_dbname.sql
v acer_tables_dbname.sql
The database scripts are in the Campaign_reportspack_home\cognos10\emessage-ddl
directory for the Oracle, IBM DB2, and Microsoft SQL Server databases.
The scripts set up indexes, tables, views, and stored procedures. The stored
procedures refresh message data to populate the staging tables. The batch
procedures must be run regularly to populate the staging tables. Running the
stored procedures is referred to as delta processing.
The initial runs of the eMessage stored procedures can take a long time to
complete, depending on the amount of data that is contained in your tables.
Subsequent delta processing also can take a long time to complete. You can
significantly reduce the processing time by limiting the number of mailing
instances (containers) that are processed by the stored procedures.
By default, data is processed for the past 90 days. However, you can change the
default value. You can change the default value before or after you run the SQL
scripts for eMessage. For more information about running the SQL scripts, see “For
eMessage reports, creating stored procedures, staging tables, and indexes” on page
22
The following example illustrates the changes that you can make to the
acer_tables script to limit the processing to the previous 30 days, if your database
is Oracle:
Note: The changes include modifying the UARE_MAILING_MASTER view.
Definition of the current view
CREATE VIEW UARE_MAILING_MASTER AS
(
(SELECT UCC_CONTAINER.CAMPAIGNID,UCC_CONTAINER.CONTAINERID,
substr(UCC_CONTAINERATTR.STRINGVALUE,1,100) AS CAMPAIGN_NAME,
UCC_CONTAINER.CONTAINERNAME AS MAILING_INST,
UCC_CONTAINER.CREATED AS MAILING_CREATED,
UCC_CONTAINER.CONTAINERTYPEID CONTAINERTYPEID,
UCC_CONTAINER.CONTCHANNELTYPEID CONTCHANNELTYPEID
FROM
UCC_CONTAINER,UCC_CONTAINERATTR
WHERE
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UCC_CONTAINERATTR.CONTAINERID=UCC_CONTAINER.CONTAINERID AND
UCC_CONTAINERATTR.ATTRIBUTENAME=’CampaignName’ AND
UCC_CONTAINER.CREATED >= sysdate - 91
)

Definition of the modified view for the use case described above (Oracle
database)
CREATE VIEW UARE_MAILING_MASTER AS
(
SELECT UCC_CONTAINER.CAMPAIGNID, UCC_CONTAINER.CONTAINERID,
substr(UCC_CONTAINERATTR.STRINGVALUE,1,100) AS CAMPAIGN_NAME,
UCC_CONTAINER.CONTAINERNAME AS MAILING_INST, UCC_CONTAINER.CREATED AS
MAILING_CREATED FROM UCC_CONTAINER,UCC_CONTAINERATTR WHERE
UCC_CONTAINERATTR.CONTAINERID=UCC_CONTAINER.CONTAINERID AND
UCC_CONTAINERATTR.ATTRIBUTENAME=’CampaignName’
AND
UCC_CONTAINER.CREATED >= sysdate - 30
)

To view all the available report data again, modify the UARE_MAILING_MASTER
view to remove the date filter from the view and refresh all Oracle or DB2
materialized views again. For example, in the sample view creation that is shown
above, remove the following lines:
UCC_CONTAINER.CREATED >= sysdate - 30

For eMessage reports, creating stored procedures, staging tables, and
indexes
Before you render eMessage reports, run specific SQL scripts after you install or
upgrade reporting templates. The SQL scripts create stored procedures and staging
tables.
The Campaign_reportspack_home\cognos10\emessage-ddl directory is on the server
that hosts the IBM Cognos Content Manager, and contains the following database
scripts for Oracle, IBM DB2, and Microsoft SQL Server:
v acer_indexes_dbname.sql
v acer_scripts_dbname.sql
v acer_tables_dbname.sql
Complete the following steps to run the database scripts:
1. Run the following script against the Campaign database:
acer_indexes_dbname.sql
Make sure that you allow sufficient time for the script to complete. The time
that the script requires to complete depends on the amount of data that is
stored in the eMessage system tables. For more information, see “For eMessage
reports, installing stored procedures for delta processing” on page 21
2. Run the following script against the Campaign database:
acer_tables_dbname.sql
This script creates the delta processing staging tables in the eMessage system
schema.
3. Run the following script against the Campaign database:
acer_scripts_dbname.sql
This script creates the stored procedures that you must configure after you
install reports for eMessage.
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When you use the script, if your database is DB2, change the termination
character from ; (semicolon) to ! (exclamation point).
Note: You must configure the stored procedures to run on a regular basis to
populate the staging tables. You cannot see data in the reports until you run the
stored procedures for eMessage reports.
For more information about running and scheduling the stored procedures, see
“Running and scheduling stored procedures for eMessage” on page 33.

Loading templates for Reports SQL Generator
The reports packages for IBM EMM applications that have reporting schemas
contain an SQL script that loads template SQL select statements into the
uar_common_sql table. The Reports SQL Generator uses the templates while
generating SQL scripts for creating the reporting views or tables.
Complete the following steps to run the script that loads the templates:
1. Browse to the schema directory under your report pack installation and locate
the templates_sql_load.sql script.
2. Run the templates_sql_load.sql script in the Marketing Platform database.

Generating view or table creation scripts
You can create reporting views or tables by using the view or table creation scripts.
Reports extract reportable data from reporting views or tables. Use the SQL
Generator to create view or table creation scripts.
If you are using eMessage reports, make sure that you have run the SQL scripts
against the Campaign database to create the staging tables and batch procedures.
For more information, see “For eMessage reports, creating stored procedures,
staging tables, and indexes” on page 22.
Complete the following tasks to create view or table creation scripts:
1. Log in to IBM EMM as a user that has the ReportsSystem role.
Proceed to step 2 if you did not use default JNDI names for JDBC data
sources.
Proceed to step 3 if you used default JNDI names for JDBC data sources.
2. Complete the following steps if you did not use default JNDI names for JDBC
data sources:
a. Select Settings > Configuration > Reports > Schemas > ProductName.
b. Change the default values of the JNDI property to match the JNDI names
that you used for JDBC connections.
3. Select Settings > Reports SQL Generator.
4.
5.
6.
7.

In the Product field, select the appropriate IBM application.
In the Schema field, select one or more reporting schemas.
Select the Database Type.
In the Generate Type field, select the appropriate option (views, materialized
views, or tables).
Note:
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v You cannot select materialized views when the database type is set to
Microsoft SQL Server.
v For eMessage only. For Oracle and IBM DB2, eMessage requires
materialized views. For SQL Server, eMessage requires views.
For more information about creating views or materialized views for
eMessage, see “Creating views or materialized views for Campaign or
eMessage” on page 25.
Important: If the JNDI data source names are incorrect or have not been
configured, the SQL Generator cannot validate the SQL scripts that create
tables.
8. Ensure that Generate Drop Statement is set to No.
9. If you want to examine the SQL script that is generated, click Generate. The
SQL Generator creates the script and displays it in the browser window.
10. Click Download.
The SQL Generator creates the script and prompts you to specify the location
for the file to be saved. If you selected a single reporting schema from the
Schema field, the script name matches the name of schema, for example
eMessage_Mailing_Performance.sql. If you selected more than one reporting
schema, the script name uses the product name, for example Campaign.sql.
Note: When you run a script that creates materialized views on a DB2
database, your database might display the following error:
"SQL20059W The materialized query table-name may not be used to
optimize the processing of queries."
However, the materialized view is successfully created.
Note: When you run a script that creates materialized views on a DB2
database, your database might display the following error:
SQL20059W The materialized query table-name may not be used to optimize
the processing of queries.
11. Specify the location where you want to save the script, and click Save. If you
change the name of the file, make sure to use a name that clearly indicates the
schemas that you selected.
12. Repeat steps 5 through 12 for each script that you want to generate.
Note: The Interact reporting schemas reference multiple data sources.
Generate a separate SQL script for each data source.
When you generate the SQL scripts for Campaign reports, such as Campaign
Extended Attributes, the generator can create single lines that are more than 2499
characters long. Because Oracle has a maximum line length of 2499 characters, you
must fix the script by adding line breaks (CR/LF) in strategic places within the
long lines.

SQL scripts by data source
Use separate SQL scripts to create views or materialized views for each data
source.
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The following table provides information about the scripts that you must generate
for each data source, the resulting script name, and the scripts that must be run
against the IBM EMM application database for creating views or materialized
views:
Note:
v The table lists the default names for the data sources and the generated scripts,
which you might have changed.
v The Interact reporting schemas reference more than one data source. Generate a
separate SQL script for each data source.
Table 5. SQL scripts by data source
Reporting schema

Data source (default names)

Script name (default names)

All Campaign reporting schemas

Campaign system tables

Campaign.sql, unless you generated
separate scripts for each reporting
schema. If you did, each script is
named after the individual schema.

(campaignPartition1DS)
eMessage Mailing Performance

eMessage tracking tables, which are
with the Campaign system tables

eMessage_Mailing_ Performance.sql

(campaignPartition1DS)
Interact Deployment History, Interact
Performance, and Interact Views

Interact design time database

Interact Learning

Interact Learning tables

Interact.sql

(campaignPartition1DS)
Interact_Learning.sql

(InteractLearningDS)
Interact Run Time

Interact run time database

Interact_Runtime.sql

(InteractRTDS)

Creating views or materialized views for Campaign or eMessage
You can use SQL scripts to create views or materialized views for Campaign or
eMessage. Reports uses views or materialized views to extract reportable data.
Note: For Oracle and DB2, eMessage requires mateiralized views. For SQL Server,
eMessage requires views.
Complete the following steps to create views or materialized views for Campaign
or eMessage:
1. Locate the SQL scripts that you generated and saved previously.
2. Use your database administration tools to run the appropriate script against the
appropriate application database(s) for the report package that you are
configuring.
Note: When you run a script that creates materialized views on a DB2
database, your database might return the following error:
SQL20059W The materialized query table-name may not be used to optimize
the processing of queries. However, the materialized view is successfully
created.
Proceed to step 3 for Campaign with a DB2 database.
Proceed to step 4 for eMessage.
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3. For Campaign with a DB2 database, increase the DB2 heap size to 10240 or
higher. The default heap size is 2048. Use the following command to increase
the heap size:
db2 update db cfg for databasename using stmtheap 10240
where databasename is the name of the Campaign database.
Increasing the heap size ensures that IBM Cognos does not display SQL error
messages if a user selects all the campaigns when running a report such as the
Financial Summary report.
4. Complete the following actions for eMessage:
a. In the ReportsPackCampaign\tools directory under your reports pack
installation, locate the uare_lookup_create_DB_type.sql script, where
DB_type is the database type that is appropriate for your installation of
Campaign.
b. Edit the appropriate version of the script to remove the drop table
statements and save the script.
c. Run the appropriate version of the script against your Campaign system
tables database.
Setting up data synchronization
Make sure that you use your database administration tools to schedule regular
data synchronization between the production databases of the IBM EMM
application and the materialized views.
For eMessage, the materialized views for Oracle and DB2 are refreshed by stored
procedures. Stored procedures also update the uare_delta_refresh_log table. If the
refresh process for DB2 fails, the log table displays the error. See “Running and
scheduling stored procedures for eMessage” on page 33 for information about
stored procedures.

Creating views or materialized views for Interact
You can use SQL scripts to create views or materialized views for Interact. Reports
uses views or materialized views to extract reportable data.
Before you create views or materialized views for Interact, verify that the language
setting for the computer from where you run the lookup_create SQL script is
enabled for UTF-8 encoding. Refer to the following table as a guideline to change
the language setting to UTF-8:
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Table 6. Changing language setting in Oracle and DB2
Database type

Guidelines

Oracle

Use the following steps as a guideline if
your database is Oracle:
1. Close all open Oracle sessions.
2. Open the Registry Editor.
3. Browse to HKEY_LOCAL_MACHINE >
SOFTWARE > ORACLE and open the
folder for your Oracle Home, for
example, KEY_OraDb10g_home1.
4. Search for the NLS_LANG setting.
5. Make sure the last part of the value
specified is UTF8. For example:
AMERICAN_AMERICA.UTF8.

DB2

Use the following steps as a guideline if
your database is DB2:
1. From the computer that is running the
script and has the DB2 client installed,
run a DB2 command window. Then run
the following command:
db2set
2. In the output, look for the following
variable/value pair:
DB2CODEPAGE=1208
3. If the DB2CODEPAGE=1208 variable is not
set, run the following command:
db2 db2set db2codepage=1208
4. Close the session window so the change
can take effect.

Complete the following steps to create views or materialized views for Interact:
1. Locate the SQL scripts that you generated and saved previously.
2. Use your database administration tools to run the appropriate script against the
appropriate application database(s) for the report package that you are
configuring.
Note: When you run a script that creates materialized views on a DB2
database, your database might display the following error:
"SQL20059W The materialized query table-name may not be used to optimize
the processing of queries."

3.

4.

5.
6.

However, the materialized view is successfully created.
Locate the tools subdirectory in the reports package installation directory and
find the lookup_create script for your database type. For example, the script
for SQL is named uari_lookup_create_MSSQL.sql.
Run the lookup_create script on the Interact design time database. Ensure that
the database tool you are using commits the changes. For example, you might
need to set the auto-commit option of the database to true.
Browse to the <Interact_ReportPack_Installer_Home>\Cognos10\interact-ddl\
<DB Type>\ folder.
For DB2, set the db2set DB2_COMPATIBILITY_VECTOR=ORA parameter.
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7. Run the acir_tables_<DB Type>.sql script on the ETL database.
Setting up data synchronization
Make sure that you use scheduled Extraction, Transformation, and Load (ETL)
method, or any custom method to schedule regular data synchronization between
the production databases of the IBM EMM application and the new reporting
tables.

Creating and populating reporting tables for Campaign
You can use SQL scripts to create and populate reporting tables for Campaign.
Reports uses reporting tables to extract reportable data.
Complete the following steps to create and populate reporting tables for
Campaign:
1. Create the reporting database.
2. Locate the SQL scripts that you generated and saved previously.
3. Use your database administration tools to run the appropriate script against the
appropriate application database(s) for the report package that you are
configuring.
4. For Campaign with a DB2 database, increase the DB2 heap size to 10240 or
higher. The default heap size is 2048. Use the following command to increase
the heap size:

5.

6.
7.

8.

db2 update db cfg for databasename using stmtheap 10240
where databasename is the name of the Campaign database.
Increasing the heap size ensures that IBM Cognos does not display SQL error
messages if a user selects all the campaigns when running a report such as the
Financial Summary report.
Locate the db/calendar subdirectory in the Marketing Platform installation
directory and find the ReportsCalendarPopulate script that is appropriate for
the database type. The ReportsCalendarPopulate script creates the following
tables:
v UA_Calendar
v UA_Time
Run the ReportsCalendarPopulate script on the new database that you created
with the table creation script.
For DB2 only, complete one of the following tasks:
v Run the script from the command prompt by using the following command:
db2 -td@ -vf ReportsCalendarPopulate_DB2.sql
v If you use the DB2 client interface, change the termination character to the @
character in the Statement termination character field.
Use your database administration tools to populate the new tables with the
appropriate data from the production system database.
Note: You must use your own tools for this step. The SQL Generator does not
generate the SQL for you.

Setting up data synchronization
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Make sure that you use scheduled Extraction, Transformation, and Load (ETL)
method, or any custom method to schedule regular data synchronization between
the production databases of the IBM EMM application and the new reporting
tables.

Creating and populating reporting tables for Interact
You can use SQL scripts to create and populate reporting tables for Interact.
Reports uses reporting tables to extract reportable data.
Complete the following steps to create and populate reporting tables for Interact:
1. Create the reporting databases.
2. Use your database administration tools to run the appropriate script against the
appropriate application database(s) for the report package that you are
configuring.
3. Run the lookup_create script on the Interact design time database. Ensure that
the database tool that you use commits the changes. For example, you might
need to set the auto-commit option of the database to true.
4. Locate the tools subdirectory in the reports package installation directory and
find the lookup_create script for your database type. For example, the script
for SQL is named uari_lookup_create_MSSQL.sql.
5. Use your database administration tools to populate the new tables with the
appropriate data from the production system database.
Note: You must use your own tools for this step. The SQL Generator does not
generate the SQL for you.
Setting up data synchronization
Make sure that you use scheduled Extraction, Transformation, and Load (ETL)
method, or any custom method to schedule regular data synchronization between
the production databases of the IBM EMM application and the new reporting
tables.

Importing the reports folder in Cognos Connection
The IBM EMM application reports are in the compressed (.zip) file that the report
package installer copied to the IBM Cognos computer. You must import the
compressed file in Cognos Connection.
Complete the following task to import the compressed file that contains reports to
Cognos Connection:
1. Browse to the Cognosnn directory under your report package installation on
the IBMCognos computer, where nn indicates the version number.
2. Copy the compressed reports archive file (for example Unica Reports for
Campaign.zip) to the directory where your Cognos deployment archives are
saved. In a distributed IBM Cognos environment, this is a location on the
system running the Content Manager.
The default location is the deployment directory under your IBM Cognos
installation and it is specified in the Cognos Configuration tool that is
installed with the Cognos Content Manager. For example: cognos\deployment.
3. Locate the Cognosnn\ProductNameModel subdirectory under your report
package installation on the Cognos computer.
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4. Copy the entire subdirectory to any place on the system running Cognos
Framework Manager that Framework Manager has access to.
5. Open Cognos Connection.
6. From the Welcome page, click Administer Cognos Content.
If your Welcome page is turned off, turn it back on in the Cognos Connection
user preferences.
7. Click the Configuration tab.
8. Select Content Administration.
9. Click the
icon on the toolbar. (New Import) on the toolbar.
10. Follow these guidelines as you step through the New Import Wizard:
a. Select the reports archive that you copied in the previous procedure.
b. In the Public folders content list, select all the options, including the
package itself (the blue folder).
c. If you do not want users to access the package and its entries yet, select
Disable after import. Make this selection if you want to test the reports
before you make them available to the IBM EMM application users.

Configuring and publishing the data model
When you set up the IBM EMM system tables as a Cognos data source, you might
have logged in as a user who is not the owner of the IBM EMM application system
tables. In this situation, you must configure and publish the data model.
Note: You do not need to configure and publish the data model of the data source
login that you used is the owner of the IBM EMM application system tables.
This step is optional for eMessage reports.
Complete the following tasks to configure and publish the data model:
1. Locate the Model directory under the reports package installation, and copy all
the files in the Model directory to anywhere under your Cognos Framework
Manager installation directory. The files constitute the application-specific data
model.
2. In Framework Manager, open the project file. The project file has a .cpf
extension, and the file name includes the IBM EMM application name, for
example ProductNameModel.cpf.
3. Open the data model for the application and complete the following steps:
a. In the Project Viewer, expand Data Sources.
b. Click the data source for the application.
c. Update the data source as described in the following table:
Table 7. Data source.
Database

Fields

SQL Server

v Catalog: Enter the name of the IBM EMM application database.
v Schema: Enter the name of the IBM EMM application database
schema. For example, dbo

Oracle
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Schema: Enter the name of the IBM EMM application database
schema.

Table 7. Data source (continued).
Database

Fields

DB2

v Schema: Enter the name of the IBM EMM application database
schema.

4. Save and republish the package.
For more information about publishing a package in IBM Cognos, see Cognos
Framework Manager User Guide.

Enabling internal links in the reports
The IBM EMM application reports have standard links. To enable the links to work
properly, you must configure the IBM Cognos Application Firewall. You must also
configure the redirect URL in the Cognos data model for the IBM EMM application
reports.
Note: This step is not necessary for eMessage reports.
Complete the following tasks to configure the redirect URL in the Cognos data
model for the IBM EMM application reports:
1. From Cognos Framework Manager, browse to the <productName>Model
subdirectory you copied into the Framework Manager directory structure and
select the .cpf file. For example, CampaignModel.cpf.
2. Select Parameter Maps > Environment.
3. Right click Environment and select Edit Definition.
4. In the Redirect URL section, select the Value field. Edit the server name and
port number so they are correct for the IBM EMM system, leaving the rest of
the URL intact. By convention, the host name includes the domain name.
For example, for Campaign:
http://serverX.ABCompany.com:7001/Campaign/
redirectToSummary.do?external=true&
For example, for Marketing Operations:
http://serverX.ABCompany.com:7001/plan/callback.jsp?
5. Save the model and publish the package:
a. From the navigation tree, expand the Packages node of the model.
b. Right-click the package instance and select Publish Package.

Verifying data source names and publishing
When you publish the model from Framework Manager to the Cognos content
store, the name that is specified as the data source for the reports in the model
must match the name of the data source that you created in Cognos Connection.
You must verify that the data source names match.
If you used the default data source names, the data source names match. If you
did not use default data source names, you must change the data source names in
the model.
Complete the following tasks to change the data source names in the model:
1. In Cognos Connection, determine the names of the data sources you created.
2. In Framework Manager, select the Open a Project option.
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3. Browse to the <productName>Model subdirectory you copied into the Framework
Manager directory structure and select the .cpf file. For example,
CampaignModel.cpf.
4. Expand the Data Sources entry and examine the names of the data sources.
Verify that they match what you named them in Cognos Connection.
a. If they match, you are finished with this procedure.
b. If they do not match, select the data source instance and edit the name in
the Properties section. Save your changes.
5. Publish the package to the Cognos content store

Configuring Cognos reporting properties in Marketing Platform
There are several sets of properties for configuring reporting in IBM EMM. Some
properties specify parameter values for the reporting components in Marketing
Platform, and some properties specify URLs and other parameters for the IBM
Cognos system. The properties that specify parameter values are specified when
the view or table creation scripts are generated. You must specify properties that
specify URLs and other parameters for the IBM Cognos system.
Complete the following tasks to configure properties that specify URLs and other
parameters for the IBM Cognos system:
1. Log in to IBM EMM as the platform_admin user or another user with the
ReportsSystem role.
2. Select Settings > Configuration > Reports > Integration > Cognos version
3. Set the value of the Enabled property to True.
4. Set the value of the Domain property to the name of the company domain on
which the IBM Cognos system is running. For example, xyzCompany.com.
If your company uses subdomains, the value in this field must include the
company domain and the subdomain.
5. Set the value of the Portal URL property, to the URL of the Cognos Connection
portal. Use a fully qualified host name, including the domain and any
subdomains (specified in the Domain property). For example:
http://MyCognosServer.xyzCompany.com/cognos10/cgi-bin/cognos.cgi
You can find this URL in the Cognos Configuration utility under Local
Configuration > Environment.
6. In the Dispatch URL field, specify the URL of the primary Cognos Content
Manager dispatcher. Use a fully qualified host name, including the domain and
any subdomains (specified in the Domain property). For example:
http://MyCognosServer.xyzCompany.com:9300/p2pd/servlet/dispatch
You can find this URL in the Cognos Configuration utility under Local
Configuration > Environment.
7. Leave Authentication mode set to anonymous for now.
8. Save the settings.

Setting report folder permissions
If you configure the reports system to use the authenticated per user mode, make
sure that the appropriate IBM users can run the reports from the IBM EMM
applications. The easiest way to do this is to assign the default ReportsUser role to
the appropriate user groups or users.
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Configuring report folder permissions
In addition to controlling access to the Analytics menu item and the Analysis tabs
for object types (campaigns and offers, for example), you can configure
permissions for groups of reports that are based on the folder structure in which
they are physically stored on the IBM Cognos system.
Before you run Sync Report Folder Permissions, you must ensure that the
following conditions exist:
v Reporting is enabled.
v The Cognos server where reports are configured is up and running.
Complete the following steps to configure report folder permissions:
1. Log in as a Campaign administrator who has the ReportSystem role.
2. Select Settings > Sync Report Folder Permissions.
The system retrieves the names of the folders that are located on the IBM
Cognos system, for all partitions. (This means that if you decide to configure
folder permissions for any partition, you must configure it for all of them.)
3. Select Settings > User Roles & Permissions > Campaign.
4. Under the Campaign node, select the first partition.
5. Select Add Roles and Assign Permissions.
6. Select Save and Edit Permissions.
7. On the Permissions form, expand Reports.
The Reports entry does not exist until after you run the Sync Report Folder
Permissions option for the first time.
8. Grant permission for Performance Reports to the appropriate role.
9. Configure the access settings for the report folders appropriately and then
save your changes.
10. Repeat steps 4 through 8 for each partition.

Running and scheduling stored procedures for eMessage
eMessage reports uses the data that is contained in staging tables, which are
populated by stored procedures. The stored procedures perform a delta refresh
operation. Run the stored procedures at least once per day. If you run the
procedures more frequently, the delta refresh method prevents multiple concurrent
runs.
The following table provides information about the stored procedures and the
tasks that they complete:
Table 8. Stored procedures for eMessage
Stored procedure

Task

sp_runid

This stored procedure creates a unique run
identifier. The list of the run IDs is stored in
the UARE_Runid table.

sp_update_ucc_tables_stats

This stored procedure updates statistics for
the ucc_tables. You can run this script
before the sp_populate_* scripts.

sp_populate_mailing_contacts

This stored procedure processes the mailing
contact data that is received since the
previous run of stored procedures.
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Table 8. Stored procedures for eMessage (continued)
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Stored procedure

Task

sp_populate_mailing_responses

This stored procedure processes the mailing
response data that is received since the
previous run of stored procedures.

sp_populate_sms_contacts

If the SMS feature is enabled, this stored
procedure processes the SMS contact data
that is received since the previous run of
stored procedures.

sp_populate_sms_responses

If the SMS feature is enabled, this stored
procedure processes the SMS response data
that is received since the previous run of
stored procedures.

sp_get_delta_mailing_contacts

This stored procedure is internally called by
sp_populate_mailing_contacts procedure,
and is responsible to get the mailing
contacts that are sent since the previous run
of the stored procedures.

sp_generate_mailing_contacts

This stored procedure is internally called by
the sp_populate_mailing_contacts
procedure, and is responsible to get mailing
and link level counts on contacted
customers for the mailings that are run
since the previous run of the stored
procedures.

sp_get_delta_mailing_responses

This stored procedure is internally called by
sp_populate_mailing_responses procedure,
and is responsible to get the responses that
are received since the previous run of the
stored procedures.

sp_generate_mailing_responses

This stored procedure is internally called by
sp_populate_mailing_responses procedure,
and is responsible to get mailing and link
level responses since the previous run of the
stored procedures.

sp_get_delta_sms_contacts

This stored procedure is internally called by
sp_populate_sms_contacts procedure, and is
responsible to get SMS since the previous
run of the stored procedures.

sp_generate_sms_contacts

This stored procedure is internally called by
sp_populate_sms_contacts procedure, and is
responsible to get mailing and link level
counts on contacted customers since the
previous run of the stored procedures.

sp_get_delta_sms_responses

This stored procedure is internally called by
sp_populate_sms_responses procedure, and
is responsible to get SMS responses since
the previous run of the stored procedures.

sp_generate_sms_responses

This stored procedure is internally called by
sp_populate_sms_responses procedure, and
is responsible to get mailing and link level
SMS responses since the previous run of the
stored procedures.
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Table 8. Stored procedures for eMessage (continued)
Stored procedure

Task

sp_populate_mobile_responses

This stored procedure processes the mobile
response data that is received since the
previous run of stored procedures.

sp_get_delta_mobile_responses

This stored procedure is internally called by
sp_populate_mobile_responses procedure,
and is responsible to get the responses that
are received since the previous run of the
stored procedures.

sp_generate_mobile_responses

This stored procedure is internally called by
sp_populate_mobile_responses procedure,
and is responsible to get mobile responses
since the previous run of the stored
procedures.

Guidelines for running stored procedures for eMessage
Use the following guidelines for running stored procedures:
v You must schedule sp_populate_mailing_contacts and
sp_populate_mailing_responses to run at least 10 minutes after scheduling
sp_runid.
v Consider the size of the tables and indexes in your installation. Larger tables
require more time to update. Allow sufficient time to process the contact and
response data. The initial runs are likely to require more time to complete than
subsequent runs.
v Because the stored procedures can run for an extended amount of time, consider
running the procedures at times of reduced system activity, such as overnight.
v You can reduce the amount of the time that is required to refresh the reports
data by limiting the scope of the reports data processed.
v You must create the stored procedures for your database by using the scripts
that are provided with the installation files.
When the scripts have run successfully, they display a final return code of 0.

Sample configuration of stored procedures for Oracle
Note the following guidelines when you configure stored procedures for the Oracle
database:
v IBM recommends using Oracle Automatic Memory Management (AMM). For
more information, go to http://docs.oracle.com/cd/B28359_01/server.111/
b28310/memory003.htm
v Create stored procedures by using a database utility, such as SQL Plus.
v Schedule the sp_runid procedure to run at least 10 minutes before the other
scripts.
The following example illustrates how to create a job and generate a run identifier.
The example also illustrates the job ID when the job completes.
Example for creating a run identifier
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The following example shows how to get a job number every day at 21:00 hours
without an end date. The jobs start on November 29, 2014:
declare
jobno number;
BEGIN
DBMS_JOB.submit (job =>:jobno,
what => ’sp_runid;’,
next_date => to_date(’29-Nov-2014 21:00’,’DD-MON-YYYY HH24:MI’ ),
interval => ’sysdate+1’);
commit;
END;
/

Example for processing email contact data
The following example shows how to schedule a batch job to process contact data.
The job runs at 21:10 hours every day:
declare
jobno number;
BEGIN
DBMS_JOB.submit (job =>:jobno,
what => ’sp_populate_mailing_contacts;’,
next_date => to_date(’29-Nov-2014 21:10’,’DD-MON-YYYY HH24:MI’ ),
interval => ’sysdate+1’);
commit;
END;
/

Example for processing email response data
The following example shows how to schedule a batch job to process response
data. The job runs at 21:10 hours every day:
declare
jobno number;
BEGIN
DBMS_JOB.submit (job =>:jobno,
what => ’sp_populate_mailing_responses;’,
next_date => to_date(’29-Nov-2014 21:10’,’DD-MON-YYYY HH24:MI’ ),
interval => ’sysdate+1’);
commit;
END;
/

Example for processing SMS contact data
Important: The SMS feature is not a part of the default Reports offering, and you
must buy a license for the feature separately. However, the delta placement takes
place regardless of whether you have bought the SMS feature.
The following example shows how to get a job number every day at 21:00 hours
without an end date. The jobs start on November 29, 2014:
BEGIN
DBMS_JOB.submit (job =>:jobno,
what => ’sp_populate_SMS_contacts;’,
next_date => to_date(’29-Nov-2014 21:10’,’DD-MON-YYYY HH24:MI’ ),
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interval => ’sysdate+1’);
commit;
END;
/

Example for processing SMS response data
The following example shows how to get a job number every day at 21:00 hours
without an end date. The jobs start on November 29, 2014:
BEGIN
DBMS_JOB.submit (job =>:jobno,
what => ’sp_populate_SMS_responses;’,
next_date => to_date(’29-Nov-2014 21:10’,’DD-MON-YYYY HH24:MI’ ),
interval => ’sysdate+1’);
commit;
END;
/

Example for processing mobile response data
The following example shows how to get a job number every day at 21:00 hours
without an end date. The jobs start on November 29, 2014:
BEGIN
DBMS_JOB.submit (job =>:jobno,
what => 'sp_populate_MOBILE_responses;',
next_date => to_date('29-Aug-2014 21:10','DD-MON-YYYY HH24:MI' ),
interval => 'sysdate+1');
commit;
END;
/

Sample configuration of stored procedures for Microsoft SQL
Server
Note the following guidelines when you configure stored procedures for the
Microsoft SQL Server database:
v Use the SQL Server Agent to create new jobs for each stored procedure.
v Schedule the jobs to run at least daily. You must schedule sp_runid to run at
least 10 minutes before the other scripts.
v Complete the following steps for each job in the SQL Server Agent interface:
1. Specify the step type as Transact-SQL script (T-SQL).
2. Select the Campaign database
Example for creating a run identifier
Define the following command:
DECLARE @return_value int
EXEC @return_value = [dbo].[SP_RUNID]
SELECT ’Return Value’ = @return_value
GO

Example for processing email contact data
Define the following command:
DECLARE @return_value int
EXEC @return_value = [dbo].[SP_POPULATE_MAILING_CONTACTS]
SELECT ’Return Value’ = @return_value
GO
Chapter 5. IBM EMM and Cognos integration

37

Schedule the job to run at least 10 minutes after the job that generates the run
identifier.
Example for processing email response data
Define the following command:
DECLARE @return_value int
EXEC @return_value = [dbo].[SP_POPULATE_MAILING_RESPONSES]
SELECT ’Return Value’ = @return_value
GO

Schedule the job to run at least 10 minutes after the job that generates the run
identifier.
Example for processing SMS contact data
Define the following command:
DECLARE @return_value int
EXEC @return_value = [dbo].[SP_POPULATE_SMS_CONTACTS]
SELECT ’Return Value’ = @return_value
GO

Example for processing SMS response data
Define the following command:
DECLARE @return_value int
EXEC @return_value = [dbo].[SP_POPULATE_SMS_RESPONSES]
SELECT ’Return Value’ = @return_value
GO

Example for processing mobile response data
Define the following command:
DECLARE @return_value int
EXEC @return_value = [dbo].[SP_POPULATE_MOBILE_RESPONSES]
SELECT 'Return Value' = @return_value
GO

Sample configuration of stored procedures for IBM DB2
Note the following guidelines when you configure stored procedures for the IBM
DB2 database:
v The database must be DB2 version 9.7.8 or higher.
v Create new jobs in DB2 Administrative Task Scheduler (ATS)
v Schedule the jobs to run at least daily. You must schedule sp_runid to run at
least 10 minutes before the other scripts.
Complete the following steps before you configure stored procedures for IBM DB2:
1. Enable the registry.
Set the DB2_ATS_ENABLE registry variable to YES, TRUE, 1, or ON. Restart the
DB2 database after you set the variable.
2. Create the SYSTOOLSPACE table space.
Users that belong to the SYSADM or SYSCTRL group can create this space. Use
the following query to verify that the space exists:
SELECT TBSPACE FROM SYSCAT.TABLESPACES WHERE TBSPACE = 'SYSTOOLSPACE'
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3. Grant permissions. In the following examples, substitute the values that are
appropriate for your environment:
EMESSAGE: Database that contains the eMessage system tables.
USER1: Owner of the EMESSAGE database
DB2ADMIN: DB2 administrative user
Administrator: Super user
4. Connect to DB2 as an administrative user and run the following grant
commands:
v db2 GRANT DBADM ON DATABASE TO USER DB2ADMIN
v db2 GRANT DBADM ON DATABASE TO USER USER1
v db2 grant all on table SYSTOOLS.ADMINTASKS to USER1
v db2 grant all on table SYSTOOLS.ADMINTASKS to DB2ADMIN
5. If the SYSPROC.ADMIN_TASK_ADD table exists, run the following grant
commands:
v db2 grant execute on procedure SYSPROC.ADMIN_TASK_ADD to USER1
v db2 grant execute on procedure SYSPROC.ADMIN_TASK_ADD to DB2ADMIN
Example for creating a run identifier
This example shows how to get a job number every day at 20:50 hours without an
end date.
call SYSPROC.ADMIN_TASK_ADD(’RunID_Job’,null,null,
null,’50 20 * * *’,’USER1’,’SP_RUNID’,null,null,null)

Example for processing mailing contact data
This example shows how to schedule a batch job to process contact data. In this
example, the job runs at 21:00 hours every day.
call SYSPROC.ADMIN_TASK_ADD(’Email_Contact_Job’,null,null,null,’00 21 * * *’,
’USER1’,’SP_POPULATE_MAILING_CONTACTS’,null,null,null)

Schedule the job to run at least 10 minutes after the job that generates the run
identifier.
Example for processing mailing response data
This example shows how to schedule a batch job to process response data. In this
example, the job runs at 21:00 hours every day.
call SYSPROC.ADMIN_TASK_ADD(’Email_Response_Job’,null,null,
null,’00 21 * * *’,’USER1’,’SP_POPULATE_MAILING_RESPONSES’,null,
null,null)

Schedule the job to run at least 10 minutes after the job that generates the run
identifier.
Example for processing SMS contact data
This example shows how to schedule a batch job to process contact data. In this
example, the job runs at 21:00 hours every day.
call SYSPROC.ADMIN_TASK_ADD('SMS_Contact_Job',null,null,null,'00 21 * * *',
'USER1','SP_POPULATE_SMS_CONTACTS',null,null,null)
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Schedule the job to run at least 10 minutes after the job that generates the run
identifier.
Example for processing SMS response data
This example shows how to schedule a batch job to process response data. In this
example, the job runs at 21:00 hours every day.
call SYSPROC.ADMIN_TASK_ADD('SMS_Response_Job',null,null,
null,'00 21 * * *','USER1','SP_POPULATE_SMS_RESPONSES',null,
null,null)

This example shows how to schedule a batch job to process contact data. In this
example, the job runs at 21:00 hours every day.
call SYSPROC.ADMIN_TASK_ADD('SMS_Response_Job',null,null,null,'00 21 * * *',
'USER1','SP_POPULATE_MAILING_RESPONSES',null,null,null)

Schedule the job to run at least 10 minutes after the job that generates the run
identifier.
Example for processing mobile response data
This example shows how to schedule a batch job to process response data. In this
example, the job runs at 21:00 hours every day.
call SYSPROC.ADMIN_TASK_ADD('MOBILE_Response_Job',null,null,
null,'00 21 * * *','USER1','SP_POPULATE_MOBILE_RESPONSES',null,
null,null)

Stored procedures for the Interact Event Pattern report
The Interact Event Pattern report uses the data that is contained in staging tables,
which are populated by stored procedures. The stored procedures perform a delta
refresh operation.
Interact Event Pattern report data comes in two steps. First, the Interact ETL
process transforms the audiences blob data into ETL database tables. Second, the
reports aggregator aggregates the data incrementally for each pattern type in
pre-configured parallel execution. It is feature of Interact reports pack.
Both processes are integrated with the database trigger on table
UACI_ETLPATTERNSTATERUN. This trigger is fired on successful ETL execution.
This trigger submits database jobs to aggregate the reports data.
The following tables provide information about the stored procedures and the
tasks that they complete:
Table 9. Stored procedures for the Interact Event Pattern report
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Stored procedure

Task

SP_GENERATE_PATTERN_MATCHALL

This stored procedure is internally called by
the SP_POPULATE_PATTERN_MATCHALL
procedure, and is responsible to get the data
for Match All patterns that are executed
since the previous run of the stored
procedures.
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Table 9. Stored procedures for the Interact Event Pattern report (continued)
Stored procedure

Task

SP_GENERATE_PATTERN_COUNTER

This stored procedure is internally called by
the SP_POPULATE_PATTERN_COUNTER
procedure, and is responsible to get the data
for Counter patterns that are executed since
the previous run of the stored procedures.

SP_GENERATE_PATTERN_WC

This stored procedure is internally called by
the SP_POPULATE_PATTERN_WC
procedure, and is responsible to get the data
for Weighted Counter patterns that are
executed since the previous run of the
stored procedures.

SP_POPULATE_PATTERN_MATCHALL

This stored procedure processes the Match
All Pattern type data that is received since
the previous run of stored procedures.

SP_POPULATE_PATTERN_COUNTER

This stored procedure processes the Counter
Pattern type data that is received since the
previous run of stored procedures.

SP_POPULATE_PATTERN_WC

This stored procedure processes the
Weighted Counter Pattern type data that is
received since the previous run of stored
procedures.

SP_UPDATE_UACI_TABLES_STATS

SP_UPDATE_UACI_TABLES_STATS is
called by the trigger first to update the
database statistics and then the database
jobs are submitted for reports data
aggregation.
This stored procedure updates the statistics
for the following ETL tables:
v UACI_ETLPATTERNSTATE
v UACI_ETLPATTERNSTATEITEM
v UACI_ETLPATTERNEVENTINFO

SP_POPULATE_PATTERN_LOCK
(p_parallel_degree)

This procedure updates the
UARI_PATTERN_LOCK table with the
degree of parallel execution configured.
p_parallel_degree is the degree at which the
aggregation processes run in parallel.

SP_AGGR_RUN_STATUS

This procedure is called by the Interact ETL
process before the start of aggregation
process to check the lock status of the
running stored procedures. This procedure
is run against the UARI_PATTERN_LOCK
table.
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Table 9. Stored procedures for the Interact Event Pattern report (continued)
Stored procedure

Task

SP_REFRESH_PATTERNINFO

For Oracle and DB2 only.
This stored procedure refreshes the
UARI_PATTERNSTATE_INFO table to get
the state and audience level information for
the ICs and Categories.
The call to this procedure is given by a
trigger before the aggregation procedures
start.
As Mviews are not supported for SQL
Server, this procedure is not applicable for
SQL Server.

SP_UARI_REBIND_PACKAGES

For DB2 only.
This stored procedure rebinds the packages
that are associated with the aggregation
trigger and procedures. This procedure is
called from the trigger after the
SP_UPDATE_UACI_TABLES_STATS
procedure call.

Table 10. Database sequence
Stored procedure

Task

SQ_UARI_RUN

For Oracle and DB2: This sequence creates a
unique run identifier. The list of the run IDs
is stored in the UARI_RUNS table.

For SQL Server: For SQL Server, RunID are generated by using the IDENTITY
property on RunId column, which generates new ID on each run.
Table 11. Database trigger
Stored procedure

Task

TR_AGGREGATE_DELTA_PATTERNS

After the UACI_ETLPATTERNSTATERUN
table is updated with the value 3, the trigger
is invoked by submitting the jobs that call
the stored procedures for data aggregation.

Enabling the stored procedures for the Interact Event Pattern report
The Interact Event Pattern report uses the delta refresh process for data
aggregation process so that reports can render faster.
Apart from the steps followed to enable reports, you must complete the following
steps to enable the Interact Event Pattern report:
1. Browse to the <Interact_ReportPack_Installer_Home>\Cognos10\interact-ddl\
<DB Type>\ folder.
2. For DB2, set the following parameters:
v db2set DB2_COMPATIBILITY_VECTOR=ORA
v db2set DB2_ATS_ENABLE=YES
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You can verify the execution by using the following command, if the database
is active: db2 list active databases.
You can use the following solution to activate the DB2, explicitly.
a. Stop the application running on this instance by running command: db2
force application all.
b. Stop the DB2 by running the command: db2stop force.
c. Start the database by running the command: db2start.
d. Issue below command to activate the database explicitly : db2 activate db
<dbname>.
You should see this message: DB20000I The ACTIVATE DATABASE command
completed successfully.
e. Verify that the database is activated by issuing command: db2 list active
databases.
You should see output similar to the following output.
Active Databases
Database name
= <dbname>
Applications connected currently
= 0
Database path
= /data04/<DB instance owner>/NODE0000/SQL00001/

This procedure must be followed whenever the instance is restarted.
ATS depends on the table space to store historical data and configuration
information. To check whether the table space is defined in the database or to
create the table space, see http://www.ibm.com/developerworks/data/
library/techarticle/dm-0809see/.
To execute the scheduled job from Task Scheduler, the database must be active.
Refer to the developer works article at http://www.ibm.com/developerworks/
data/library/techarticle/dm-0809see/.
The ADMIN_TASK_STATUS is an administrative view that is created when the
ADMIN_TASK_ADD procedure is called first time. These views must exist in
the database. If the views are missing, create the views with the help of
database administrator.
You must have access privilege on the ADMIN_TASK_STATUS administrative
view.
For more information, see http://www-01.ibm.com/support/knowledgecenter/
api/content/SSEPGG_9.7.0/com.ibm.db2.luw.admin.gui.doc/doc/t0054396.html
and http://www.ibm.com/developerworks/data/library/techarticle/dm0809see/.
3. Run the following scripts in a sequence on the ETL database:
a.
b.

acir_tables_<DB Type>.sql
acir_scripts_<DB Type>.sql

Note: You must run the acir_tables_<DB Type>.sql scripts if it has not been
run earlier.
Note: If an exception is thrown after you run the acir_scripts_db2.sql script
on the target database, delete the trigger and create it with the appropriate
database user.
For SQL Server, run the acir_jobs_sqlserver.sql script. The script creates
database jobs for degree 2. To change the degree, see “For Interact Event
Pattern report, changing the degree of parallel execution” on page 45.
Note: Make sure that the SQL Server Agent service must be running.
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4. Before the ETL process starts, run the following command on the ETL database
to create parallel batch degree records in the UARI_PATTERN_LOCK table:
v For Oracle, run execute SP_POPULATE_PATTERN_LOCK(2), where degree is 2.
v For DB2, run call SP_POPULATE_PATTERN_LOCK(2), where degree is 2.
v For SQL Server, run EXEC [dbo].[SP_POPULATE_PATTERN_LOCK]
@p_parallel_degree = 2, where degree is 2.
After you run the script, the UARI_PATTERN_LOCK table is populated with
the stored procedures with the degree value. This degree value is configurable.
Increase the degree of parallel execution for the Interact Event Pattern report
aggregation process to reduce the elapse time. If the degree is set to higher
value, hardware resource requirements also increase proportionally. The
number of procedures that are run for data aggregation depend on the degree
value.
At the first run, ETL does not insert any values against the respective PatternID
in the UARI_DELTA_PATTERNS table, as all the patterns are new or delta. The
reports aggregation process collects all the PatternIDs from the ETL tables
inserts them in the UARI_DELTA_PATTERNS table.
The ETL process calls the SP_AGGR_RUN_STATUS procedure. The
SP_AGGR_RUN_STATUS procedure checks the UARI_PATTERN_LOCK table
for running JobIDs. The JobID contains the flag 'Y' either in case of running or
failed scenarios. If there are any failed jobs, the procedure sets the flag to 'N'.
For running jobs, the value remains 'Y'. The ETL process always checks the
status of the reports aggregation by checking status of the submitted jobs. If the
ETL finds reports aggregation running, the ETL does not start its execution. The
ETL starts after again as per the schedule.
The ETL process checks the UARI_PATTERN_LOCK table for the number of
JobIDs with value ‘Y’. The ETL process starts only if the number of JobIDs with
the value 'Y' is 0. If the number of JobIDs with value 'Y' is greater than 0, then
the ETL process is skipped and it runs at the next scheduled interval. For more
information about the ETL process, see the IBM Interact Administrator's Guide.
From the second run onwards, the ETL process updates the
UARI_DELTA_PATTERNS table with the update flag for the updated PatternID,
for updated data, the Pattern ID is marked with 'U'. For deleted data, the
PatternID is marked with 'D'.Newly added Patterns are identified by reports
aggregation code and then inserted into UARI_DELTA_PATTERNS with the
flag 'P'. The ETL always updates the flags in UARI_DELTA_PATTERNS table
for the existing PatternID's and newly added patternID's are processed and
inserted into UARI_DELTA_PATTERNS table by reports aggregation process.
The aggregation process is done for only the PatternIDs marked with the 'U' or
'D' flag.
When The ETL finishes running successfully, the status in the
UACI_ETLPATTERNSTATERUN table is updated as 3, and the trigger
TR_AGGREGATE_DELTA_PATTERNS is called. The trigger calls the stored
procedure for the set parallel degree.
Note: It is possible that the first report aggregation takes longer time than
subsequent aggregation. It is because the system is trying to aggregates all data for
the first time.
Note: At any time if you want to turn off the aggregation process, while the ETL
feature is, you can disable the trigger so that reports aggregation is not called.
Run following command in the respective database to disable Trigger.
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For DB2 refer to http://www.ibm.com/developerworks/data/library/techarticle/
0211swart/0211swart.html.
For Oracle: alter trigger TR_AGGREGATE_DELTA_PATTERNS disable;
For SQL Server: Disable Trigger TR_AGGREGATE_DELTA_PATTERNS on
uaci_etlpatternstaterun
To turn on the reports aggregation: alter trigger
TR_AGGREGATE_DELTA_PATTERNS enable;
For SQL Server: Enable Trigger TR_AGGREGATE_DELTA_PATTERNS on
uaci_etlpatternstaterun

For Interact Event Pattern report, changing the degree of parallel
execution
This degree value is configurable. Increase the degree of parallel execution for the
Interact Event Pattern report aggregation process to reduce the elapse time. If the
degree is set to higher value, hardware resource requirements also increase
proportionally
Configure the degree at which the aggregation process runs so that the Interact
Event Pattern report can render faster.
Complete the following steps to change the degree value with which the
aggregation process can run in parallel:
Depending on your database, complete the following steps to configure database
jobs for degree 3:
Table 12. Commands to run to change the degree of parallel execution
Database type

Command to run against the ETL database

Oracle

To configure the degree value as 3, run the
execute SP_POPULATE_PATTERN_LOCK(3) command against the Interact ETL
database.

IBM DB2

To configure the degree value as 3, run the
call SP_POPULATE_PATTERN_LOCK(3) command against the Interact ETL
database.
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Table 12. Commands to run to change the degree of parallel execution (continued)
Database type

Command to run against the ETL database

SQLServer

After you run the default acir_jobs_sqlserver.sql script, database jobs
for degree value 1 and 2 are created. The patterns with degree values 1
and 2 are aggregated in the UARI_PROCESSED_PATTERNS table.
To modify the degree to 3 for the Match All Pattern, copy the sample
code for degree 1 and complete the following steps:
1. Create the @job_name to JOB_MA_3.
2. Create the @p_parallel_degree to value 3.
Run the following command against the Interact ETL database:
Command for Match All Pattern with degree 3
DECLARE
@jobId BINARY(16),
@status int,
@schedule_name varchar(16),
@dbname varchar(100)
set @dbname= (SELECT DB_NAME());
EXEC msdb.dbo.sp_add_job @job_name=N’JOB_MA_3’,
@job_id = @jobId OUTPUT;
EXEC msdb.dbo.sp_add_jobstep @job_id=@jobId, @step_name=N’first’,
@command=N’EXEC [dbo].[SP_POPULATE_PATTERN_MATCHALL]
@p_parallel_degree = 3’,
@database_name=@dbname;
EXEC msdb.dbo.sp_add_jobserver @job_id=@jobId,
@server_name=N’(local)’;
GO
You can create the degree for the Counter Pattern and the Weighted
Counter Pattern, and run the commands against the ETL database.
To modify the degree to 3 for the Counter Pattern, copy the sample code
for degree 1 and complete the following steps:
1. Create the @job_name with the name as JOB_C_3.
2. Create the @p_parallel_degree to value 3.
To modify the degree to 3 for the Weighted Counter Pattern, copy the
sample code for degree 1 and complete the following steps:
1. Create the @job_name with the name as JOB_WC_3.
2. Create the @p_parallel_degree to value 3.

How to read the UARI_DELTA_REFRESH_LOG table for the Interact
Event Pattern report
UARI_DELTA_REFRESH_LOG table contains the logging information for all the
procedures.
When the aggregation is run with degree value 2, you see the following log
messages in the table.

How to verify the status of the aggregation process
MESSAGE_LINE:
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<patterntype> patterns delta refresh completed for parallel degree <degree value>
Aggregation of the patterns with degree value is started.

MESSAGE_LINE:
<patterntype> patterns delta refresh completed for parallel degree <degree value>
Aggregation of the patterns with degree value is completed.

Where patterntype is the Type of Pattern, Match All, Counter, or Weighted
Counter, the degree value is the value with which patterns are processed in
parallel.
Example:
MatchAll
MatchAll
MatchAll
MatchAll

patterns
patterns
patterns
patterns

delta
delta
delta
delta

refresh
refresh
refresh
refresh

started for parallel degree 1
completed for parallel degree 1
started for parallel degree 2
completed for parallel degree 2

How to verify whether the UARI_PATTERNSTATE_INFO table is
refreshed
MESSAGE_LINE:
Pattern State information refresh procedure started
--The procedure to refresh the data in UARI_PATTERNSTATE_INFO is running.

MESSAGE_LINE:
Pattern State information refresh procedure completed
--The procedure to refresh the data in UARI_PATTERNSTATE_INFO is completed.

How to verify whether the lock flags are reset by the procedure
SP_AGGR_RUN_STATUS
MESSAGE_LINE:
patterns lock has been reset for parallel degree <degree value>

The OBJECT column of the UARI_DELTA_REFRESH_LOG table contains the
procedure name for which the lock is reset.
Where, the degree value is the value with which patterns are processed in parallel.
Example:
patterns lock has been reset for parallel degree 1

How to verify rebinding of the packages completed (for DB2
only)
MESSAGE_LINE:
Rebind of packages started
--Rebinding of the packages started

MESSAGE_LINE:
Rebinding of packages completed successfully on <datetime>
--Rebinding of the packages completed successfully on the given date.
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How to verify whether the statistics are updated on the ETL
tables
MESSAGE_LINE:
Table statistics update started
--Update statistics on the ETL tables is in process

MESSAGE_LINE:
Statistics on Tables UACI_ETLPATTERNSTATE UACI_ETLPATTERNSTATEITEM
UACI_ETLPATTERNEVENTINFO and indexes have been updated successfully
on <Datetime>
--Statistics are updated on the mentioned ETL tables on the given date.

How to verify the degree of parallel execution
MESSAGE_LINE:
Pattern aggregation processing Parallel degree is set to <degree value>
--Parallel degree with which report aggregation will run is set to 2.

Example:
Pattern aggregation processing Parallel degree is set to 2.

Testing your configuration before enabling authentication
After the reports are installed and configured, you must test the configuration
before you enable authentication. You can test the configuration by running some
reports.
Complete the following tasks to test your configuration before you enable
authentication:
1. Verify that IBM EMM is running and that the IBM Cognos BI service is
running.
2. Log in to IBM EMM as a user with application access and create some data.
(Otherwise the reports have nothing to show.)
3. Open Cognos Connection.
4. Browse to the report folders you imported and click the link to a basic report.
For example, for Campaign, select Public Folders > Campaign > Campaign >
Campaign Summary.
If the report fails, verify that you configured the Cognos data source for the
IBM EMM application database correctly. See “Creating IBM Cognos data
sources for IBM EMM application databases” on page 19.
5. Click a link in the report.
If the internal links from the reports do not work, the redirect URL is not
configured correctly. See “Enabling internal links in the reports” on page 31.
6. Log in to the IBM EMM application as a user with application access and
browse to the Analysis page.
When you specify the URL for the IBM EMM application, be sure to use a fully
qualified host name with your company domain (and subdomain, if
appropriate). For example:
http://serverX.ABCompany.com:7001/unica
7. Click the link to the same report that you tested in Cognos.
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If you cannot view the report, it is likely that the IBM Cognos firewall isn't
configured correctly. See “Configuring IBM Cognos Application Firewall for
IBM EMM” on page 20.
If you cannot view an eMessage report, verify if the eMessage stored
procedures have been run recently.
8. Click a link in the report.
If the internal links from the reports do not work, the redirect URL is not
configured correctly. See “Enabling internal links in the reports” on page 31.
9. Open an individual item, click the Analysis tab, and verify that the report is
correct.

Configure IBM Cognos to use IBM EMM authentication
The IBM EMM Authentication Provider enables the Cognos applications to use
IBM EMM authentication to communicate with the IBM EMM system as though it
were another IBM EMM application in the suite.
Before you begin configure IBM Cognos to use IBM EMM authentication, be sure
that you know which authentication mode you plan to configure ("authenticated"
or "authenticated per user).

Creating the reports system user
You must create a reports system user if you use the authenticated mode for
authentication. When you create the reports system user, you can create the user
and data source credentials to the user that holds the login information for IBM
Cognos BI. You do not need to create the reports system user if you use the
authenticated per user mode for authentication.
When you create the reports system user, you can configure the following login
credentials for the same user:
v One set of login credentials for the IBM system: the user name and password are
specified for the reports system user (cognos_admin)
v One set of login credentials for IBM Cognos BI: the user name and password are
specified as data source credentials for the reports system user
Complete the following tasks to create the reports system user:
1. Log in to IBM EMM as the platform_admin user.
2. Select Settings > Users.
3. Create an IBM user with the following attributes:
a. User name: cognos_admin
b. Password: admin
4. Create a data source for the user with the following attributes:
a. Data Source: Cognos
b. Data Source Logon: cognos_admin
Ensure that the user name in the data source exactly matches the user name
of the IBM user you created in step 3.
c. Data Source Password: admin
5. Add the Reports System role to the user.
6. If IBM EMM is configured to expire user passwords, log out and then log back
in as the reporting system user (cognos_admin). This step ensures that you
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interact with the IBM security "change password" challenge and reset the
password before you log in to IBM Cognos as this user in a later task.

Configuring Cognos authentication properties in IBM EMM
You must configure Cognos authentication properties in IBM EMM so the IBM
EMM applications can communicate with the Cognos applications if the IBM EMM
and Cognos applications are installed in different network domains.
Complete the following tasks to configure Cognos authentication properties in IBM
EMM:
1. Log in to IBM EMM as the platform_admin user.
2. Select Settings > Configuration.
3. Expand Reports > Integrations > Cognos version .
4. Set the value of the Authentication Mode property by selecting either
authenticated or authenticatedPerUser, as appropriate for your system.
For "authenticated" only. Verify that the values in the Authentication user
name and Authentication datasource name fields match those of the user and
data source you created in the previous task, “Creating the reports system
user” on page 49.
6. Set the value of the Enable form authentication property.
5.

This setting indicates that IBM EMM security uses form-based authentication in
place of cookies. You set this property to True when either of the following is
true.
v When the IBM EMM is not installed in the same network domain as the
Cognos applications.
v When Cognos is accessed by using an IP address (within the same network
domain) instead of the Fully Qualified Hostname (which is being used to
access the IBM EMM applications), even if both the IBM EMM applications
and the Cognos installation are on the same computer.
However, when the value is True, the login process to Cognos Connection
passes the login name and password in clear text and therefore is not secure
unless Cognos and the IBM EMM are configured to use SSL communication.
Even with SSL configured, the user name and password appear as clear text in
the HTML source code when you "view source" in a displayed report. For this
reason, you should install Cognos and IBM EMM in the same network domain.
Note: When the Enable form authentication property is set to True, the
Authentication mode property automatically behaves as though it were set to
authenticated, and you must complete the step that is required for this mode,
described in “Creating the reports system user” on page 49.
7. Save the new settings.
8. For "authenticatedPeruser" only. Assign the ReportUser role to the default
asm_admin user. You complete this step so that you can test reports: you need
a user with access to both the IBM EMM application and report data. The
platform_admin user does not have access to the IBM EMM application
features.
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Configuring IBM Cognos to use IBM EMM Authentication
Provider
You must use the Cognos Configuration and Cognos Connection applications to
configure the IBM Cognos BI applications to use the IBM EMM Authentication
Provider.
Complete the following tasks to configure IBM Cognos to use the IBM EMM
Authentication Provider:
1. On the computer where the Cognos Content Manager is running, open
Cognos Configuration.
2. Select Local Configuration > Security > Authentication.
3. Right-click Authentication and select New resource > Namespace.
4. Complete the fields as follows, and then click OK:
a. Name: Unica
b. Type: Custom Java Provider.
5. On the Resource Properties page, complete the fields as follows and then save
your changes:
NamespaceID: Unica
Java class name:
com.unica.report.adapter.UnicaAuthenticationProvider
6. Stop and restart the IBM Cognos BI service.
On a Windows system, sometimes the Cognos interface indicates that the
service is stopped when it is not. To ensure that the service has really stopped,
use the Windows Administrative tools to stop the service.
7. Under Local Configuration > Security > Authentication, right-click Unica
and select Test.
If Cognos Connection displays an error, examine the cogserver.log file in the
logs directory of your Cognos installation to determine the problem.
a.
b.

8. Log in to Cognos Connection as follows to verify that the IBM EMM
Authentication provider is configured correctly:
v If you set the Cognos authentication mode in the IBM EMM configuration
properties to authenticated, log in as the cognos_admin (report system)
user.
v If you set the authentication mode in the IBM EMM configuration
properties to authenticatedPerUser, log in as the asm_admin user.
If IBM Cognos displays the error "The third-party provider returned an
unrecoverable exception," expand the error message. If it states "invalid
credentials," you made an error entering your user credentials. Try again.
However, if it states "password expired," IBM EMM expired the password.
Log in to IBM EMM application as the reporting system user and reset the
password. Then, try logging in to Cognos Connection again.
If you still cannot log in to Cognos Connection, examine the cogserver.log
file in the logs directory of your Cognos installation, to determine the
problem.
9. When you can successfully log in to Cognos Connection, open Cognos
Configuration again.
10. Select Local Configuration > Security > Authentication > Cognos.
11. Disable anonymous access to IBM Cognos BI by setting Allow anonymous
access? to false.
12. Save your changes.
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13. Stop and restart the IBM Cognos service.
If the IBM Cognos service cannot communicate successfully with the
authentication provider, it cannot start. If the IBM Cognos service fails to start,
verify your configuration by retracing the steps in this procedure.
14. Distributed systems only. If your IBM Cognos system has backup Content
Managers configured for failover support, repeat this procedure on all the
servers with Content Manager installed.
At this point, anyone who logs in to an application on the Cognos system must be
authenticated by IBM EMM. Additionally, the authentication namespace Unica
now appears in the IBM Cognos user interface for logon and security
administration tasks.

Configuring additional settings for Marketing Platform
Additional configuration is required when IBM Marketing Platform is integrated
with an LDAP server, Windows Active Directory (Windows Integrated Login), or
with a web access control system such as Tivoli® or SiteMinder.
Complete the following tasks to configure additional settings for Marketing
Platform:
1. In Cognos Configuration, set the flag Selectable for authentication to false for
the Unica® authentication namespace.
When you set this flag to false, Cognos Connection and Cognos Administration
cannot access the Unica namespace for authentication. However, IBM EMM
applications can still access the Unica namespace through the Cognos SDK API
(for example, when users view Cognos reports from within IBM EMM
applications).
2. If you need authenticated access to the Cognos URL, complete the following
tasks:
a. In Cognos Configuration, configure a namespace by using the appropriate
bundled authentication provider.
b. Set Selectable for authentication to true.
c. Use this new namespace for the Cognos URL.

Testing your configuration with authentication configured
You must test your configuration of IBM Cognos BI after you configure IBM
authentication.
Complete the following tasks to test your configuration of IBM Cognos BI:
1. Verify that IBM EMM is running and that the IBM Cognos service is running.
2. Open Cognos Connection.
3. Browse to the report folders you imported and click the link to a basic report.
For example, for Campaign, select Public Folders > Campaign > Campaign >
Campaign Summary.
If the report fails, verify that you configured the IBM Cognos data source for
the IBM application database correctly. See “Creating IBM Cognos data sources
for IBM EMM application databases” on page 19.
4. Click a link in the report.
If the internal links from the reports do not work, the redirect URL is not
configured correctly. See “Enabling internal links in the reports” on page 31.
5. Log in to IBM EMM and browse to the Analysis page.
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When you specify the URL for the IBM application, be sure to use a fully
qualified host name with your company domain (and subdomain, if
appropriate). For example: http://serverX.ABCompany.com:7001/unica
6. Click the link to the same report that you tested in IBM Cognos.
If you see error messages about security, it is likely that the IBM Authentication
Provider is not configured correctly. See “Configure IBM Cognos to use IBM
EMM authentication” on page 49.
If you are prompted to enter credentials for authentication, it is likely that the
domain name is missing from one of your URLs. Log in to IBM EMM as a user
with admin privileges. Then, select Settings > Configuration and ensure that
the URLs in the following properties include the domain name and any
appropriate subdomain name.
v Reports > Integration > Cognos > Portal URL and Dispatch URL
v Any URL properties for the IBM applications, for example: Campaign >
navigation > serverURL
7. Click a link in the report.
If you are prompted to enter credentials for authentication, it is likely that the
domain name is missing from one of the URLs.
8. Open an individual item, click the Analysis tab, and verify that the report is
correct.
If you see error messages about security, it is likely that the IBM Application
Provider is not configured correctly.
Now reporting works properly and the example reports are in their default state.
When you finish configuring the actual data design of your IBM EMM applications
- things like campaign codes, custom campaign attributes, response metrics - you
have to return to reporting because you may need to customize the reports or
reporting schemas.
If you are using Campaign or Interact, see the "Configuring reporting" chapter.
If you are using Marketing Operations, see the "Using Reports" chapter in the IBM
Marketing Operations Administrator's Guide.
If you are setting up reporting for eMessage, you are done configuring reporting.

Chapter 5. IBM EMM and Cognos integration
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Chapter 6. Configuring reporting
After you install or upgrade your reporting packages, you must configure your
reporting installation.
For its reporting feature, IBM EMM integrates with IBM Cognos, a third-party
business intelligence application. Reporting relies on the following components:
v
v

An installation of IBM Cognos
A set of IBM EMM components that integrate IBM Enterprise applications with
the IBM Cognos installation

For several IBM EMM applications, reporting schemas that enable you to build
reporting views or tables in the IBM system tables of the application
v The example reports for the IBM EMM application, which is built with IBM
Cognos Report Studio
v

When you install IBM EMM applications, each application registers itself with the
Marketing Platform. During that registration process, it adds an entry for itself to
the Analytics menu item.
After the report package for the application is configured:
v The Analytics menu item for the application provides access to its cross-object
reports.
The single object reports then appear on the Analysis tabs of the appropriate
objects.
v The dashboard reports for the application can be enabled and used in
dashboards.
v

Typically, the reports packages for the IBM EMM products are installed when the
IBM EMM applications are installed. Not all of the reports packages contain
reporting schemas, but they all contain the following IBM Cognos BI components:
A customizable IBM Cognos reporting metadata model for the IBM EMM
application reports
v Customizable IBM EMM application reports built with IBM Cognos BI Report
Studio
v Reference documentation that describes the reporting data model and the
reports
v

The IBM Cognos model references the reporting views (or tables) in the IBM EMM
application database, making that data available to the IBM Cognos reports that
are also delivered in IBM EMM Reports Packages.
Immediately after installation, the reports are in their default state and are to be
considered example reports. Why? Because many IBM EMM applications have a
set of objects, attributes, or metrics that can be added or customized. For example,
Campaign allows you to add response types, custom campaign attributes,
additional audience levels. After the data design of your system is implemented,
you can revisit reporting to customize the example reports and create new reports.
How you configure the reports after the data design phase of your implementation
depends on which IBM EMM applications are included in your IBM EMM system.
© Copyright IBM Corp. 1999, 2015
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For Campaign and Interact, you customize the reporting schemas and then
update the views or reporting tables that were created during installation. At
that point, you synchronize the Cognos data model with the newly updated
reporting views and publish the revised model to the Cognos content store. Now
the new custom attributes are available in Report Studio and you can add them
to the sample reports, or create new reports that display the attributes.
v For the IBM EMM applications that do not provide reporting schemas and for
eMessage (which provides schemas that cannot be customized), you configure
the Cognos IBM reports only.
v

This section describes the security model, the schemas, the data models, and the
reports.

Reporting and security
For security, the reporting feature is controlled by specific access control
mechanisms.
The following access control mechanisms exist:
v Application access control settings. Whether users can run reports from the IBM
EMM interface depends on the permissions that are granted by the IBM EMM
application access settings. Additionally, for Campaign, eMessage, and Interact,
you can grant or deny access to groups of reports based on their folder structure
on the IBM Cognos system.
v Marketing Platform access control settings. Whether an administrator can
customize the schemas or run the Report SQL Generator depends on the
permissions that are configured for Marketing Platform.
v IBM EMM authentication. You can also configure the IBM Cognos BI system to
use IBM EMM authentication, thus controlling access to the IBM application
data from the IBM Cognos system.

Report folder permissions
The IBM Cognos report packages that you install on the IBM Cognos system
contain the report specifications for the IBM applications, which are organized into
folders. For example, the Interact Reports folder is the folder for Interact, and the
reports specifications are in the Interact Reports folder on the IBM Cognos
system.
For Campaign, eMessage, and Interact, you can configure permissions for groups
of reports based on the folder structure in which they are physically stored on the
IBM Cognos system.

Synchronizing with the IBM Cognos file directory
After reporting is installed, to make the IBM system aware of the report folders on
the IBM Cognos system, you run the Sync Report Folder Permissions option on
the Settings menu in the IBM interface. This option connects to the IBM Cognos
system to determine which folders are present. It then creates an entry in the user
permissions lists for the Campaign partitions. The entry, named Reports, appears
in the permissions lists between the Logging and the System Tables entries. When
you expand it, the report folder names are listed and now represent permissions.
The default setting for the new permissions is "not granted." Therefore, after you
run the Sync Report Folder Permissions option, you must configure permissions
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for the report folders. Otherwise, no one has access to the IBM Cognos reports
anymore.

Partitions and folder partitions
The folder synchronizing process retrieves the names of all the folders on the
Cognos system, for all partitions. If you decide to configure report folder
permissions for any partition, you must configure permissions for all partitions.

Using IBM EMM Authentication Provider to secure IBM
Cognos BI system
By default, the Cognos system is unsecured because anyone who has access to the
IBM Cognos applications can access the data from the IBM EMM application
database. You can secure the Cognos system by using the IBM EMM
Authentication Provider.
When your IBM EMM system integrates with the IBM Cognos BI system, the IBM
Cognos system provides access to the IBM EMMapplication data in the following
ways:
v From the IBM EMM applications: when someone requests a report from the IBM
EMM interface, the IBM EMM system contacts the IBM Cognos system, which
queries the reporting views or tables and then sends the report back to the IBM
EMM interface.
v From the IBM Cognos applications: when you work with the IBM EMM
application data model in Framework Manager or the reports in Report Studio,
you connect to the database for the IBM EMM application.
When IBM Cognos is configured to use IBM EMM authentication, the IBM EMM
Authentication Provider that is installed on the IBM Cognos BI system
communicates with the security layer of the Marketing Platform to authenticate
users. For access, the user must be a valid IBM EMM user and must have a role
that grants one of the following permissions:
v report_system, which also grants access to the reporting configuration options in
the IBM EMM interface. The ReportsSystem role grants this permission.
v report_user, which grants access to the reports but not to the reporting
configuration options in the IBM EMM interface. The ReportsUser role grants
this permission.
The following authentication options exist:
v authenticated
v authenticated per user

Authenticated mode
When the authentication mode is set to authenticated, the communications
between the IBM EMM system and the IBM Cognos system are secured at the
machine level. To use the authenticated mode for a user, you must configure a
report system user and identify the user in the reporting configuration settings.
Complete the following tasks to configure a report system user:
1. Create the user and assign to it the ReportsSystem role, which grants it access
to all reporting functions.
2. Store login credentials for the IBM Cognos system in a user data source.
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3. Name it, by convention (which is not required), cognos_admin.
The IBM EMM Authentication Provider uses the following method to authenticate
report system user:
v Each time that an IBM EMM user attempts to display a report, Marketing
Platform uses the credentials that are stored in the report system user record in
its communication with the Cognos system. The authentication provider verifies
the user credentials.
v When report authors log in to the IBM Cognos applications, they log in as the
report system user, cognos_admin and the authentication provider verifies the
user credentials.

Authenticated per user mode
When the authentication mode is set to authenticated per user, the reports system
does not use a report system user and evaluates the credentials of each individual
user. The IBM EMM Authentication Provider uses the following method in the
authenticated per user mode:
v Each time that an IBM EMM user attempts to display a report, the Marketing
Platform includes the user credentials in its communication with the Cognos
system. The authentication provider verifies the user credentials.
v When report authors log in to the IBM Cognos applications, they log in as
themselves and the authentication provider verifies their credentials.
With the authenticated per user mode, all users must have either the ReportsUser
or the ReportsSystem role to see reports. Typically, you assign the ReportsSystem
role to one or two administrators and assign the ReportsUser role to the user
groups of the IBM EMM users who need to see reports in the IBM EMM interface.
Except for checking for a reporting permission, the authentication provider does
not check for other authorization. Report authors who log in to the Cognos
applications have access to all the reports on the Cognos system, no matter how
their report folder permissions might be set on the IBM EMM system.

Reporting permissions reference
You can give access to the reporting configuration functions and to reports by
configuring the settings on the Configuration page.
Access to the reporting configuration functions and to the reports themselves are
controlled by the following settings.
User interface item

Access control

Configuration option on the Settings menu (you
configure reporting schemas on the Configuration page)

The Platform permission Access to Configuration
located under Settings > User Roles & Permissions >
Platform

Report SQL Generator and Sync Report Folder
Permissions options on the Settings menu

The Report permission report_system, located under
Settings > User Roles & Permissions > Report
The standard ReportsSystem role has this permission.
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User interface item

Access control

Analytics menu

Application access settings that vary by product, as
follows:
v

For Campaign, eMessage, and Interact, the
Administration > Access Analysis Section permission
at the campaign partition level of Settings > User
Roles & Permissions .

v

For Marketing Operations and Distributed Marketing,
the Analysis permissions in the security policies.

Analysis tabs

The Analysis (or Analyze) permissions in the security
policies for the individual objects.

Data displayed by the reports

When the authentication mode of the Cognos system is
"authenticated per user," users must have either the
ReportsSystem or ReportsUser role so that they can see
the data in a report.

Reporting schemas
You must create reporting view or tables to implement reporting for Campaign,
Interact, and eMessage. Reports can extract reportable data in the reporting views
or tables. The report packages for Campaign, Interact, and eMessage include
reporting schemas that the Reporting SQL Generator uses to produce SQL scripts
that create reporting views or tables
For Campaign and Interact, you must customize the schema templates, so the data
that you want to include in your reports is represented. You can run the Reporting
SQL Generator after you customize the schema templates. You can run the SQL
scripts that the SQL Generator generated and run the scripts on your application
databases.
You cannot customize the eMessage reporting schemas. However, you must
generate the SQL script that builds the reporting views or tables and then run the
scripts on the eMessage databases.
The reporting schemas make it easier for you to use any third-party reporting tool
to examine your IBM application data. However, if you want to display reports in
the IBM EMM user interface, your installation must be integrated with IBM
Cognos BI.

Reporting SQL Generator
The Reporting SQL Generator uses the reporting schemas to determine the analytic
logic that is necessary to extract data from the database for the IBM EMM
application. The Reporting SQL Generator then generates the SQL script that
creates views or reporting tables that implement that logic and that enables
business intelligence tools to extract reportable data.
During installation and configuration, the system implementers configured data
source properties that identify the IBM EMM application databases. The Reporting
SQL Generator connects to the application databases to complete the following
tasks:
v Validate scripts that create views or materialized views
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59

v Determine the correct data types to use in scripts that create reporting tables
If the JNDI data source names are incorrect or missing, the Reporting SQL
Generator cannot validate scripts that create reporting tables.

Reporting deployment options
You can choose a deployment option when you run the Reporting SQL Generator
tool.
When you run the Report SQL Generator tool, you specify whether you want the
script to create views, materialized views, or tables. Which deployment option you
use depends on the amount of data that is contained in your system.
v For smaller implementations, reporting views that directly query the production
data might perform sufficiently for your needs. If they do not, try materialized
views.
v For medium-sized implementations, use either materialized views on the
production system database or set up reporting tables in a separate database.
v For large implementations, configure a separate reporting database.
For all implementations, you can use Cognos Connection Administration to
schedule reports that retrieve large amounts of data to run during off hours.

Materialized views and Microsoft SQL Server
The reporting feature does not support materialized views for Microsoft SQL
Server.
In SQL Server, materialized views are called "indexed views." However, the
definition that creates an index in a view on SQL Server cannot use certain
aggregations, functions, and options that the reporting views include. Therefore, if
you are using a SQL server database, use views or reporting tables.
Note: For eMessage, you must use views.

eMessage and Oracle
If your installation includes eMessage and your database is Oracle, you must use
materialized views or reporting tables.

eMessage and IBM DB2
If your installation includes eMessage and your database is IBM DB2, you must
use materialized views or reporting tables.

Data synchronization
When you deploy with materialized views or reporting tables, determine how
frequently you want to synchronize the data with the production system data.
Then, use your database administration tools to schedule data synchronization
processes to refresh the reporting data regularly.
For eMessage, the materialized views are automatically refreshed when you run
the eMessage delta refresh stored procedures. For more information, see “Running
and scheduling stored procedures for eMessage” on page 33.
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Control groups and target groups in the reports
The example IBM Cognos BI reports from the report packages include data from
both target groups and control groups. To support these reports, the reporting
schemas contain two columns for each of the default contact and response history
metrics and default response types. One column represents the response from the
control group and the other column represents the response from the target group.
If you plan to extend the example reports or create your own new reports,
determine whether you want to include response information from both the target
and control groups. If the answer is yes and you add metrics or response types,
create two columns for that item in the reporting schema, one for the target and
one for the control. If the answer is no, you create only the target group column in
the reporting schema for that item.

Audience levels and the reports
You can change the audience level in your reports by editing the performance and
response schemas to reference the system tables for the correct audience level.
In their default state, the reporting schemas reference the system tables for the
single pre-defined audience level, Customer, that is delivered with Campaign. This
means that performance and response history reports reference the Customer
audience level by default.
You can change the audience level in your reports by editing the performance and
response schemas to reference the system tables for the correct audience level.
Additionally, for Campaign and Interact, you can add reporting schemas for
additional audience levels. You create the reporting schemas from the templates in
the Settings > Configuration pages. Add the additional reporting views to the
Cognos data model; and then modify the Cognos reports to accommodate the
additional audience level or levels.

Audience keys in reporting schemas
Specify the audience key for the audience level when you configure the audience
level for performance reports and response history, or when you create new
reporting schemas for additional audience levels.
If the key includes more than one database column (sometimes referred to as a
multikey audience key), you use commas between the column names. For example,
ColumnX,ColumnY.
The maximum length of the string you can enter in the Audience Key field of a
reporting schema is 255 characters. If the audience key is longer than 255
characters, you can work around this restriction in the generated SQL. Enter the
first 255 characters of the key in the Audience Key field and generate the SQL script
as usual. Then, open the generated script in an editor and use find and replace to
replace each of the truncated audience key references with the complete string.

Partitions and reporting schemas
If Campaign has more than one partition, you can add reporting schemas for each
partition. Create the reporting schemas from the templates in the Schemas
configuration pages.
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If Campaign has more than one partition, the system implementer configures a
reports package on the Cognos system for each partition. However, after the data
design of your system is implemented, you must revisit the reporting views or
tables for each partition.

Framework Manager data models
A Cognos model is reporting metadata that describes physical database objects and
their relationships to query subjects and query items. When you build reports in
IBM Cognos 10 BI Report Studio, you build them from query subjects and items
that are described in the data model.
The data model for an IBM EMM application references the reporting views in the
IBM EMM application database, making that data available to the Cognos 10
reports that are also delivered in the IBM EMM Reports Package.
When you configure the reporting views to include additional attributes, metrics,
response types, you synchronize the Cognos reporting model with the reporting
views and publish the revised model to the Cognos content store. At that point,
those new attributes become available in Report Studio and you can add them to
the IBM EMM reports.
The IBM Cognos 10 model from a IBM EMM Reports Package presents the IBM
EMM application metadata in the following three categories (folders).
v Import View. This level represents the data from the reporting schemas in the
IBM EMM application database. You use this view to synchronize the data
model with the IBM EMM database views, materialized views, or reporting
tables through the data source connection.
v Model View. This is the working area where you perform basic metadata
transformations. You set up relationships between object entities that are
represented by query subjects, creating building blocks that can be used in the
Business View.
v Business View. This level organizes query subjects in terms of business objects to
simplify report building. This is the information that you see when you open an
IBM EMM application report in Report Studio.
The Campaign and eMessage models include shortcuts from the Model View to the
Business View. The Interact model does not use shortcuts in the same way because
some of its query subjects span two data sources.
Note: While creating a project in IBM Cognos Configuration, use the Open
Project option to create a project. When you use the Open Create option, the
query mode is set to Compatible. Do not use the Create New Project option. The
Create New Project option uses the default template that sets the query mode to
Dynamic.

Report Studio reports
Each IBM EMM reports package contains several reports for the application that is
built with the IBM Cognos Report Studio. When the application is installed, you
can select and run an example report in the IBM EMM suite common user
interface.
Run an example report from the following locations in the IBM EMM suite
common user interface:
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v The multiple object reports are accessible from the Analytics menu.
v The single object reports appear on the Analysis tab of items like campaigns or
offers.
v Additionally, for Campaign, Marketing Operations, eMessage, and Interact, the
reports packages include pre-configured portlets (reports) for use with IBM
EMM dashboards. See the IBM Marketing Platform Administrator's Guide for
information on how to work with dashboards.

Folders, subfolders, and access settings
Each IBM EMM application's reports are organized into folders and subfolders
with names that represent both the application and the purpose of the report in the
Public Folders area.
During installation, the system implementers imported the IBM EMM application's
reports archive in Cognos Connection to the Public Folders area.
The folders and subfolders are also used by the security access control model for
Campaign , Interact, and eMessage, which includes security settings for the reports
by folder. That is, the security policies for those applications grant users access to
all the reports in a folder. The access control model for Marketing Operations does
not provide this level of access. In Marketing Operations, you either have access to
all the reports or none of the reports.
As a best practice, you must not rename the folders or subfolders in the IBM
Cognos Connection interface. If you do, ensure that you configure your IBM
application so that it recognizes the changed folder names.
v For Campaign, eMessage, and Interact, select Settings > Configuration and then
edit the values of the reporting folder properties under Campaign > partitions >
[partition name] > reports so they match the actual names of the folders.
v For Marketing Operations, open the plan_config.xml file and edit the values for
the reportsAnalysisSectionHome and reportsAnalysisTabHome configuration
settings.

Report styles and appearance
Use the GlobalReportStyles.css style sheet to establish common reporting styles
across the reports for all the IBM EMM applications.
This style sheet establishes common reporting styles across the reports for all the
IBM EMM applications. For information about styles, see the appendix
Appendix B, “Formatting the Cognos reports,” on page 133. This appendix
provides the following information for the various kinds of reports.
v The styles that are implemented by the GlobalReportStyles.css file.
v

Style formatting that you must do manually when you author a report because
you cannot implement certain styles by the style sheet.

The dash character ("-") has special meaning in the IBM EMM reports: it denotes
calculations that do not apply. For example, if the unique count in a row that
shows totals cannot be calculated, a "-" is displayed to indicate that fact.
Some of the reports do not appear at their best on systems with little or no data.
For example, a line graph with one data point cannot display a line, which makes
the graph look empty. Additionally, graphical representations of summary data do

Chapter 6. Configuring reporting

63

not list the dates or times for data points that do not have data. For example, if
you specify a date range that has only one day with data, the graph shows that
date only.
You can customize the reports to use the chart or graph type that works best for
the data from your systems.

Setting up schedules for generating reports
In IBM Cognos Connection, you can schedule the automatic running of your
reports. For each report, you can select the run frequency, format options, delivery
methods, and locations for saving.
For example, you can schedule a report to run every Monday at 9:00 AM, and
distribute the report by using an auto-generated email to a specified group of
recipients.
For details about scheduling and distributing reports, see the schedule chapter in
the IBM Cognos Connection User Guide.

Customizing reporting schemas
You can customize your reports to include custom data to display in your reports.
Complete the steps in the procedures in the following section as appropriate for
the reporting goals of your system:
v “Reporting schema”
v “Adding contact or response metrics”
v “Adding custom attributes” on page 65
v “Adding response types” on page 66
v “Adding contact status codes” on page 66
v “Specifying the calendar time periods for performance reports” on page 66
v “Configuring audience level for performance reports and response history” on
page 67

Reporting schema
The reporting schema that you must modify depends on the reports you plan to
customize. The appendix named "Reports and Reporting Schemas by Product"
provides tables that show which reporting schemas support the sample reports
provided in the report packs.
Determine which reports you plan to customize and then consult the appropriate
report to reporting schema map.
v Appendix D, “Reports and reporting schemas by product,” on page 153
v “Interact Reports and Reporting Schemas” on page 156
v “eMessage Reports and Reporting Schemas” on page 155
Note: You cannot customize the eMessage reporting schemas, but you can modify
and create new eMessage reports.

Adding contact or response metrics
You can add contact or response metrics to the Campaign Performance and Offer
Performance reporting schemas.
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Before you begin, determine the following information:
v Which reporting schema supports the report you want to add the metric to. See
the appendix Appendix D, “Reports and reporting schemas by product,” on
page 153 for information.
v Whether you need to add a column to the reporting schema for the control
group in addition to the target group. See “Control groups and target groups in
the reports” on page 61.
v How the metric is calculated. For example, it could be summed, averaged, or
counted.
Complete the following steps to add contact or response metrics:
1. Select Settings > Configuration and expand Reports > Schemas > Campaign >
name of the appropriate reporting schema .
2. Expand the Columns node and select either Contact Metric or Response
Metric.
3. In the form on the right, click New category name and enter the name of the
contact or response metric.
4. For Column Name, enter the name to use in the reporting schema for the
attribute. Use all uppercase letters with no spaces.
5. For Function, specify how the metric is calculated or determined.
6. For Input Column Name, enter the name of the column for this attribute from
the appropriate table in the IBM application database. Input column names are
case-sensitive.
7. For Control Treatment Flag, enter the number 0 (zero) to indicate that this
column in the reporting schema represents the target group.
8. Click Save Changes.
9. Repeat this procedure to add the control group column to the reporting
schema, if necessary. This time, enter the number 1 (one) to indicate that this
column represents the control group.

Adding custom attributes
You can add custom campaign, offer, and cell attributes to the Custom Campaign
Attributes reporting schema.
Before you begin, determine the following information.
v The value from the attribute's AttributeID column in the UA_CampAttribute,
UA_CellAttribute, or UA_OfferAttribute table, as appropriate
v The data type of the attribute: string value, number value, or date/time value
Complete the following steps to add custom attributes:
1. Select Settings > Configuration and expand Reports > Schemas > Campaign >
Campaign Custom Attributes > Columns.
2. Select the type of column that matches the type of attribute you want to add.
3. In the form on the right, click New category name and enter the name of the
custom attribute.
4. For Column Name, enter the name to use in the reporting schema for the
attribute. Use all uppercase letters with no spaces.
5. For Attribute ID, enter the ID of this attribute.
6. For Value Type, specify the data type of the attribute.
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Note: If you are adding an attribute that holds a currency value, specify
NumberValue in the Value Type field. If you are adding an attribute whose Form
Element Type was set to Select Box - String in Campaign, specify
StringValue in the Value Type field.
7. Click Save Changes.

Adding response types
You can add response types to the Campaign Offer Response Breakout schema.
Before you begin, determine the following information:
v Whether you need to add a column to the reporting schema for the control
group in addition to the target group. See “Control groups and target groups in
the reports” on page 61.
v The response type code from the UA_UsrResponseType table.
Complete the following steps to add response types:
1. Select Settings > Configuration and expand Reports > Schemas > Campaign >
Campaign Offer Response Breakout > Columns > Response Type.
2. In the form on the right, click New category name and enter the name of the
response type.
3. For Column Name, enter the name to use in the reporting schema for the
response type.
4. For Response Type Code, enter the three letter code for this response type.
Response type codes are case-sensitive.
5. For Control Treatment Flag, enter the number 0 (zero) to indicate that this
column in the reporting schema represents the target group
6. Click Save Changes.
7. Repeat this procedure to add the control group column to the reporting
schema, if necessary. This time, enter the number 1 (one) to indicate that this
column represents the control group.

Adding contact status codes
You can add contact status codes to the Campaign Offer Contact Status Breakout
schema. You can determine the contact status code from the UA_ContactStatus
table.
Complete the following steps to add the contact status codes:
1. Select Settings > Configuration and expand Reports > Schemas > Campaign >
Campaign Offer Contact Status Breakout > Columns > Contact Status.
2. In the form on the right, click New category name and enter the name of the
contact status type.
3. For Column Name, enter the name to use in the reporting schema for the
contact status type
4. For Contact Status Code, enter the three letter code for this contact status.
Contact status codes are case-sensitive.
5. Click Save Changes.

Specifying the calendar time periods for performance reports
The standard reports for both Campaign and Interact include performance reports
that summarize data over calendar periods.
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To specify time periods that are used in these reports to be something other than
the default over time variations, complete the following steps:
1. Select Settings > Configuration and expand Reports > Schemas and then
select either Campaign or Interact.
2. Select the performance schema of interest.
3. Click Edit Settings.
4. In the Schema Settings section, select the appropriate values for the Over Time
Variations option list.
5. Click Save Changes.

Configuring audience level for performance reports and
response history
You can customize your Campaign and Interact reporting schemas to include
custom data to display in your reports.
Before you begin, determine the following information:
v The names of the contact history, detailed contact history, and response history
tables for the audience level of interest.
v The audience key to the contact history and detailed contact history tables. See
“Audience keys in reporting schemas” on page 61.
Then, complete the following procedures for each of the appropriate reporting
schemas:
v For Campaign: Offer Performance, Campaign Performance, Campaign Offer
Response Breakout, Campaign Offer Contact Status Breakout
v For Interact: Interact Performance
1. Select Settings > Configuration and expand Reports > Schemas > ProductName
> SchemaName.
2. In the form on the right, click Edit Settings.
3. In the Input Tables section, identify the system tables for the audience level
and the audience key.
Note: Remember to use commas to separate column names for a multikey
audience key. For more information, see “Audience keys in reporting schemas”
on page 61.
4. Click Save Changes.

Reporting schemas for extra audience levels or partitions
You can create reporting schemas for extra audience levels or partitions by using
following information.
You are likely to create additional reporting schemas for the following reasons:
v You want to report on more than one audience level. Perhaps you plan to create
reports that present data for more than one audience level, or add filters that
prompt users to specify one of several audience levels. Therefore, you need
schemas that point to an additional set of contact and response history table.
v You are configuring reporting for multiple partitions and you need to implement
different schema customizations for each set of partition system tables
Before you begin, determine the following information.
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v Which reporting schemas to create.
– For Campaign: Campaign Offer Response Breakout, Offer Performance,
Campaign Performance, Offer Contact Status Breakout, and Campaign
Custom Attributes
– For Interact: Interact Performance
v The names of the following tables for this audience level.
– For Campaign: contact history, detailed contact history, and response history
tables
– For Interact: detailed contact history and response history tables
v The name of the audience key column (or columns) for this audience level
v Pick a short 2 or 3 letter code to represent the name of the audience level. You
use this code when you specify the table or view names for the new reporting
schema.
Complete the steps in the following procedures as appropriate for your reporting
goals.

Creating a Campaign Offer Response Breakout schema
You can create reporting schemas for extra audience levels or partitions if you
want to configure reporting for multiple audience levels or multiple partitions.
1. Select Settings > Configuration and expand Reports > Schemas > Campaign
> Campaign Offer Response Breakout Star Schema.
2. Click New category name and enter a descriptive name for the reporting
schema that indicates the audience level. For example, Campaign Offer
Response Household.
3. In the Input Tables section, enter the name of the response history table for
this audience level, and then click Save Changes.
A new node appears in the Configuration tree for the schema. You cannot
change the name of the node.
4. Under the new node, select Columns > Response Type and then configure
the response types for this audience level.
For help with this step, see the procedure “Adding response types” on page
66.
5. Under the new node, select SQL Configuration > Campaign Response
Breakout and click Edit Settings.
6. In the form that appears, edit the name in the Table/View Name field to
include the code for the audience level. The name can be no longer than 18
characters and must be in all uppercase letters. For example, if the name of
the audience level is household, you might specify: UARC_CRBO_HH_.
For more information about table and view naming conventions, see the
“Reports | Schemas | [product] | [schema name] | SQL Configuration” on
page 116.
7. Click Save Changes.
8. Under the new node, select SQL Configuration > Campaign Offer Response
Breakout and click Edit Settings.
9. Edit the name in the Table/View Name field to include the code for the
audience level. The name can be no longer than 18 characters and must be in
all uppercase letters. For example, UARC_CORBO_HH_.
10. Click Save Changes.
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Creating a Campaign Offer Contact Status Breakout schema
You can create reporting schemas for extra audience levels or partitions if you
want to configure reporting for multiple audience levels or multiple partitions.
1. Select Settings > Configuration and expand Reports > Schemas > Campaign
> Campaign Offer Response Breakout Star Schema.
2. Click New category name and enter a descriptive name for the reporting
schema that indicates the audience level. For example, Campaign Offer
Contact Status Household.
3. In the Input Tables section, enter the name of the response history table for
this audience level, and then click Save Changes.
A new node appears in the Configuration tree for the schema. You cannot
change the name of the node.
4. Under the new node, select Columns > Contact Status Code and then
configure the contact status codes for this audience level.
For help with this step, see the procedure “Adding contact status codes” on
page 66.
5. Under the new node, select SQL Configuration > Campaign Contact Status
Contact History and click Edit Settings.
6. In the form that appears, edit the name in the Table/View Name field to
include the code for the audience level. The name can be no longer than 18
characters and must be in all uppercase letters. For example, if the name of
the audience level is household, you might specify: UARC_CCSBO_HH_.
7. Click Save Changes.
8. Under the new node, select SQL Configuration > Campaign Offer Contact
Status Contact and click Edit Settings.
9. Edit the name in the Table/View Name field to include the code for the
audience level. The name can be no longer than 18 characters and must be in
all uppercase letters. For example, UARC_COCSBO_HH_.
10. Click Save Changes.

Creating an Offer Performance schema
Use Offer Performance Star Schema to create an Offer Performance schema.
Complete the following steps to create an Offer Performance schema:
1. Select Settings > Configuration and expand Reports > Schemas > Campaign
> Offer Performance Star Schema.
2. In the New category name, enter a descriptive name for the reporting schema
that indicates the audience level. For example, Offer Performance Household.
3. In the Input Tables section, identify the tables that support the audience level
and the audience key.
4. In the Schema Settings section, select the Over Time Variations options that
apply and then click Save Changes.
A new node appears in the Configuration tree for the schema. You cannot
change the name of the node.
5. Under the new node in the Configuration tree, select Columns > Contact
Metric and then configure the contact metrics for this audience level.
For help with this step, see the procedure “Adding contact or response
metrics” on page 64.
6. Under the new node, select Columns > Response Metric and then configure
the response metrics for this audience level.
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For help with this step, see the procedure “Adding contact or response
metrics” on page 64.
7. Under the new node, expand SQL Configuration, select the first item (Offer
Contact History) and click Edit Settings.
8. In the form that appears, edit the value in the Table/View name field to
include the code for the audience level. The name can be no longer than 18
characters and must be in all uppercase letters. For example, if the name of
the audience level is household, you might specify: UARC_OCH_HH_.
9. Click Save Changes.
10. Repeat steps 7 through 9 for each item that is listed under the SQL
Configuration section of the new reporting schema.

Creating a Campaign Performance schema
Use Campaign Performance Star Schema to create a Campaign Performance
schema.
Complete the following steps to create a Campaign Performance schema:
1. Select Settings > Configuration and expand Reports > Schemas > Campaign
> Campaign Performance Star Schema.
2. Click New category name and enter a descriptive name for the reporting
schema that indicates the audience level. For example, Campaign Performance
Household.
3. In the Input Tables section, identify the tables that support the audience level
and the audience key.
4. In the Schema Settings section, select all the Over Time Variations options
that apply and then click Save Changes.
A new node appears in the Configuration tree for the schema. You cannot
change the name of the node.
5. Under the new node, select Columns > Contact Metric and then configure the
contact metrics for this audience level.
For help with this step, see the procedure “Adding contact or response
metrics” on page 64.
6. Under the new node, select Columns > Response Metric and then configure
the response metrics for this audience level.
For help with this step, see the procedure “Adding contact or response
metrics” on page 64.
7. Under the new node, select SQL Configuration and select the first item,
Campaign Contact History.
8. In the form that appears, edit the value in the Table/View name field to
include the code for the audience level. The name can be no longer than 18
characters and must be in all uppercase letters. For example, if the name of
the audience level is household, you might specify: UARC_CCH_HH_.
9. Click Save Changes.
10. Repeat steps 8 and 9 for each item that is listed under the SQL Configuration
section of the new reporting schema.

Creating a Campaign Custom Attributes schema
You need just one Campaign Custom Attributes schema for each partition. The
same schema is used for all audience levels.
Complete the following steps to create a Campaign Custom Attributes schema.
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1. Select Settings > Configuration and expand Reports > Schemas > Campaign >
Campaign Custom Attributes.
2. In the New category name, enter a descriptive name for the reporting schema
that indicates the partition. For example, Campaign Custom Attributes
Partition 2.
3. Under the new node in the Configuration tree, expand Columns and then add
the custom cell, offer, and campaign attributes that are required by the partition
for which you are creating this reporting schema.
For help with this step, see the procedure “Adding custom attributes” on page
65.
4. Optional: You can edit the view or table names. Under the new node, expand
SQL Configuration and select each item and examine the view or table names.
If you decide to change the names, make sure that names can be no longer
than 18 characters, must be in all uppercase letters, and can include no spaces.
5. Click Save Changes.

Creating an Interact Performance schema
Use Interact Performance Star Schema to create Interact Performance Schema.
Complete the following steps to create an Interact Performance schema
1. Select Settings > Configuration and expand Reports > Schemas > Interact >
Interact Performance Star Schema.
2. In the New category name field, enter a descriptive name for the reporting
schema that indicates the audience level. For example, Interact Performance
Household.
3. In the Input Tables section, identify the tables that support the audience level
and the audience key.
4. In the Schema Settings section, select all the Over Time Variations options that
apply and then click Save Changes.
A new node appears in the Configuration tree for the schema. You cannot
change the name of the node.
5. Under the new node, select SQL Configuration and select the first item,
Interactive Channel Offer Contact History Summary.
6. In the form that appears, edit the value in the Table/View name field to
include the code for the audience level. The name can be no longer than 18
characters and must be in all uppercase letters. For example, if the name of the
audience level is household, you might specify: UARI_ICP_OCH_HH_.
7. Click Save Changes.
8. Repeat steps 6 and 7 for each item that is listed under the SQL Configuration
section of the new reporting schema.

Customizing the IBM Cognos Model
When you customize an IBM EMM reporting schema to include additional metrics,
attributes, or audience levels and then modify the reporting view or tables that are
based on that schema, you must also edit the IBM Cognos BI model.
Use the IBM Cognos Framework Manager features to query the views or tables
and then import the additional items in the data model.
The way you update the Cognos model depends on the changes you made in the
IBM EMM reporting views or tables.
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v

If you modified existing views by adding columns for attributes, metrics, or
response types, import the new columns by updating the query object that
represents the associated view.

v

If you modified the over time variations for performance or runtime reports or
created new reporting schemas for additional audience levels, you have added
new views. In this case, use the Framework Manager MetaData Wizard to
import the views into the data model.

This section provides examples that you can use as guidelines for adding your
customizations to the Cognos model. For more information, see the IBM Cognos BI
Framework Manager User Guide and the Framework Manager online help.

Adding attributes to an existing view or table in a data model
You can add attributes to an existing view or table in a data model by using the
IBM Cognos Report Studio.
The following example procedure shows how to add an item to an existing view in
the IBM Cognos model. For this example, assume that you need to add a custom
offer attribute to the Campaign database and then include it in a report. You have
already completed the following tasks:
v Created the offer attribute in the UA_OfferAttribute table.
v
v
v

Added the offer attribute to the Campaign Custom Attributes reporting schema.
Used the Reports SQL Generator to generate the view creation script.
Ran the generated script in the Campaign database to update the Offer Custom
Attribute reporting view, UARC_OFFEREXTATTR.

Now, to add the new offer attribute to the Cognos Campaign model, you would
complete the following steps.
1. Make a backup of the Campaign model. That is, browse to the Cognos/models
directory and copy the CampaignModel subdirectory. In a distributed Cognos
environment, the models directory is in a location on the system running the
Content Manager.
2. In Framework Manager, open the Campaign.cpf file (the project) and expand
the Import View node.
3. Under Import View, select the query object that represents the reporting view
for custom offer attributes: Import View > Campaign Custom Attributes >
UARC_OFFEREXTATTR.
4. Select Tools > Update Object. Cognos refreshes the columns that are listed
under the node for the view so they reflect all the columns currently present in
the UARC_OFFEREXTATTR reporting view in the Campaign database.
5. Expand the Model View and select the node that represents custom offer
attributes in this view: Model View > Campaign Custom Attributes > Offer
Custom Attributes.
6. Double-click the Offer Custom Attributes node to open the Query Subject
Definition dialog box.
7. Locate the new column and add it to the Model View. Then, edit the name of
the query item so it can be read easily. For example, the column that is named
LASTRUNDATE in the Import View of the Campaign data model appears as Last
Run Date in the Model View.
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Note: Because the Business View contains a shortcut to the Offer Custom
Attributes node in the Model View, the new query item now available in the
Business View without your having to add it manually.
8. Save the model.
9. Publish the package to the Cognos content store.
Now you can add the attribute to the appropriate report by using IBM Cognos
Report Studio.

Adding new views to IBM Cognos data model
You can add new views or tables to the IBM Cognos data model. Use IBM Cognos
Framework Manager features to query the views or tables and then import the
additional items in the data model.
The following example procedure shows how to add new views or tables to the
IBM Cognos data model. For this example, assume that you changed the Over
Time Variations for the Campaign Peformance reporting schema and now need to
import the change in the Cognos model. You have already completed the following
tasks:
v Modified the Campaign Performance schema by adding Quarterly to the Over
Time Variations options.
v Used the Reporting SQL Generator to generate the view creation script. This
script now contains instructions to create the following additional reporting
views: UARC_CCCH_QU, UARC_CCH_QU, UARC_CCRH_QU,
UARC_COCH_QU, UARC_CORH_QU, and UARC_CRH_QU
v Ran the generated script in the Campaign database to create the additional
reporting views.
Now, to add the new reporting views to the Cognos Campaign data model, you
would complete the following steps.
1. Make a backup of the Campaign model.
That is, browse to the Cognos/models directory and copy the CampaignModel
subdirectory. In a distributed Cognos environment, the models directory is in a
location on the system running the Content Manager.
2. In Framework Manager, open the Campaign project and expand the Import
View node
3. Select the Campaign Performance folder and run the Metadata Wizard
(accessed through the right-mouse menu).
4. Use the Metadata Wizard to import the new views.
5. Expand the Model View > Campaign Performance node and model a new
entry named Campaign Performance by Quarter.
For help with this step, examine the other entries for reference. Be sure to
maintain the same structure and relationships that are included in the other
over time variation nodes. Additionally, consult the Cognos BI Framework
Manager User Guide for the following information:
v Creating a namespace.
v Creating star schema groupings.
v Adding joins.
6. Expand the Business View and create a shortcut to the Campaign Performance
by Quarter node in the Model View .
7. Save the model.
8. Publish the package to the Cognos content store.
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9. Open Report Studio and create a new report with the objects from the Campaign
Performance by Quarter schema that you created.

Customizing or creating Cognos reports for IBM EMM applications
You can customize the example reports so they include your custom data and you
can create new reports. From Cognos Connection, you can configure options for
the reports, schedule them to run at regular times, and use Report Studio to
customize them.
Consult the following sources when you are planning and implementing your
reports.
v The user's guides for your IBM EMM applications include short descriptions of
all the reports in the IBM EMM reports package for that product.
v The IBM EMM reports packages provide reference documentation that describes
the specifications of each of the reports in the pack and the Framework Manager
metadata model that supports the reports. You can find the reference
documentation in the reports package installation directory, in a location similar
to <ReportsPackInstallationDirectory>/cognos10/<Product>Docs.
For example, the IBM EMM Campaign reports package documentation might be
found in the Reports Pack installation directory under /IBM/EMM/
ReportsPackCampaign/cognos10/CampaignDocs.
Examine these documents before you customize a model or a report. Be sure
that you understand how a report is constructed before you modify it.
v For detailed documentation about creating and editing IBM Cognos BI reports,
see the IBM Cognos BI documentation, especially the IBM Cognos BI Report
Studio Professional Authoring User Guide.
v For information about the report styles to use, see the appendix Appendix B,
“Formatting the Cognos reports,” on page 133.
v For information about customizing Marketing Operations reports, see the
Marketing Operations Administration Guide.

Guidelines for creating new Campaign reports
The IBM EMM reporting package for Campaign includes example reports. Use the
Report Studio to create a new report, or modify an existing report.
Use the following guidelines to create new reports for Campaign in IBM Cognos
Report Studio:
v Examine the reference documentation that describes the metadata model and the
specifications of the example reports from the Campaign report package. It is in
the CampaignReportPack\cognosN\docs subdirectory in the report package
installation directory, where N is the version number of your Cognos installation.
v Using Report Studio, create a new report, or copy and modify an existing report.
For details, see the Cognos Report Studio documentation.
v If you are modifying a copy of an existing report (or the report itself), ensure
that you understand how the report is constructed. Then, you can add your
custom attributes and metrics, and modify the objects and query items in an
appropriate way, by using the toolbar and Properties pane in Report Studio. For
information about using Report Studio, see the Cognos Report Studio
documentation. For information about the objects and query items in an example
report, consult the reference documentation from the report package.
v For object-specific reports that appear on the Analysis tab, create a parameter ID
that accepts the passed value from the object. For a system-wide report that
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appears on the Analysis page, create a prompt that contains all object values for
campaigns or offers. For details, see the Cognos Report Studio documentation.
v Save the new report into the appropriate folder under Public Folders to make it
visible in Campaign.
– If it must appear on the Analysis tab, save it in the Campaign - Object
Specific Reports folder.
– If it must appear on the Analysis page, save it in the Campaign folder.
– If you plan to add it to a dashboard portlet, save it in the Unica
Dashboards\Campaign folder.

Configuring the Interaction Point Performance dashboard
portlet
Interact has one IBM Cognos dashboard report: Interaction Point Summary.
Because dashboard reports do not prompt users for query parameters, the channel
ID of the interactive channel in the Interaction Point Performance report is a static
value. By default, the channel ID for this report is set to 1. If the channel ID is not
correct for your implementation, you can customize the report and change the
channel ID in the report's filter expression.
To customize any of the IBM Cognos reports, you need IBM Cognos report
authoring skills. For detailed documentation about creating and editing IBM
Cognos BI reports, see the IBM Cognos BI documentation, especially IBM Cognos
BI Report Studio Professional Authoring User Guide for the version of Cognos you are
using.
For information about the queries and data items in the Interaction Point
Performance report, see the reference documentation that is provided in the
Interact report package.
If you need to display a chart for more than one interactive channel in the
Dashboard, make a copy of the Interaction Point Performance Dashboard and
modify the channel ID. Then, create a new dashboard portlet for the new report
and add it to your dashboards.

Guidelines for creating new, custom dashboard reports
The IBM EMM reporting packages for Campaign, Interact, eMessage, and
Marketing Operations include pre-configured reports (portlets) that are specially
formatted for use with IBM EMM dashboards.
See the IBM Marketing Platform Administrator's Guide for details on working with
dashboards and by using these pre-configured portlets.
If you want to create new, custom dashboard reports in Cognos Report Studio, use
the following guidelines.
v Examine the reference documentation that describes the metadata model and the
specifications of the example reports from the report package. It is in the
ProductNameReportPack\cognosN\docs subdirectory in the report package
installation directory, where N is the version number of your Cognos installation.
v Save all dashboard reports in the appropriate product subdirectory under the
main Unica Dashboards folder.
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v The report must be formatted and sized so it fits properly in a dashboard
portlet. See “Dashboard report styles” on page 141 in the "Style Guide for the
IBM Cognos BI reports" appendix for a description of the formatting you must
use.
v Do not include a title in a dashboard report. The portlet it appears in gives the
report its title.
v Do not include hyperlinks in a dashboard report.
v Do not include page numbers in a dashboard report.
To create a new dashboard portlet and add the report to it, see the IBM EMM
Marketing Platform Administrator's Guide.
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Chapter 7. User authorization for Cognos folders and reports
A Custom Java Authentication Provider (CJAP) provides authorization for users
accessing Cognos report folders and reports. You can implement this feature after
you implement the IBM EMM Authentication Provider, which provides single
sign-on authentication between IBM EMM applications and Cognos.

Limitations of the IBM EMM Authentication Provider
After Cognos has been configured to use the IBM EMM Authentication Provider,
users are authenticated automatically in Cognos when they access reports in an
IBM EMM application. If a user accesses the Cognos URL in the same browser
session used to access IBM EMM products, Cognos does not prompt the user to
log in again.
A user logged in to the Cognos user interface becomes a part of the Cognos
Everyone group. This is the default Cognos namespace implementation. The
Everyone group in Cognos has System Administrator privileges by default. This is
a security risk, because every user becomes a admin user. A malicious user can
take advantage of this permission to delete or edit reports in public folders.
The IBM EMM Authentication Provider authenticates users in Cognos, but it does
not authorize them in Cognos. To correct this limitation, the CJAP implementation
makes users visible in the security section of the Cognos in namespace. When this
is done, you can administer user roles and permissions in Cognos.

Overview of the CJAP implementation
The CJAP implementation brings all users in the IBM EMM application who have
report access into a Cognos namespace that you specify. The CJAP associates IBM
EMM users with Cognos groups based on their IBM EMM product access. Users
who have the ReportsUser role in IBM EMM receive read-only limited access to
Cognos folders and reports. Users who have the ReportsSystem role in IBM EMM
receive administrator permission in Cognos. You can also customize groups and
roles to secure custom reports and report folders in Cognos.

CJAP prerequisite
Before you implement CJAP, ensure that the IBM EMM Authentication Provider is
implemented and tested.

How to implement CJAP security
Follow the procedures in this section in the order shown to implement CJAP
security.
Before you begin to perform the implementation procedures, read this section to
understand some special considerations that might apply to your environment.
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Authenticated mode
When you configure the IBM EMM Authentication Provider, you can set the value
of the Authentication Mode property by selecting either authenticated or
authenticatedPerUser.
If you selected authenticated, all users are authenticated using the same user
account.
Note the following considerations when you use the authenticated option.
v By default, the user account that the system uses for authentication is
Cognos_admin. When you implement CJAP authentication, it is a best practice
to give the Cognos_admin user the ReportUser role in IBM EMM.
v You do not have to perform the following procedures described in this chapter.
These procedures apply only when you select authenticatedPerUser for the IBM
EMM Authentication Provider.
– Giving all Reports users read-only permissions in public folders
– Securing public folders
– Verifying user permissions in Cognos

Performing backups for CJAP
Before you implement CJAP, back up your Cognos environment.
1. Stop the Cognos service.
2. Use the export option in the Cognos Configuration File menu to back up your
Cognos configuration.
3. Back up the content database.
4. Manually back up the webapps\p2pd\WEB-INF\AAA folder located under your
Cognos installation

Editing and synchronizing the property file
The property file determines which groups in IBM EMM are duplicated in Cognos.
You edit the property file to specify the Marketing Platform groups you want to
synchronize into Cognos.
First, design the required reports access in Marketing Platform by creating groups,
associating them with appropriate roles, and making users members of these
groups.
Perform the following procedure with the Cognos service stopped, and restart the
service after you edit the properties file. You must restart the Cognos service after
you make any changes to the properties file.
1. Locate the ReportSecurityConfig.properties file in the \webapps\p2pd\WEBINF\AAA\lib\ folder under your Cognos installation and open it in a text editor.
2. Follow the instructions in the file for how to set the properties.
For example you might set the properties as follows.
v useFolderSecurity=true
v createEMMProductReportGroupsToSecureCognosReportFolders=Campaign
In Cognos, sub folders are created under the folder you specify here.
v createCampaignReportsSyncFolderPermissionGroups=true
v createUserGroupInCognosSameAsPlatformGroup=Test_grp
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Groups you specify here must exist in Marketing Platform.
v createUserGroupInCognosWithPlatformUserRole=User_Defined_Role01
Roles you specify here must exist in Marketing Platform.
3. Restart the Cognos service.
4. Click Settings > Sync Report Folder Permissions in the IBM EMM user
interface to synchronize the property file.

Configuring the new namespace provider in Cognos
Configure a new namespace provider in Cognos for CJAP.
1. In Cognos Configuration, navigate to the Security > Authentication folder.
2. Add a new Namespace resource to the Authentication folder.
3. Give the namespace a name.
4. Select Custom Java Provider from the Type menu and click OK.
This creates a new namespace for the security CJAP.
5. Select the new namespace and enter the name you gave the namespace as the
ID for the provider.
6. Enter com.ibm.emm.cognos.provider.EMMSuiteSecurityCJAP for the class name.
Ensure that there are no leading or trailing spaces.
7. Set the Selectable for authentication? property to True for test purposes.
v True - Allows the users to log in to Cognos using IBM EMM credentials.
External users can log in without password, so this is not recommended for
production.
v False - This namespace is not available for authentication on the Cognos UI,
but the IBM EMM integration will work.
Change to this setting is after testing is completed.
8. Log in to Cognos under the new namespace, with an IBM EMM account that
has the Report_System role in IBM EMM.
The URL is similar to: http://host:port/ibmCognos/cgi-bin/Cognos.cgi
If you can see the Cognos application it means that the new authentication
provider is working.
9. In IBM EMM, navigate to the Settings > Configuration page and set the
Reports | Integrations | Cognos 10 | Autentication namespace configuration
property to the same name you set in Cognos.
10. Verify that the Cognos reports are running correctly in IBM EMM.

Verifying synchronization
Verify that groups, users, and roles exist as expected in the Cognos namespace.
1. In Cognos Connection, click Launch > Cognos Administration.
2. On the Security tab click Users, Groups, and Roles.
3. Select the namespace you created.
4. Click the Groups folder and verify that groups have synchronized correctly, as
follows.
v Verify that the following three default groups are present and that they have
the expected members.
– EMM_Report_System_Admin_User
Users with the ReportsSystem role in IBM EMM are members of this
group.
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– EMM_Report_User_Role_Users
Users with the ReportsUser role in IBM EMM are members of this group.
– EMM_Report_Access_All_Users
Users with the ReportsUser role in IBM EMM are members of this group.
v Verify that the groups you specified in the
ReportSecurityConfig.properties file are present and that they have the
expected members.
5. Click the Users folder and verify that all users with the ReportsSystem or
ReportsUser role in Marketing Platform are listed in this folder.
Attention: Users who are granted report permissions through group
membership appear in Cognos after they access reports in IBM EMM. Also,
new users are listed after Cognos is restarted or after the user accesses reports
in IBM EMM.
6. Click the Roles folder and verify that the expected role members are present, as
follows.
v All users with the ReportsSystem role in Marketing Platform have the
Reports_System_Role in Cognos.
v All users with the ReportsUser role in Marketing Platform have the
Reports_User_Role in Cognos.

Assigning Cognos permissions to the new roles
Use this procedure to assign permissions to the Cognos Reports_System_Role and
Report_ User_Role roles in Cognos that are equivalent to the Marketing Platform
ReportSystem role and ReportUser roles respectively.
1. In Cognos Connection click Launch > IBM Cognos Administration.
2. On the Security tab, click Users, Groups, and Roles.
3. Navigate to Directory > [your namespace] > Roles.
4. Click the Report_User_Role icon and give this role read-only permissions as
follows.
a.
b.
c.
d.

On the Permissions tab, click Add > Cognos Namespace.
Select the All authenticated Users group, click Add, and click OK.
Grant Read, Execute, and Traverse permissions.
Deny Write and Set Policy permissions.

e. Click OK.
5. Click the icon for the Reports_System_Role and give this role all permissions
as follows.
a.
b.
c.
d.

On the Permissions tab, click Add > Cognos Namespace.
Select the All authenticated Users group, click Add, and click OK.
Grant Read, Write, Execute, Set Policy, and Traverse permissions.
Click OK.

Removing the Everyone group from the Cognos System
Administrators role
By default all authenticated users are members of the Everyone group in Cognos,
and members of this group have the System Administrators role in Cognos. This
grants all users administrator rights in Cognos by default. This procedure assigns
the EMM_ Report_System_Admin_User group or Reports_System_Role role as
administrators in Cognos, and removes the Everyone group from the Cognos
System Administrators role.
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1.
2.
3.
4.

In Cognos Connection click Launch > IBM Cognos Administration.
On the Security tab, click Users, Groups, and Roles.
Click the Cognos namespace.
Find the System Administrators role, click the Set properties icon, and modify
the Everyone group as follows.
a. Click the Members tab.
The Everyone group is listed.
b. Click Add and click your namespace.
c. Add the EMM_Report_System_Admin_User group or the
Reports_System_Role role.
d. Click OK.
e. Select the Everyone group and click Remove.

Giving all Reports users read-only permissions in public
folders
Make users with the Marketing Platform ReportSystem and ReportUser roles
members of the EMM_Report_Access_All_Users group. Give members of this
group read-only access for the public folders in Cognos.
Note: The EMM_Report_System_Admin_User group has system administrator
permissions in Cognos. To grant an IBM EMM user this level of permissions in
Cognos, make that user a member of the EMM_Report_System_Admin_User
group.
1. In Cognos Connection, click the Set properties for Public Folders icon.
2. On the Permissions tab, click Add, click your namespace, and click Groups.
3. Add the EMM_Report_Access_All_Users group from your namespace.
4. Remove all other roles and groups from the permissions.
5. Grant Read, Execute, and Traverse permissions.
6. Deny Write and Set Policy permissions.
7. Click OK.

Securing public folders
To ensure that you control access to public folders in Cognos, perform this
procedure on all public folders, including the folders created for each IBM EMM
product report pack.
In the example below, fff represents any public folder that must be assigned to a
user group in your namespace.
1. Select Set properties of fff folder and click the Permissions tab.
By default, permissions are the EMM_Report_Access_All_Users group
permissions you provided in a previous step for all folders.
2. Click the Override the access permissions acquired from the parent entry
check box and specify a different group as follows.
a. Click Add, click your namespace, click Groups, click Select, and add your
desired group.
b. Add your desired group and click OK.
c. Remove all other groups and grant the desired permissions to the newly
added group.
d. Click OK.
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3. Verify that users in the selected group have the expected access to the folder,
and that users who are not members of the group do not have access to the
folder.

Verifying user permissions in Cognos
Verify that your implementation of CJAP is working as expected.
Cognos authentication is based on cookies. To execute these tests, delete the
Cognos cookies and use a new browser window when you switch between users.
1. Log in to Cognos using an account with the Report_User_Role role in Cognos.
2. Verify that this user has the following access.
v No access to IBM Cognos Administration.
v No access to the public folder that you secured.
v Cut, Paste, and Delete buttons are disabled.
v The user can copy, but can paste only in the user’s folder under My Folders.
v The user can add a folder under My Folders but not under Public Folders.
3. Verify that the members of Marketing Platform groups you have specified in
the properties file are in the expected groups and have the expected
permissions.
4. Use the following information to help resolve problems.
v If reports are not accessible to a user, verify that the user has either the
Report_User_Role or the Reports_System_User role in Cognos.
v Enable logs in the property file by providing the path to the log file.
5. When all of your tests are finished, in Cognos Configuration, navigate to the
Security > Authentication folder and in the namespace you used for CJAP, set
the Selectable for authentication? property to False.

Removing the CJAP implementation from your environment
Follow this procedure if you implement CJAP security and later decide to roll back
your environment to use only the IBM EMM Authentication Provider.
1. Reverse the following steps that you performed to implement CJAP.
a. Restore the reportSecurityConfig.properties file from your backup and
click Settings > Sync Report Folder Permissions in the IBM EMM user
interface to synchronize the property file.
b. Add the Cognos Administrators role to the Everyone group in the Cognos
namespace.
When you configured CJAP, you removed this role from the Everyone
group in the Cognos namespace. You must add it back or Cognos will have
no users with administrator permissions. If that occurs, you must set up a
new content data store database, or restore the content store from the
backup database.
2. Stop and restart the Cognos service.
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Chapter 8. Configuring reporting for multiple partitions
You can set up reporting after you configure multiple partitions in Campaign and
eMessage.
For instructions on configuring partitions in Campaign and eMessage, see the IBM
Campaign Administrator's Guide.

Configuring the IBM Cognos Reports for multiple partitions
If you are using Campaign, eMessage, and/or Interact with more than one
partition, you must configure IBM Cognos reports packages for each partition. The
partition_tool.sh utility is used to configure reports for multiple partitions.
When you run the partition_tool.sh utility, it does the following:
v Copies the xml files from the original reports zip archive.
v Replaces the package references in the xml files to reference a new package
under a new folder that you specify.
v Zips up the new files into a new archive, adding the new partition name to the
end of the file name.
After you run the partition_tool.sh utility, you create a folder in Cognos
Connection by using the name that you specified, and import the new archive into
that folder. Finally, you copy the original project file (which contains the model) so
you can change the datasource to point to the new partition, and then publish the
model to the new folder.

Prerequisites for multiple partitions
The reporting partition utility, partition_tool.sh, is a UNIX shell script. You can
configure IBM Cognos reports packages for multiple partitions by using the
partition_tool.sh utility.
Before you run the utility, complete the following steps:

Determine values for input parameters
The reporting partition tool has two input parameters: the name of the partition
folder you want to create in Cognos, and the location of the reports archive to
copy.
v Decide the name of the top-level partition folder you plan to create in Cognos.
This name is used in Cognos for the package references. For example,
"Partition2."
v Note the path to the original reports archive. For example: IBM\Unica\
ReportsPacksCampaign\cognos<version>\Unica Reports for Campaign.zip

Windows only: obtain a shell script simulator
If Cognos is running on Windows, you must run the script from a shell script
simulator (for example, Cygwin).
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If you do not have a shell script simulator installed on the computer that is
running the Cognos Content Manager, download and install one now.

Ensure that a zip utility is installed
The reporting partition tool creates a zip archive for the new partition reports. To
enable this function, a zip utility must be installed on the Cognos system.
If you do not have a zip utility installed on the computer that is running the
Cognos Content Manager, download and install one now.

Running the reporting partition tool to create a copy of the reports
archive zip file
You must create a copy of the reports archive zip file by running the
partition_tool.sh utility for each partition.
Perform this procedure for each partition in your system.
1. From the shell or the shell simulator, browse to the IBM\Unica\Platform\tools\
cognos<version>\bin directory.
2. Run the partition_tool.sh utility, providing values for the partition name and
archive path parameters.
Examples
For a Campaign reports archive
partition_tool.sh Partition2 "IBM\Unica\ReportsPacksCampaign\
cognos<version>\Unica Reports for Campaign.zip"
For an eMessage reports archive
partition_tool.sh Partition2 "IBM\Unica\ReportsPackseMessage\cognos10\
Unica Reports for eMessage.zip"
Note: You must use quote characters around the parameter values if they
contain spaces, as shown above for the archive paths.
3. Copy each new zip file to the Cognos deployment directory.
If you used the partition name that is provided in the example above, the new
zip file would be named as follows:
v Campaign - Unica Reports for Campaign_Partition2.zip
v eMessage - Unica Reports for eMessage_Partition2.zip
4. Open Cognos Connection.
5. Under Public Folders, create a folder for the reports partition. For example,
Campaign Partition 2.
6. Import each new zip archive, selecting the folder that you created in step 5 as
the target location in the import wizard.
If you followed the example, you would target the "Campaign Partition 2"
folder.

Creating a copy of the Cognos model for Campaign
Create a copy of the IBM Cognos data model for the new Campaign reports. You
must ensure that the model references the correct data source name.
Complete the following steps if you plan to use Campaign reports in multiple
partitions:
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1. Verify that you created an IBM Cognos data source for this partition. If you
have not yet created the data source for this partition, see “Creating JDBC data
sources” on page 12.
2. Use Framework Manager to open the Campaign project (cpf file), the
CampaignModel.cpf file.
3. Use Save As to copy the CampaignModel project and give it a new name that
indicates the partition where it is used. For example, CampaignModelPartition2.
4. In the Project Viewer, expand the Data Sources node and select CampaignDS.
If the Properties pane does not appear by default, select View > Properties.
5. Click in the Name field and change the value from the default data source
(CampaignDS) to the correct data source name for this Campaign partition. For
example, CampaignDS_partition2.
6. Click in the Content Manager Datasource field and change the value of the
default data source (CampaignDS) to the same value that you specified in the
previous step.
In this example, the value is CampaignDS_partition2.
7. Save your changes.
8. Publish the package to the content store and when the publish wizard displays
the Select Location Type window, browse to and specify the folder where you
imported the reports archive in Cognos Connection in the previous task.
In the example, the folder is Campaign Partition 2.

Creating a copy of the Cognos model for eMessage
You must create a copy of the Cognos model for eMessage if you want to use
eMessage reports in multiple partitions. Create a copy of the IBM Cognos data
model for the new eMessage reports and ensure that the model references the
correct data source name.
1. Verify that you created an IBM Cognos data source for this partition. If you
have not yet created the data source for this partition, see “Creating JDBC data
sources” on page 12.
2. Use Framework Manager to open the eMessage project file, eMessageModel.cpf.
3. Use Save As to copy the eMessageModel project and give it a new name that
indicates the partition where it is used. For example, eMessageModelPartition2.
4. In the Project Viewer, expand the Data Sources node and select
eMessageTrackDS.
If the Properties pane does not appear by default, select View > Properties.
5. Click in the Name field and change the value of the default data source
(eMessageTrackDS) to the new data source name for this eMessage partition.
6. Click in the Content Manager Datasource field and change the value of the
default data source (eMessageTrackDS) to the same value that you specified in
the previous step.
In this example, the value is eMessageTrackDS_partition2.
7. Save your changes.
8. Publish the package to the content store and when the publish wizard displays
the Select Location Type window, browse to and specify the folder where you
imported the reports archive in Cognos Connection in the previous task.
In the example, the folder is Campaign Partition 2.
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Updating the partition's report properties on the IBM EMM
Configuration page
Each partition has a set of reports properties that specifies the location of the
report folders. You must edit the values of each of the reports properties to reflect
the actual path of the folders by inserting the string that identifies the new
top-level partition folder.
Campaign example
If the new partition folder in Cognos Connection is named "Campaign Partition 2",
you would edit the report property settings as shown in the following example.
folder[@name='Campaign Partition 2']/
For example, to update the offerAnalysisTabCachedFolder property, you would
change the value from
/content/folder[@name='Affinium Campaign - Object Specific
Reports']/folder[@name='offer']/folder[@name='cached']
to
/content/folder[@name='Campaign Partition 2']/folder[@name='Affinium
Campaign - Object Specific Reports']/folder[@name='offer']/
folder[@name='cached']
eMessage example
If the new partition folder in Cognos Connection is named "Campaign Partition 2",
you would edit the report property settings as shown in the following example.
folder[@name='Campaign Partition 2']/
For example, to update the campaignAnalysisTabEmessageOnDemandFolder property,
you would change the value from
/content/folder[@name='Affinium Campaign']/folder[@name='eMessageReports']
to
/content/folder[@name='Campaign Partition 2']/folder[@name='Affinium
Campaign']/folder[@name='eMessage Reports']

Updating the partition's report properties
You must edit the values of each of the reports properties of the partition to reflect
the actual path of the folders by inserting the string that identifies the top-level
partition folder.
1. Log in to IBM EMM as the platform_admin user.
2. Select Settings > Configuration .
3. Expand Campaign > partitions > partitionName > reports.
4. Edit the value of each of the properties so that they reflect the actual path to
the reporting folders.
5. Save your changes.

86

Reports: Installation and Configuration Guide

6. Repeat steps 3 through 5 for each partition.
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Chapter 9. Upgrading reports
You can upgrade your current version of IBM EMM reports to bring it up-to-date
with the latest features.
In IBM EMM, reporting is one of the components that is provided by the
Marketing Platform.
When you upgrade, the installer and database scripts also upgrade the reporting
feature, retaining the configuration settings for the Campaign and Interact
reporting schemas.

Upgrade scenarios
Source version

Upgrade path

Pre-7.5.1

If you are upgrading an IBM EMM application from a pre-7.5.1
version, there is no upgrade path for reporting. Instead, see
“Installation roadmap” on page 1.

7.5.1

If you are upgrading an IBM EMM application from the 7.5.1 version,
complete the steps that are described in the following topics:
v “Upgrade prerequisites”
v Chapter 10, “Upgrading reports from version 7.5.1,” on page 95
Note: Because there is no upgrade path for eMessage from version
7.5.x to versions 8.x and later, there is also no upgrade path for the
eMessage reports.

8.x and 9.x

If you are upgrading an IBM EMM application from an 8.x or a 9.x
version, complete the steps that are described in the following topics:
v “Upgrade prerequisites”
v Chapter 11, “Upgrading the 8.x or 9.x model and installing new
reports,” on page 107
For eMessage, the following upgrade paths are supported:
v From version 8.6.0.4 or later fix packs to version 9.1
v From version 9.0 or later fix packs to version 9.1
Note: If you have already customized your eMessage reports, you
have less report customization work if you upgrade to 9.0 rather than
8.6.0.4 or later fix packs.
If you are using eMessage with Oracle or IBM DB2, you must use
materialized views.

Upgrade prerequisites
Before you upgrade your version of IBM EMM reports, you must complete specific
tasks.
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User with ReportsSystem role
If you are upgrading from version 7.x you must configure an IBM EMM user with
appropriate permissions to work with reporting. If you are upgrading from 8.x,
this user probably exists already.
If you do need to configure this reporting user, see “Configuring a user with the
ReportsSystem role” on page 11 for instructions.

Upgrade requirements for IBM Cognos BI
You must upgrade your version of IBM Cognos BI to the version that is supported
for the report packs you are installing. See the Environment Support Matrix for more
information about the supported IBM Cognos BI version.
For help with this task, see the IBM Cognos BI documentation.
After you upgrade Cognos, complete the Cognos configuration tasks that are
described in the installation chapter of this guide.

Back up requirements for Cognos model and report archive
On the IBM Cognos BI system, complete the following tasks:
v Back up the model subdirectory. That is, locate the application model that is
installed by the IBM EMM reports package installers, and copy the entire model
subdirectory to create a backup.
v Use the export deployment specification feature in Cognos Connection to create
a backup of the application's reports archive. Export the entire content store.
v Delete the old models and folders from the Cognos user interface. Do not delete
them from the file directory structure or from Cognos Framework Manager..

Additional requirements
You must also complete the following tasks before you upgrade your version of
IBM EMM reports:
1. Generate the SQL to drop tables and run the SQL in product databases
2. Upgrade reporting schemas on Marketing Platform.
3. Upgrade reporting templates in Marketing Platform.
4.
5.
6.
7.
8.

For eMessage and Interact, update lookup tables.
For eMessage, create database objects by using the acer_*.sql scripts.
For eMessage, create and run stored procedures.
Upgrade the views or tables in the product databases.
Upgrade the IBM EMM integration components.

The tasks are explained in detail in their own sections.

Additional requirements for eMessage reports
See “Prerequisites for eMessage Reports” on page 8 understand additional
requirements for eMessage reports.
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Generating SQL to drop views, materialized views, or tables and run
SQL in product databases
You can use the Report SQL Generator to generate drop table SQL commands and
run them against the appropriate product system table database. Complete the task
before you upgrade the reporting schemas.
This procedure only applies to Campaign, eMessage, and Interact.
The following table shows if the object types are supported in Campaign,
eMessage, and Interact for Oracle, DB2, and SQL server.
Table 13. Supported object types

Oracle

DB2

SQL Server

Campaign

eMessage

Interact

Views

Materialized Views

Views

Materialized Views

Materialized Views

Table

Table

Views

Materialized Views

Views

Materialized Views

Materialized Views

Table

Table

Views
Table

Views

Views
Table

Complete the following tasks to generate and run the SQL:
1. Log in to IBM EMM as the platform_admin user (or another user with access
to the Report SQL Generator menu item).
2. Only if you did not use the default JNDI names for the JDBC data sources
you created in an earlier step, do the following.
a. Select Settings | Configuration | Reports | Schemas | ProductName.
b. Change the default values of the JNDI property to match the JNDI names
you gave the JDBC connections in an earlier step.
3. Select Settings | Reports SQL Generator.
4. In the Product field, select the appropriate IBM application.
5. In the Schema field, select one or more reporting schemas.
6. Select the Database Type.
7. In the Generate Type field, select the appropriate option (views, materialized
views, or tables).
Materialized views are not an option when Database Type is set to Microsoft
SQL Server.
If the JNDI data source names are incorrect or not configured, the SQL
Generator cannot validate the SQL scripts that create tables.
8. Ensure that Generate Drop Statement is set to Yes.
9. Optional: To examine the SQL that is generated, click Generate. The SQL
Generator creates the script and displays it in the browser window.
10. Click Download.
The SQL Generator creates the script and prompts you to specify where you
want to save the file. If you selected a single reporting schema from the
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Schema field, the script name matches the name of schema
(eMessage_Mailing_Performance.sql, for example). If you selected more than
one reporting schema, the script name uses the product name only
(Campaign.sql, for example). For a complete list of names, see “SQL scripts by
data source” on page 24.
11. Specify the location where you want to save the script. If you change the
name of the file, be sure to use something that clearly indicates which
schemas you selected. Then, click Save.
12. Repeat steps 5 through 12 for each drop table script you need to generate.
Note: The Interact reporting schemas reference more than one data source.
Generate a separate SQL script for each data source.
There may be times when you want to disable script validation. For example,
perhaps the Marketing Platform cannot connect to the IBM application
database but you want to generate the scripts anyway. To disable validation,
clear the data source names from the data source fields (see step 3, above).
When you generate the scripts, the SQL Generator displays a warning that it
cannot connect to the data source, but it still generates the SQL script.
13. Run the drop table SQL in your product system table database. Repeat for
each product for which you are upgrading reports.

Upgrading reporting schemas on Marketing Platform
You must run the IBM EMM master installer with the reports packs installers to
upgrade the reporting schemas and reports integration configuration properties.
Run the IBM EMM master installer with the appropriate report package installer
on the computer where Marketing Platform is installed, and select the IBM EMM
Product Reporting Schemas installation option.
After you upgrade reporting schemas, you can verify the upgrade by completing
the following tasks:
1. Log in to the IBM EMM system as the platform_admin user.
2. Select Settings > Configuration.
3. Expand Reports > Schemas > ProductName .
If the schema configuration categories for your application were not upgraded,
you have not yet upgraded reports on the Marketing Platform.
Note: If you are upgrading Marketing Operations, skip this step (Marketing
Operations does not have reporting schemas).
4. Expand Reports > Integrations.
If the schema configuration categories were upgraded, and if your current
reports installation is pre 8.6.0, you see a new category for Cognos 10
configuration. Your Cognos 8 category is disabled, but it is retained for
reference purposes, to assist you in setting the configuration properties for
Cognos 10. After you have fully configured and tested your reporting upgrade,
you must use the Delete Category link to remove the Cognos 8 configuration
category.
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Upgrading reporting templates in the Marketing Platform
You must upgrade reporting templates in Marketing Platform before you upgrade
reports. If you are upgrading reports for Marketing Operations, do not upgrade
reporting templates because Marketing Operations does not have reporting
schemas.
After you run the report pack installer, complete the following tasks:
1. Browse to the Unica\productReportsPack\schema directory, locate the
templates_sql_load.sql script and run the script in the Marketing Platform
system tables database.
2. Ensure that the Marketing Platform is running.
3. Log in to IBM EMM as a user with administrator privileges.
4. Under Settings > Users, give yourself the ReportsSystem role. Then, log out
and log back in.
5.

Campaign only.
The database schema for adding new campaign attributes was changed in
Campaign 8.0.0. Therefore, if the reporting schema customization included
additional campaign attributes, complete the following steps:
a. Use your database management tools to determine the value from each
attribute's AttributeID column in the UA_CampAttribute table.
b. In IBM EMM, select Settings > Configuration and expand Reports >
Schemas > Campaign > Campaign Custom Attributes > Columns >
Campaign.
c. Delete the existing custom campaign attributes that were added for this
installation, but do not delete the standard custom campaign attributes. (The
standard custom campaign attributes were upgraded by the installer.)
d. Re-create the attributes that you deleted. Enter the ID of the attribute in the
Attribute ID field.

Upgrading IBM EMM integration components
You must run the installers on the computer where the Cognos Content Manager is
installed to upgrade IBM EMM integration components.
Complete the following steps to upgrade IBM EMM integration components:
1. On the IBM Cognos BI system that runs the Cognos Content Manager,
download or copy the following IBM EMM installers to a single directory:
v IBM EMM master installer
v Marketing Platform installer
v IBM EMM application report package installers
2. Run the IBM EMM master installer. (It launches the sub-installers for Marketing
Platform and the report packages in order.)
3. In the first Products window, ensure that both Marketing Platform and the
report package options are selected.
4. In the Platform Database Connection window, provide the necessary
information for connecting to the Marketing Platform system tables.
5. When the Platform Installation Components window appears, select the
Reports for IBM Cognos option and clear the other options
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6. When the Marketing Platform installer prompts for the path to the JDBC driver,
enter the fully qualified path for the JDBC driver you copied to the Cognos
system during the initial install of reporting.
For more information, see “Obtain the JDBC driver for the Marketing Platform
system tables” on page 17.
7. When the Marketing Platform installer prompts for the location of the IBM
Cognos installation, enter or browse to the top level of the IBM Cognos
installation directory.
The default value that is provided in this field is a static value that is not based
on the actual file structure of your IBM Cognos system.
8. When the report package installer takes over and displays its installation
options, select the IBM Cognos package for IBM EMM [product] option and
clear the option for the reporting schemas. This installation option copies the
reports archive to the Cognos computer. You import this archive manually later.
9. When the installers are finished, copy the JDBC driver for the Marketing
Platform database to the IBM Cognos webapps\p2pd\WEB-INF\AAA\lib directory.
Make sure that you copy the driver. Do not cut and paste the driver.

Updating lookup tables for eMessage and Interact
If you are using reports for eMessage and Interact, you must update the lookup
tables. You must use your database client to run specific upgrade scripts against
the system table database.
Complete one of the following steps:
v Complete the following steps if you are upgrading from version 8.6.0.4 or 9.0 for
eMessage:
1. In the ReportsPackCampaign\tools directory under your reports pack
installation, locate the uare_lookup_create_DB_type.sql script, where
DB_type is the database type appropriate for your installation of Campaign.
v Complete the following steps for Interact
1. In the ReportsPackInteract\tools directory under your reports pack
installation, locate the uari_lookup_create_DB_type.sql script, where
DB_type is the database type appropriate for your installation of Campaign.
2. Run the appropriate version of the script against your Interact design time
database.

Upgrading views or tables in the product databases
To successfully upgrade your version of Reports, you must generate an updated
SQL, and upgrade views or tables in your product databases.
Note: For eMessage, skip this section.
Complete the following tasks to upgrade views or tables in the product databases:
1. Generate updated SQL, as described in “Generating view or table creation
scripts” on page 23.
2. Run the SQL scripts that you generated earlier against the product system table
databases.
3. For Campaign and Interact, create reporting views or tables by using the new
SQL and the SQL scripts that are provided with your reports packs.
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Chapter 10. Upgrading reports from version 7.5.1
Before upgrading reports from version 7.5.1, make sure that you complete all the
upgrade prerequisites. IBM EMM reporting is no longer provided in a separate
web application such as in Affinium Reports 7.5.x.
Important: You cannot upgrade eMessage reports version 7.5.1 to 9.1. For
eMessage, you must first install reports version 8.6.0.4, and then upgrade to
version 9.1.
When you install the IBM Cognos reports archive from the reports package, you
run an upgrade script that preserves your customizations to the Cognos data
mode. However, you must replace the 7.5.1 reports with the new reports. Most of
the older reports are compatible with the upgraded Cognos models, the new
reports packages include new and enhanced reports, and most of the packages also
contain Dashboard reports. The only way to obtain the new or enhanced reports is
to install the new reports archive, which overwrites the existing reports.
Therefore, you have the following options for upgrading your reports:
v Back up the old reports, install the new reports, and then re-create your
customizations by using the old reports for reference.
v Back up the old reports and install the new reports. Compare the new reports to
your old reports and examine your customizations. If you are certain that a
customized report functions properly with the new data model, copy the old
customized report back into the reports folder.
Note: The 7.5.1 version of the Campaign Performance by Cell reports and the
Offer Performance Summary by Campaign reports do not function at all without
manual intervention. Additionally, the new versions of many of the old reports
include enhancements and minor bug fixes. To obtain the changes, you must use
the new versions of the reports.
You must complete the following steps to upgrade reports from version 7.5.1:
1. Upgrade the 7.5.1 model and install the new reports.
2. Updating the old Campaign Performance by Cell reports.
3. Updating the old Campaign Performance by Cell reports.
Each step is explained in a separate section.

Upgrading 7.5.1 model and installing new reports
Upgrading the 7.5.1 model and installing the new reports are the first steps that
you must complete to upgrade your 7.5.1 reports.
The new report packages include new and changed reports as well as dashboard
reports for most of the IBM EMM applications. Although you can upgrade the
model, you cannot upgrade the 7.5.1 reports. You must install the new reports and
then re-create the reporting customizations that you made to 7.5.1, or copy the old
reports into the folder.
Complete the following steps to upgrade the 7.5.1 model and install new reports:
1. Verify that you backed up the model and the old reports.
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2. Browse to the ProductNameReportsPack\CognosN directory under your IBM
EMM product installation.
The N in the path refers to the Cognos version number.
3. Copy the reports archive .zip file, such as Unica Reports for Campaign.zip, to
the directory where your Cognos deployment archives are saved.
The default location is the deployment directory under your IBM EMM
Cognos installation and it is specified in the Cognos Configuration tool that is
installed with the Cognos Content Manager, for example: cognosN\deployment.
The N in the path refers to the Cognos version number.
In a distributed IBM Cognos environment, the directory is located on the
system that runs the Content Manager.
4. If the Reports Pack installation directory and Framework Manager are on
different computers, locate the cognosN\model directory under the Reports
Pack installation directory. Then, copy it to the directory on the computer
where your Framework Manager is installed.
The N in the path refers to the Cognos version number.
5. Only if you did not install your IBM EMM product to the default directory
(C:\Unica on Windows) you must update some upgrade scripts as described
in this step.
You must update the scripts that are listed here. The scripts that you must
update differ, depending on the reports package.
The scripts are all in the ProductNameReportsPack\cognosN\ProductNameModel
directory under your IBM EMM product installation.
The N in the path refers to the Cognos version number.
Campaign
v upgrade80to81.xml
v
v
v
v

upgrade81to85.xml
upgrade85to86.xml
upgrade86to90.xml
upgrade90to91.xml

v upgrade91to911.xml
v upgrade911to9112.xml
Interact
v upgrade80to81.xml
v upgrade81to85.xml
v upgrade85to86.xml
v upgrade86to90.xml
v upgrade90to91.xml
v upgrade91to911.xml
v upgrade911to9112.xml
Leads
v upgrade81to85.xml
v upgrade86to90.xml
v upgrade90to91.xml
v upgrade91to911.xml
Campaign with Marketing Operations
v upgrade80to81.xml
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v upgrade82to85.xml
v upgrade86to90.xml
v upgrade90to91.xml
v upgrade91to911.xml
v upgrade911to9112.xml
Marketing Operations
v upgrade75to80.xml
v upgrade80to81.xml
v upgrade81to82.xml
v upgrade82to85.xml
v upgrade85to86.xml
v upgrade86to90_DB2.xml (for DB2 database only)
v
v
v
v

upgrade86to90_Oracle.xml (for Oracle database only)
upgrade86to90_Sqlserver.xml (for SQLServer database only)
upgrade90to91.xml
upgrade91to911.xml

v upgrade911to9112.xml
Distributed Marketing
v upgrade86to90.xml
v upgrade911to9112.xml
In each script, edit the file paths that point to directories where the localized
language versions of the models are stored to reflect your product installation
location. Modify the file path in each script for every language that your users
need, for example:
install_directory \ReportsPackCampaign\cognosN\CampaignModel\
translations\L\translations.txt
The N in the path refers to the Cognos version number.
The L in the path refers to one of the following language indicators.
v fr
v de
v
v
v
v

es
it
ja
ko

v pt
v ru
v zh
v zh-tw
6. Open Cognos Connection.
7. Select Administer Cognos Content > Configuration > Content
Administration.
8. Click the New Import button on the toolbar
and import the reports
folder.
9. Open Cognos Framework Manager and select the project that corresponds to
your old reports.
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10. Select Project > Run Script.
11. Run the following scripts from your new version against your old reports.
You must run the scripts that are listed here. The scripts that you must run
differ, depending on the reports package.
The scripts are all in the ProductNameReportsPack\cognosN\ProductNameModel
directory under your IBM EMM product installation.
The N in the path refers to the Cognos version number.
Campaign
v preUpgrade_86_fromanyversion.xml
v upgrade75to751.xml
v upgrade751to80.xml
v
v
v
v

upgrade80to81.xml
upgrade81to85.xml
upgrade85to86.xml
upgrade86to90.xml

v upgrade90to91.xml
v upgrade91to911.xml
v upgrade911to9112.xml
Interact
v preUpgrade_86_fromanyversion.xml
v upgrade75to751.xml
v upgrade751to80.xml
v upgrade80to81.xml
v upgrade81to85.xml
v
v
v
v

upgrade85to86.xml
upgrade86to90.xml
upgrade90to91.xml
upgrade91to911.xml

v upgrade911to9112.xml
Leads
v upgrade75to80.xml
v upgrade81to85.xml
v upgrade86to90.xml
v upgrade90to91.xml
v upgrade91to911.xml
Campaign with Marketing Operations
v
v
v
v
v
v
v

upgrade80to81.xml
upgrade81to82.xml
upgrade82to85.xml
upgrade86to90.xml
upgrade90to91.xml
upgrade91to911.xml
upgrade911to9112.xml

Marketing Operations
v upgrade75to80.xml
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v upgrade80to81.xml
v upgrade81to82.xml
v upgrade82to85.xml
v upgrade85to86.xml
v upgrade86to90_DB2.xml (for DB2 database only)
v upgrade86to90_Oracle.xml (for Oracle database only)
v upgrade86to90_Sqlserver.xml (for SQLServer database only)
v upgrade90to91.xml
v upgrade91to911.xml
v upgrade911to9112.xml
Distributed Marketing
v upgrade86to90.xml
v upgrade911to9112.xml
12. Publish the package to the Cognos content store.
13. Run a report to ensure that it works properly.
14. If the 7.5.1 reports were customized, re-create those customizations.
Alternately, if you can ensure that an old report works properly with the
upgraded model, copy the old report back.
For information about fixing the old Campaign Performance by Cell reports
and the old Offer Performance Summary by Campaign reports so they work
with the new data model, continue with the remaining tasks in this section.
15. If you have reports installed for multiple partitions, configure reports
packages for the additional partitions by using the instructions in the chapter
that describes how to configure multiple partitions.
16. Optional: See “Configure IBM Cognos to use IBM EMM authentication” on
page 49 for information about the new authentication mode, "authenticate per
user."

Updating the old Campaign Performance by Cell reports
After you upgrade the Campaign model from 7.5.1 to 8.x, the old Campaign
Performance by Cell reports do not function properly. If you want to use your old
Campaign Performance by Cell reports, you must manually update them.
You must manually upgrade and fix the following reports:
v Offer Performance Summary by Campaign cross-object report
v Single object Offer Performance Summary by Campaign report

Fixing the cross-object Performance by Cell reports
To manually upgrade your reports version 7.5.1, you must manually upgrade and
fix the cross-object Performance by Cell reports, so the reports can function with
the new data model.
You must fix the following reports:
v Campaign Performance Summary by Cell
v Campaign Performance Summary by Cell (with Revenue)
v Campaign Performance Summary by Cell by Initiative
Complete the following steps to fix the reports:
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1. Open the report in IBM Cognos Report Studio.
2. Click the lock icon on the toolbar to unlock the report.
3. Browse to the Query Explorer and open the Report Query for a list of all the
query items in the report.
4. For all three reports, remap the query items according to the information in
the following table:
Table 14. Mapping for query items
Query item

Mapping

Number of Offers Given

[Campaign Performance Summary].[Campaign Cell CH with
Controls Summary].[Number of Offers Given]

Response Transactions

[Campaign Performance Summary].[Campaign Cell RH with
Controls Summary].[Response Transactions]

Unique Recipients

[Campaign Performance Summary].[Campaign Cell CH with
Controls Summary].[Unique Recipients]

Unique Responders

[Campaign Performance Summary].[Campaign Cell RH with
Controls Summary].[Unique Responders]

Unique Recipients Control [Campaign Performance Summary].[Campaign Cell CH with
Group
Controls Summary].[Unique Recipients Control Group]
Unique Responders
Control Group

[Campaign Performance Summary].[Campaign Cell RH with
Controls Summary].[Unique Responders Control Group]

5. For the report with revenue, remap for the Gross Revenue item as follows:
[Campaign Performance Summary].[Campaign Cell RH with Controls
Summary].[Gross Revenue]
6. Update the formula for the Responder Rate Control Group to be the
following:
IF(([Unique Responders Control Group]/([Unique Recipients Control Group]
* 1.00)) is missing)
THEN (0)
ELSE(([Unique Responders Control Group]/([Unique Recipients Control Group]
* 1.00)))

7. From the Detail Filter list, select the first detail filter and edit it so it looks
like this:
[Campaign Performance Summary] . [Campaign] . [Campaign ID] in
(?CampaignIds?)
8. From the Detail Filter list, delete the second detail filter - the one that looks
like this:
[Campaign Performance Summary].[Responder Rate Control Group at Cell
Level].[Campaign ID] in (?CampaignIds?)
9. Lock the report.
10. Complete the following steps in Report Studio for each report:
a. Go to File > Report Package.
b. Select Unica Campaign Package and click OK.
c. Complete prompts on the report as necessary.
d. After the report is validated, click Close in the Validation Response
window.
11. Save and run the report.
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Fixing the object-specific Performance by Cell reports
To manually upgrade your reports version 7.5.1, you must manually upgrade and
fix the object-specific Performance by Cell report, so that the report can function
with the new data model.
You must fix the following reports:
v Campaign Performance Summary by Cell
v Campaign Performance Summary by Cell (with Revenue)
Complete the following steps to fix the report:
1. Open the report in IBM Cognos Report Studio.
2. Click the lock icon on the toolbar to unlock the report.
3. Browse to the Query Explorer and open the Report Query for a list of all the
query items in the report.
4. For both reports, remap the query items according to the information in the
following table:
Table 15. Mapping for query items
Query item

Mapping

Number of Offers Given

[Campaign Performance Summary].[Campaign Cell CH with
Controls Summary].[Number of Offers Given]

Response Transactions

[Campaign Performance Summary].[Campaign Cell RH with
Controls Summary].[Response Transactions]

Unique Recipients

[Campaign Performance Summary].[Campaign Cell CH with
Controls Summary].[Unique Recipients]

Unique Responders

[Campaign Performance Summary].[Campaign Cell RH with
Controls Summary].[Unique Responders]

Unique Recipients Control [Campaign Performance Summary].[Campaign Cell CH with
Group
Controls Summary].[Unique Recipients Control Group]
Unique Responders
Control Group

[Campaign Performance Summary].[Campaign Cell RH with
Controls Summary].[Unique Responders Control Group]

5. For the report with revenue, remap the Gross Revenue query item as follows:
[Campaign Performance Summary].[Campaign Cell RH with Controls
Summary].[Gross Revenue]
6. Update the formula for the Responder Rate Control Group to be the
following:
IF(([Unique Responders Control Group]/([Unique Recipients Control Group]
* 1.00)) is missing)
THEN (0)
ELSE(([Unique Responders Control Group]/([Unique Recipients Control Group]
* 1.00)))

7. From the Detail Filter list, select the first detail filter and edit it so it looks
like this:
[Campaign Performance Summary].[Campaign].[Campaign ID] in
(?CampaignIds?)
8. Delete the second detail filter - the one that looks like this:
[Campaign Performance Summary].[Responder Rate Control Group at Cell
Level].[Campaign ID] in (?CampaignIds?)
9. Lock the report.
10. Complete the following steps in Report Studio for each report.
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Go to File > Report Package.
Select Unica Campaign Package and click OK.
Complete prompts on the report as necessary.
After the report is validated, click Close in the Validation Response
window.
11. Save and run the report.
a.
b.
c.
d.

Updating the old Offer Performance Summary by Campaign reports
After you upgrade the Campaign model from 7.5.1 to 8.x, the old Offer
Performance Summary by Campaign reports do not function properly. If you want
to use your old Offer Performance Summary by Campaign reports, you must
manually update them.
You must upgrade and fix the following reports:
v Offer Performance Summary by Campaign cross-object report
v Single object Offer Performance Summary by Campaign report

Fixing the Offer Performance Summary by Campaign
cross-object report
To manually upgrade your reports version 7.5.1, you must manually upgrade and
fix the Offer Performance Summary by Campaign cross-object report, so the report
can function with the new data model.
Complete the following tasks to fix the report:
1. Open the report in IBM Cognos Report Studio.
2. Browse to the Query Explorer and open the Report Query for a list of all the
query items in the report.
3. Configure the aggregation as follows for the following Campaign Level
Counts query items.
Table 16. Aggregate functions for Campaign Level Counts query items.
Query item

Aggregate
Function

Rollup Aggregate
Function

Number of Offers Given

None

Automatic

Response Transactions

None

Automatic

Unique Recipients

None

Automatic

Unique Responders

None

Automatic

Not Contacted Responders

None

Automatic

Responses after Expiration

None

Automatic

Unique Recipients Control Group

None

Automatic

Unique Responders Control Group

None

Automatic

4. Configure the aggregation as follows for the following Campaign Level
Counts query items.
Table 17. Aggregate functions for Campaign Level Counts query items.
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Query item

Aggregate
Function

Rollup Aggregate
Function

Response Rate

Automatic

Automatic
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Table 17. Aggregate functions for Campaign Level Counts query items (continued).
Query item

Aggregate
Function

Rollup Aggregate
Function

Responder Rate

Automatic

Automatic

Responder Rate Control Group

Automatic

Automatic

Best Offer Lift Over This

Automatic

Automatic

Lift Over Worst Offer

Automatic

Automatic

Lift Over Control Group

Automatic

Automatic

5. Configure the aggregation as follows for the following Offer Level Counts
query items.
Table 18. Aggregate functions for Offer Level Counts query items.
Query item

Aggregate
Function

Rollup Aggregate
Function

Number of Offers Given-Offer

None

Automatic

Unique Responders-Offer

None

Automatic

Not Contacted Responders-Offer

None

Automatic

Responses after Expiration-Offer

None

Automatic

Unique Responders Control Group-Offer

None

Automatic

6. Change the expression for the Response Transactions-Offer query item to be
the following.
[Offer Performance Summary].[Offer Response History Summary].
[Response Transactions] / count([Campaign Name] for [Offer ID])

7. Configure the aggregation as follows for the following Offer Level Counts
query items.
Table 19. Aggregate functions for Offer Level Counts query items.
Query item

Aggregate
Function

Rollup Aggregate
Function

Response Transactions - Offer

Total

Automatic

Unique Recipients - Offer

Total

Automatic

Unique Recipients Control Group - Offer

Total

Automatic

8. Configure the aggregation as follows for the following Offer Level Counts
query items.
Table 20. Aggregate functions for Offer Level Counts query items.
Query item

Aggregate
Function

Rollup Aggregate
Function

Response Rate - Offer

Automatic

Automatic

Responder Rate - Offer

Automatic

Automatic

Responder Rate Control Group - Offer

Automatic

Automatic

Lift Over Control Group - Offer

Automatic

Automatic

9. For the Report Total level counts, change the expression for Total Response
Transactions to be the following.
total ([Response Transactions-Offer])
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10. Also, for Total Response Transactions, confirm that Aggregate Function is set
to Automatic and that Rollup Aggregate Function is set to Automatic.
11. Lock the report.
12. Complete the following steps in Report Studio for each report:
a. Go to File > Report Package.
b. Select Unica Campaign Package and click OK.
c. Complete prompts on the report as necessary.
d. After the report is validated, click Close in the Validation Response
window.
13. Save and run the report.

Fixing the single object Offer Performance Summary by
Campaign report
To manually upgrade your reports version 7.5.1, you must manually upgrade and
fix the single object Offer Performance Summary by Campaign report, so the report
can function with the new data model.
Complete the following steps to fix the report:
1. Open the report in IBM Cognos Report Studio.
2. Browse to the Query Explorer and open the Report Query for a list of all the
query items in the report.
3. Configure the aggregation as given in the following table for the Campaign
Level Counts query items:
Table 21. Aggregate functions for Campaign Level Counts query items.
Query item

Aggregate
Function

Rollup Aggregate
Function

Number of Offers Given

None

Automatic

Response Transactions

None

Automatic

Unique Recipients

None

Automatic

Unique Responders

None

Automatic

Not Contacted Responders

None

Automatic

Responses after Expiration

None

Automatic

Unique Recipients Control Group

None

Automatic

Unique Responders Control Group

None

Automatic

4. Configure the aggregation as given in the following table for Campaign Level
Counts query items.
Table 22. Aggregate functions for Campaign Level Counts query items.
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Query item

Aggregate
Function

Rollup Aggregate
Function

Response Rate

Automatic

Automatic

Responder Rate

Automatic

Automatic

Responder Rate Control Group

Automatic

Automatic

Best Offer Lift Over This

Automatic

Automatic

Lift Over Worst Offer

Automatic

Automatic

Lift Over Control Group

Automatic

Automatic
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5. Configure the aggregation as given in the following table for Offer Level
Counts query items.
Table 23. Aggregate functions for Offer Level Counts query items.
Query item

Aggregate
Function

Rollup Aggregate
Function

Number of Offers Given-Offer

None

Automatic

Unique Responders-Offer

None

Automatic

Not Contacted Responders-Offer

None

Automatic

Responses after Expiration-Offer

None

Automatic

Unique Responders Control Group-Offer

None

Automatic

6. Change the expression for the Response Transactions-Offer query item to be
the following.
[Offer Performance Summary].[Offer Response History Summary].
[Response Transactions] / count([Campaign Name] for [Offer ID])

7. Configure the aggregation as given in the following table for Offer Level
Counts query items.
Table 24. Aggregate functions for Offer Level Counts query items.
Query item

Aggregate
Function

Rollup Aggregate
Function

Response Transactions - Offer

Total

Automatic

Unique Recipients - Offer

Total

Automatic

Unique Recipients Control Group - Offer

Total

Automatic

8. Configure the aggregation as given in the following table for Offer Level
Counts query items.
Table 25. Aggregate functions for Offer Level Counts query items.
Query item

Aggregate
Function

Rollup Aggregate
Function

Response Rate - Offer

Automatic

Automatic

Responder Rate - Offer

Automatic

Automatic

Responder Rate Control Group - Offer

Automatic

Automatic

Lift Over Control Group - Offer

Automatic

Automatic

9. Lock the report.
10. Complete the following tasks in Report Studio for each report.
a. Go to File > Report Package.
b. Select Unica Campaign Package and click OK.
c. Complete prompts on the report as necessary.
d. After the report is validated, click Close in the Validation Response
window.
11. Save and run the report.
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Chapter 11. Upgrading the 8.x or 9.x model and installing new
reports
Upgrading the 8.x or 9.x model and installing the new reports are the first steps
that you must complete to upgrade your reports.
Complete the following steps to upgrade the 8.x or 9.x model and install new
reports:
1. Browse to the Unica\ProductNameReportsPack\CognosN directory, where N is
the version of your Cognos installation.
2. Copy the reports archive .zip file, such as Unica Reports for Campaign.zip, to
the directory where your Cognos deployment archives are saved.
The default location is the deployment directory under your IBM Cognos
installation. The directory is specified in the Cognos Configuration tool that is
installed with the Cognos Content Manager, for example: cognos\deployment.
In a distributed IBM Cognos environment, the directory is a located on the
system that runs the Content Manager.
3. Copy the pre-upgrade version of the Campaign model to a directory on the
server where your Framework Manager is installed. If the Reports Pack
installation directory and Framework Manager are on different servers, locate
the upgraded cognos10\model directory under the Reports Pack installation
directory. Then, copy the appropriate upgrade.xml files to the directory on the
server where Framework Manager is installed. Also, copy the translation
folder of upgraded model in the old model that is copied to the directory on
the server where Framework Manager is installed. If prompted for
replacement, click Yes.
4. If the Reports Pack installation directory and Framework Manager are on
different servers, locate the cognos10\model directory under the Reports Pack
installation directory. Then, copy the appropriate upgrade.xml files to the
server where your Framework Manager is installed.
5. Copy the translation folder of the upgraded Campaign model in the old
model that you copied to a directory on a server where your Framework
Manager is installed. If you see a prompt for replacement, click Yes.
6. If you did not install your IBM EMM product to the default C:\Unica
directory on Windows, you must update the upgrade scripts.
In each script, edit the file paths that point to directories where the localized
language versions of the models are stored to reflect your product installation
location. Modify the file path in each script for every language that your users
need, for example:
install_directory\ReportsPackCampaign\cognosN\CampaignModel\
translations\L\translations.txt
The N in the path refers to the Cognos version number.
The L in the path refers to one of the following language indicators:
v
v
v
v
v
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v ko
v pt
v ru
v zh
v zh-tw
Edit the following upgrade scripts:
Campaign
v upgrade80to81.xml
v upgrade81to85.xml
v upgrade85to86.xml
v upgrade86to90.xml
v upgrade90to91.xml
v upgrade91to911.xml
v upgrade911to9112.xml
eMessage
v upgrade86to90.xml
v upgrade8604to91.xml
v upgrade90to91.xml
v upgrade91to911.xml
v upgrade9102to911.xml (To upgrade from version 9.1.0.x.0.0 (x >= 2) and if
you have not applied 9.1.0.2 Reports Feature Pack 1)
v upgrade910201to911.xml (To upgrade from version 9.1.0.x.0.1 (x >= 2) and if
you have applied 9.1.0.2 Reports Feature Pack 1)
Interact
v
v
v
v

upgrade80to81.xml
upgrade81to85.xml
upgrade85to86.xml
upgrade86to90.xml

v upgrade90to91.xml
v upgrade91to911.xml
v upgrade911to9112.xml
Leads
v upgrade81to85.xml
v upgrade86to90.xml
v upgrade90to91.xml
v upgrade91to911.xml
Campaign with Marketing Operations
v upgrade80to81.xml
v upgrade82to85.xml
v upgrade86to90.xml
v upgrade90to91.xml
v upgrade91to911.xml
v upgrade911to9112.xml
Marketing Operations
v upgrade75to80.xml
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v upgrade80to81.xml
v upgrade81to82.xml
v upgrade82to85.xml
v upgrade85to86.xml
v upgrade86to90_DB2.xml (for DB2 database only)
v upgrade86to90_Oracle.xml (for Oracle database only)
v upgrade86to90_Sqlserver.xml (for SQL Server database only)
v upgrade90to91.xml
v upgrade91to911.xml
v upgrade911to9112.xml
Distributed Marketing
v upgrade86to90.xml
v upgrade911to9112.xml
7. Open Cognos Connection.
8. Select Administer Cognos Content > Configuration > Content
Administration.
9. Click the New Import button on the toolbar
and import the reports
folder.
10. Open Cognos Framework Manager and open the project for the version from
which you are upgrading.
11. Select Project > Run Script.
12. Run the following scripts from the new version of your product:
Note: You must consider the following points for the 8.x or 9.x version from
which you are upgrading:
v You do not have to run the scripts that refer to earlier versions. For
example, if you are upgrading Campaign reports from version 8.5.0, you do
not need to run the upgrade80to81.xml and upgrade81to85.xml scripts.
v You must run the preUpgrade_86_fromanyversion.xml script for upgrades
from all versions except 8.6.
v You cannot upgrade reports from any source version to a destination
version. For example, to upgrade reports from version 9.0.0 to version 9.1.1,
you must first upgrade from version 9.0.0 to version 9.1, and then upgrade
from version 9.1 to version 9.1.1.
v Only for eMessage reports, you must upgrade from version 8.6.0.4 or later
to 9.1 directly.
Campaign
v preUpgrade_86_fromanyversion.xml
v upgrade80to81.xml
v upgrade81to85.xml
v upgrade85to86.xml
v upgrade86to90.xml
v upgrade90to91.xml
v upgrade91to911.xml
v upgrade911to9112.xml
eMessage
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v
v
v
v
v

upgrade86to90.xml
upgrade8604to91.xml
upgrade90to91.xml
upgrade91to911.xml
upgrade9102to911.xml (To upgrade from version 9.1.0.x.0.0 (x >= 2) and if
you did not apply Reports 9.1.0 Feature Pack 1)
v upgrade910201to911.xml (To upgrade from version 9.1.0.x.0.1 (x >= 2) and if
you did apply Reports 9.1.0 Feature Pack 1)
Interact
v preUpgrade_86_fromanyversion.xml
v upgrade80to81.xml
v
v
v
v

upgrade81to85.xml
upgrade85to86.xml
upgrade86to90.xml
upgrade90to91.xml

v upgrade91to911.xml
v upgrade911to9112.xml
Leads
v upgrade81to85.xml
v upgrade86to90.xml
v upgrade90to91.xml
v upgrade91to911.xml
Campaign with Marketing Operations
v upgrade80to81.xml
v
v
v
v

upgrade81to82.xml
upgrade82to85.xml
upgrade86to90.xml
upgrade90to91.xml

v upgrade91to911.xml
v upgrade911to9112.xml
Marketing Operations
v upgrade75to80.xml
v upgrade80to81.xml
v upgrade81to82.xml
v upgrade82to85.xml
v upgrade85to86.xml
v upgrade86to90_DB2.xml (for DB2 database only)
v upgrade86to90_Oracle.xml (for Oracle database only)
v upgrade86to90_Sqlserver.xml (for SQL Server database only)
v upgrade90to91.xml
v upgrade91to911.xml
v upgrade911to9112.xml
Distributed Marketing
v upgrade86to90.xml
v upgrade911to9112.xml
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All the scripts are in the ProductNameReportsPack\cognosN\ProductNameModel
directory under your IBM EMM product installation, where N is the Cognos
version number.
13. If you are upgrading eMessage reports, complete the following steps:
Note: If your database is DB2, change the statement termination character
from ; (semicolon) to ! (exclamation point).
a. Go to Campaign_ReportPack_Installer_Home\Cognos10\ emessage-ddl\DB
Type\Upgrade.
b. Run the following scripts in the sequence shown:
v If you are upgrading from eMessage 8.6.0.4 or later to eMessage 9.1:
acer_tables_upgrade_dbname.sql. Search for the base version name and
run the following script:
--8.6.0.4 Updates-v If you are upgrading from eMessage 9.0 or later to eMessage 9.1:
– acer_tables_upgrade_dbname.sql. Search for the base version name
and run the following script:
--9.0.x Updates-– acer_indexes_upgrade_dbname.sql. Search for the base version name
and run the following script:
--9.0.x Updates-v If you are upgrading from eMessage 9.1.0.x.0.0 (x >= 0) to eMessage
9.1.1:
acer_tables_upgrade_dbname.sql. Search for the base version name and
run the following script:
--9.1.0.x updates (Not applicable for 9.1.0 Feature Pack 1
upgrade)-Note: If you applied 9.1.0 Feature Pack 1, you do not need to run table or
index upgrade scripts.
c. Go to Campaign_ReportPack_Installer_Home\Cognos10\emessage-ddl\DB
Type and run the following script:
acer_scripts_dbname.sql
Note: You must run the acer_scripts_dbname.sql script for a both a fresh
installation and an upgrade of reports.
Note: If you are using Microsoft SQL Server, you must drop the 8.6.0.4
version's procedures before you complete this step.
d. Use Run SQL Generator to generate report view scripts. For Microsoft SQL
Server, generate views. For Oracle and IBM DB2, create materialized
views.
e. Run and schedule the stored procedures.
Note: To ensure proper report performance, you must schedule the stored
procedures to run regularly. For more information about eMessage stored
procedures, see “Running and scheduling stored procedures for eMessage”
on page 33.
14. Publish the package to the Cognos content store.
15. For all IBM EMM products, complete the following steps:
a. Go to File > Report Package.
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b. Select the appropriate reports package according to your product and click
OK.
c. Complete prompts on the report as necessary.
d. After the report is validated, click Close in the Validation Response
window.
16. Run a report to test your upgrade.
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Appendix A. Report configuration properties
The report configuration properties for IBM EMM are at Settings > Configuration
> Reports.
To generate reports, the IBM EMM suite integrates with IBM Cognos, a third-party
business intelligence application. You use the Integrations > Cognos properties to
identify your IBM Cognos system. Then, for Campaign, eMessage, and Interact,
there are additional configuration properties to set up and customize the reporting
schemas.

Reports | Integrations | Cognos [version]
The IBM EMM suite integrates with IBM Cognos to generate reports.
This page displays properties that specify URLs and other parameters that are
used by the IBM system.

Integration Name
Description
Read-only. Specifies that IBM Cognos is the third-party reporting or
analytical tool that is used by the IBM EMM to display the reports.
Default value
Cognos

Vendor
Description
Read-only. Specifies that IBM Cognos is the name of the company that
provides the application that is specified by the Integration Name property.
Default value
Cognos

Version
Description
Read-only. Specifies the product version of the application that is specified
by the Integration Name property.
Default value
<version>

Enabled
Description
Specifies whether IBM Cognos is enabled for the suite.
Default value
False
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Valid Values
True | False

Integration Class Name
Description
Read-only. Specifies the fully qualified name of the Java class that creates
the integration interface that is used to connect to the application specified
by the Integration Name property.
Default value
com.unica.report.integration.cognos.CognosIntegration

Domain
Description
Specifies the fully qualified company domain name in which your Cognos
server is running. For example, myCompanyDomain.com.
If your company uses subdomains, the value in this field must include the
appropriate subdomain as well.
Default value
[CHANGE ME]
Valid Values
A string no longer than 1024 characters.

Portal URL
Description
Specifies the URL of the IBM Cognos Connection portal. Use a fully
qualified host name, including the domain name (and subdomain, if
appropriate) that is specified in the Domain property. For example:
http://MyReportServer.MyCompanyDomain.com/cognos<version>/cgi-bin/
cognos.cgi
You can find the URL in IBM Cognos Configuration at: Local
Configuration > Environment .
Default value
http://[CHANGE ME]/cognos<version>/cgi-bin/cognos.cgi
Valid Values
A well-formed URL.

Dispatch URL
Description
Specifies the URL of the IBM Cognos Content Manager. Use a fully
qualified host name, including the domain name (and subdomain, if
appropriate) specified in the Domain property. For example:
http://MyReportServer.MyCompanyDomain.com:9300/p2pd/servlet/dispatch
You can find the URL in Cognos Configuration at: Local Configuration >
Environment .
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Default value
http://[CHANGE ME]:9300/p2pd/servlet/dispatch
9300 is the default port number for the Cognos Content Manager. Be sure
that the port number specified matches that used in the Cognos
installation.
Valid Values
A well-formed URL.

Authentication mode
Description
Specifies whether the IBM Cognos application is using the IBM
Authentication Provider, which means it relies on the Marketing Platform
for authentication.
Default value
anonymous
Valid Values
v anonymous: means that authentication is disabled.
v authenticated: means that the communications between the IBM system
and the Cognos system are secured at the machine level. You configure a
single system user and configure it with the appropriate access rights.
By convention, this user is named "cognos_admin."
v authenticatedPerUser: means that the system evaluates individual user
credentials.

Authentication namespace
Description
Read only. The namespace of the IBM Authentication Provider.
Default value
Unica

Authentication user name
Description
Specifies the login name for the reporting system user. The IBM
applications log in to Cognos as this user when Cognos is configured to
use the Unica Authentication provider This user also has access to IBM
EMM.
This setting applies only when the Authentication mode property is set to
authenticated .
Default value
cognos_admin

Authentication datasource name
Description
Specifies the name of the data source for the reporting system user that
holds the Cognos login credentials.
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Default value
Cognos

Enable form authentication
Description
Specifies whether form-based authentication is enabled. You set this
property to True when either of the following condition is true:
v When the IBM EMM is not installed in the same domain as the
IBMCognos applications.
v When IBMCognos is accessed by using an IP address (within the same
network domain) instead of the Fully Qualified Hostname (which is
being used to access the IBM EMM applications), even if both the IBM
EMM applications and the IBMCognos installation are on the same
machine.
However, when the value is True, the login process to Cognos Connection
passes the login name and password in clear text and therefore is not
secure unless IBMCognos and the IBM EMM are configured to use SSL
communication.
Even with SSL configured, the user name and password appear as clear
text in the HTML source code when you "view source" in a displayed
report. For this reason, you must install IBM Cognos and IBM EMM in the
same domain.
Default value
False
Valid Values
True | False

Reports | Schemas | [product] | [schema name] | SQL Configuration
The SQL script creates views or tables for the reporting schemas. The Reports |
Schemas | [product] | [schema name] | SQL Configuration property provides
information about the name of the views or tables.

Table/View Name
Description
Specifies the name of the view or table that the SQL script you generate for
this reporting schema creates. As a best practice, you should not change
the name for any of the standard or default Table/View names. If you do,
you must also change the name of the view in the Cognos model in IBM
Cognos Framework Manager.
When you create a new reporting schema for a new audience level, you
must specify the names of all the new reporting tables/views.
Default value
Varies by schema
Valid Values
A string with the following restrictions.
v It can be no longer than 18 characters
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v It must use all uppercase letters
You must use the following naming convention:
v Start the name with the letter "UAR"
v Add a one-letter code to represent the IBM EMM application. See the list
of codes, below.
v Add an underscore character
v Add the table name, including a one or two letter code to indicate the
audience level
v Finish with an underscore character.
The SQL generator appends a time dimension code, if appropriate. See the
following list of codes:
For example: UARC_COPERF_DY is the name of the reporting view or table for
Campaign Offer Performance by Day.
Following is the list of IBM EMM application codes.
v Campaign: C
v eMessage: E
v Interact: I
v Distributed Marketing: X
v Marketing Operations: P
v Leads: L
Following is the list of the Time Dimension Codes added by the generator.
v Hour: HR
v
v
v
v

Day: DY
Week: WK
Month: MO
Quarter: QU

v Year: YR

Reports | Schemas | Campaign
The Reports | Schemas | Campaign property provides information about the data
source that identifies the Campaign database.

Input Datasource (JNDI)
Description
Specifies the name of the JNDI data source that identifies the Campaign
database, specifically, the system tables. This data source must exist if you
want to use the SQL generation tool to generate scripts that create
reporting tables. The SQL generation tool can generate scripts that create
reporting views without this data source, but it cannot validate them.
The database type of this data source must match the database type that
you select when you generate the SQL scripts for the Campaign views or
reporting tables.
Default value
campaignPartition1DS
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Reports | Schemas | Campaign | Offer Performance
The Offer Performance Schema yields contact and response history metrics for all
offers and for offers by campaign. By default, the schema is configured to generate
a "summary" view (or table) across all time.

Audience Key
Description
Specifies the name of the column that is the Audience Key for the audience
level that is supported by this reporting schema.
Default value
CustomerID
Valid Values
A string value no longer than 255 characters
If the key includes more than one column, use commas between the
column names. For example, ColumnX,ColumnY.

Contact History Table
Description
Specifies the name of the Contact History table for the audience level that
is supported by this reporting schema.
Default value
UA_ContactHistory

Detailed Contact History Table
Description
Specifies the name of the Detailed Contact History table for the audience
level that is supported by this reporting schema.
Default value
UA_DtlContactHist

Response History Table
Description
Specifies the name of the Response History table for the audience level that
is supported by this reporting schema.
Default value
UA_ResponseHistory

Over Time Variations
Description
Specifies the calendar time periods that are used by the "over time" reports
supported by this schema.
Default value
Day, Month
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Valid Values
Day, Week, Month, Quarter, Year

Reports | Schemas | Campaign | [schema name] | Columns | [Contact
Metric]
Use the Reports | Schemas | Campaign | [schema name] | Columns | [Contact
Metric] property to add contact metrics to the Campaign Performance or Offer
Performance reporting schemas.

Column Name
Description
Specifies the name to use in the reporting view or table for the column that
is specified in the Input Column Name field.
Default value
[CHANGE ME]
Valid Values
The name can be no longer than 18 characters, it must be in all uppercase
letters, and it cannot have spaces.

Function
Description
Specifies how the contact metric is determined or calculated.
Default value
count
Valid Values
count, count distinct, sum, min, max, average

Input Column Name
Description
The name of the column that provides the contact metric you are adding to
this reporting schema.
Default value
[CHANGE ME]
Valid Values
The name of the column in the Contact History and Detailed Contact
History tables.

Control Treatment Flag
Description
If you use the sample IBM Cognos reports or create your own custom
reports that include control groups, then each contact metric must have
two columns in the reporting schema. One column represents the metric
for the control group and the other column represents the metric for the
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target group. The value in Control Treatment Flag specifies whether the
column in the view represents the control group or the target group.
If your reports do not include control groups, you do not need the second
column for the control group.
Default value
0
Valid Values
v 0: the column represents the target group
v 1: the column represents the control group

Reports | Schemas | Campaign | [schema name] | Columns |
[Response Metric]
Use the Reports | Schemas | Campaign | [schema name] | Columns |
[Response Metric] property to add the response metrics that you want to include
in your reports to the Campaign Performance or Offer Performance reporting
schemas.

Column Name
Description
Specifies the name to use in the reporting view or table for the column that
is specified in the Input Column Name field.
Default value
[CHANGE ME]
Valid Values
The name can be no longer than 18 characters, it must be in all uppercase
letters, and it cannot have spaces.

Function
Description
Specifies how the response metric is determined or calculated.
Default value
count
Valid Values
count, count distinct, sum, min, max, average

Input Column Name
Description
The name of the column that provides the response metric you are adding
to this reporting schema.
Default value
[CHANGE ME]
Valid Values
The name of the column in the Response History table.

120

Reports: Installation and Configuration Guide

Control Treatment Flag
Description
If you use the standard IBM Cognos reports or create your own custom
reports that include control groups, then each response metric must have
two columns in the reporting schema. One column represents the response
from the control group and the other column represents the response from
the target group. The value in Control Treatment Flag specifies whether
the column in the view represents the control group or the target group.
If your reports do not include control groups, you do not need the second
column for the control group.
Default value
0
Valid Values
v 0: the column represents the target group
v 1: the column represents the control group

Reports | Schemas | Campaign | Campaign Performance
The Campaign Performance schema yields contact and response history metrics at
the campaign, campaign-offer, and campaign-cell level.

Audience Key
Description
Specifies the name of the column that is the Audience Key for the audience
level that is supported by this reporting schema.
Default value
CustomerID
Valid Values
A string value no longer than 255 characters.
If the key includes more than one column, use commas between the
column names. For example, ColumnX,ColumnY.

Contact History Table
Description
Specifies the name of the Contact History table for the audience level that
is supported by this reporting schema.
Default value
UA_ContactHistory

Detailed Contact History Table
Description
Specifies the name of the Detailed Contact History table for the audience
level that is supported by this reporting schema.
Default value
UA_DtlContactHist
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Response History Table
Description
Specifies the name of the Response History table for the audience level that
is supported by this reporting schema.
Default value
UA_ResponseHistory

Over Time Variations
Description
Specifies the calendar time periods that are used by the "over time" reports
supported by this schema.
Default value
Day, Month
Valid Values
Day, Week, Month, Quarter, Year

Reports | Schemas | Campaign | Campaign Offer Response Breakout
The Campaign Offer Response Breakout schema supports reporting on
campaign-detailed responses, which are broken out by response type and by offer
data. This schema template gives different response counts for each custom
Response Type for campaigns and offers grouped by campaign.
This schema

Response History Table
Description
Specifies the name of the Response History table for the audience level that
is supported by this reporting schema.
Default value
UA_ResponseHistory

Reports | Schemas | Campaign | Campaign Offer Response Breakout |
Columns | [Response Type]
Use the Reports | Schemas | Campaign | Campaign Offer Response Breakout |
Columns | [Response Type] property to add any custom response types that you
want to include in your reports to the reporting schema.

Column Name
Description
Specifies the name to use in the reporting view or table for the column that
is specified in the Response Type Code field.
Default value
[CHANGE ME]
Valid Values
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The name can be no longer than 18 characters, it must be in all uppercase
letters, and it cannot have spaces.

Response Type Code
Description
The response type code for the specified response type. This value is held
in the ResponseTypeCode column in the UA_UsrResponseType table.
Default value
[CHANGE ME]
Valid Values
The example response type codes are as follows:
v EXP (explore)
v CON (consider)
v
v
v
v

CMT
FFL
USE
USB

(commit)
(fulfill)
(use)
(unsubscribe)

v UKN (unknown)
Your Campaign installation may have additional custom response type
codes.

Control Treatment Flag
Description
If you use the standard IBM Cognos reports provided in the IBM EMM
Reports Pack or custom reports that include control groups, then each
response type must have two columns in the reporting schema. One
column represents the response type from the control group and the other
column represents the response type from the target group. The value in
Control Treatment Flag specifies whether the column in the view
represents the control group or the target group.
If your reports do not include control groups, you do not need the second
column for the control group.
Default value
0
Valid Values
v 0: the column represents the target group
v 1: the column represents the control group

Reports | Schemas | Campaign | Campaign Offer Contact Status
Breakout
The Campaign Offer Contact Status Breakout schema supports reporting on
campaign-detailed contacts, which are broken out by contact status type and by
offer data. This schema template gives different contact counts for each custom
Contact Status Type for campaigns and offers grouped by campaign.
By default, none of the example Campaign reports use this schema.
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Audience Key
Description
Specifies the name of the column that is the Audience Key for the audience
level that is supported by this reporting schema.
Default value
CustomerID
Valid Values
A string value no longer than 255 characters.
If the key includes more than one column, use commas between the
column names. For example, ColumnX,ColumnY.

Contact History Table
Description
Specifies the name of the Contact History table for the audience level that
is supported by this reporting schema.
Default value
UA_ContactHistory

Detailed Contact History Table
Description
Specifies the name of the Detailed Contact History table for the audience
level that is supported by this reporting schema.
Default value
UA_DtlContactHist

Reports | Schemas | Campaign | Campaign Offer Contact Status
Breakout | Columns | [Contact Status]
Use the Reports | Schemas | Campaign | Campaign Offer Contact Status
Breakout | Columns | [Contact Status] to add the contact status that you want to
include in your reports to the reporting schemas.

Column Name
Description
Specifies the name to use in the reporting view or table for the column that
is specified in the Contact Status field.
Default value
[CHANGE ME]
Valid Values
The name can be no longer than 18 characters, it must be in all uppercase
letters, and it cannot have spaces.

Contact Status Code
Description
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The name of the contact status code. This value is held in the
ContactStatusCode column in the UA_ContactStatus table.
Default value
[CHANGE ME]
Valid Values
The example contact status types are as follows.
v CSD (campaign send)
v DLV (delivered)
v UNDLV (undelivered)
v CTR (control)
Your Campaign installation may have additional custom contact status
types.

Reports | Schemas | Campaign | Campaign Custom Attributes |
Columns | [Campaign Custom Column]
Use the Reports | Schemas | Campaign | Campaign Custom Attributes |
Columns | [Campaign Custom Column] property to add any custom campaign
attributes that you want to include in your reports to the reporting schema.

Column Name
Description
Specifies the name to use in the reporting view or table for the attribute
that is identified in the Attribute ID field.
Default value
[CHANGE ME]
Valid Values
The name can be no longer than 18 characters, it must be in all uppercase
letters, and it cannot have spaces.

Attribute ID
Description
The value from the attribute's AttributeID column in the
UA_CampAttribute table.
Default value
0

Value Type
Description
The data type of the campaign attribute.
Default value
StringValue
Valid Values
StringValue, NumberValue, DatetimeValue
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If this campaign attribute holds a currency value, select NumberValue.
If this campaign attribute's Form Element Type was set to Select Box String in Campaign, select StringValue.

Reports | Schemas | Campaign | Campaign Custom Attributes |
Columns | [Offer Custom Column]
Use the Reports | Schemas | Campaign | Campaign Custom Attributes |
Columns | [Offer Custom Column] property to add any custom offer attributes
that you want to include in your reports to the reporting schema.
Use this form to add

Column Name
Description
Specifies the name to use in the reporting view or table for the attribute
that is identified in the Attribute ID field.
Default value
[CHANGE ME]
Valid Values
The name can be no longer than 18 characters, it must be in all uppercase
letters, and it cannot have spaces.

Attribute ID
Description
The value from the attribute's AttributeID column in the
UA_OfferAttribute table.
Default value
0

Value Type
Description
The data type of the offer attribute.
Default value
StringValue
Valid Values
StringValue, NumberValue, DatetimeValue
If this offer attribute holds a currency value, select NumberValue.
If this offer attribute's Form Element Type was set to Select Box - String
in Campaign, select StringValue.
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Reports | Schemas | Campaign | Campaign Custom Attributes |
Columns | [Cell Custom Column]
Use the Reports | Schemas | Campaign | Campaign Custom Attributes |
Columns | [Cell Custom Column] property to add any custom cell attributes that
you want to include in your reports to the reporting schema.

Column Name
Description
Specifies the name to use in the reporting view or table for the attribute
that is identified in the Attribute ID field.
Default value
[CHANGE ME]
Valid Values
The name can be no longer than 18 characters, it must be in all uppercase
letters, and it cannot have spaces.

Attribute ID
Description
The value from the attribute's AttributeID column in the
UA_CellAttribute table.
Default value
0

Value Type
Description
The data type of the cell attribute.
Default value
StringValue
Valid Values
StringValue, NumberValue, DatetimeValue

Reports | Schemas | Interact
The Interact reporting schemas reference three separate databases: the design time,
runtime, and learning databases. Use the Reports | Schemas | Interact property
to specify the JNDI names of the data sources for those databases.
The data sources that are specified on this page must exist if you want to use the
Reporting SQL generation tool to generate scripts that create reporting tables. The
SQL generation tool can generate scripts that create reporting views without these
data sources, but it cannot validate the scripts.
The database type of the data sources must match the database type that you select
when you generate the SQL scripts for the views or reporting tables.
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Interact Design Datasource (JNDI)
Description
Specifies the name of the JNDI data source that identifies the Interact
design time database, which is also the Campaign system tables.
Default value
campaignPartition1DS

Interact Runtime Datasource (JNDI)
Description
Specifies the name of the JNDI data source that identifies the Interact
runtime database.
Default value
InteractRTDS

Interact Learning Datasource (JNDI)
Description
Specifies the name of the JNDI data source that identifies the Interact
learning database.
Default value
InteractLearningDS

Reports | Schemas | Interact | Interact Performance
The Interact Performance schema yields contact and response history metrics at the
channel, channel-offer, channel-segment, channel-interaction point, interactive cell,
interactive cell-offer, interactive cell-interaction point, interactive offer, interactive
offer-cell, and interactive offer-interaction point levels.

Audience Key
Description
Specifies the name of the column that is the Audience Key for the audience
level that is supported by this reporting schema.
Default value
CustomerID
Valid Values
A string value no longer than 255 characters.
If the key includes more than one column, use commas between the
column names. For example, ColumnX,ColumnY.

Detailed Contact History Table
Description
Specifies the name of the Detailed Contact History table for the audience
level that is supported by this reporting schema.
Default value
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UA_DtlContactHist

Response History Table
Description
Specifies the name of the Response History table for the audience level that
is supported by this reporting schema.
Default value
UA_ResponseHistory

Over Time Variations
Description
Specifies the calendar time periods that are used by the "over time" reports
supported by this schema.
Default value
Hour, Day
Valid Values
Hour, Day, Week, Month, Quarter, Year

Reports | Schemas | eMessage
The Reports | Schemas | eMessage property specifies the name of the data source
that identifies the eMessage tracking tables, which are in the Campaign system
tables.

eMessage Tracking Datasource (JNDI)
Description
Specifies the name of the JNDI data source that identifies the eMessage
tracking tables, which are in the Campaign system tables. This data source
must exist if you want to use the Reports SQL generation tool to validate
scripts that create reporting tables. The SQL generation tool can generate
scripts that create reporting views without this data source, but it cannot
validate them.
The database type of this data source must match the database type that
you select when you generate the SQL scripts for the views or reporting
tables.
Default value
campaignPartition1DS

Campaign | partitions | partition[n] | reports
The Campaign | partitions | partition[n] | reports property defines the different
types of folders for reports.

offerAnalysisTabCachedFolder
Description
The offerAnalysisTabCachedFolder property specifies the location of the
folder that contains the specification for bursted (expanded) offer reports
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listed on the Analysis tab when you reach it by clicking the Analysis link
on the navigation pane. The path is specified by using the XPath notation.
Default value
/content/folder[@name='Affinium Campaign - Object Specific
Reports']/folder[@name='offer']/folder[@name='cached']

segmentAnalysisTabOnDemandFolder
Description
The segmentAnalysisTabOnDemandFolder property specifies the location of
the folder that contains the segment reports listed on the Analysis tab of a
segment. The path is specified by using the XPath notation.
Default value
/content/folder[@name='Affinium Campaign - Object Specific
Reports']/folder[@name='segment']/folder[@name='cached']

offerAnalysisTabOnDemandFolder
Description
The offerAnalysisTabOnDemandFolder property specifies the location of the
folder that contains the offer reports listed on the Analysis tab of an offer.
The path is specified by using the XPath notation.
Default value
/content/folder[@name='Affinium Campaign - Object Specific
Reports']/folder[@name='offer']

segmentAnalysisTabCachedFolder
Description
The segmentAnalysisTabCachedFolder property specifies the location of the
folder that contains the specification for bursted (expanded) segment
reports listed on the Analysis tab when you reach it by clicking the
Analysis link on the navigation pane. The path is specified by using the
XPath notation.
Default value
/content/folder[@name='Affinium Campaign - Object Specific
Reports']/folder[@name='segment']

analysisSectionFolder
Description
The analysisSectionFolder property specifies the location of the root
folder where report specifications are stored. The path is specified by using
the XPath notation.
Default value
/content/folder[@name='Affinium Campaign']

campaignAnalysisTabOnDemandFolder
Description

130

Reports: Installation and Configuration Guide

The campaignAnalysisTabOnDemandFolder property specifies the location of
the folder that contains the campaign reports listed on the Analysis tab of a
campaign. The path is specified by using the XPath notation.
Default value
/content/folder[@name='Affinium Campaign - Object Specific
Reports']/folder[@name='campaign']

campaignAnalysisTabCachedFolder
Description
The campaignAnalysisTabCachedFolder property specifies the location of
the folder that contains the specification for bursted (expanded) campaign
reports listed on the Analysis tab when you reach it by clicking the
Analysis link on the navigation pane. The path is specified by using the
XPath notation.
Default value
/content/folder[@name='Affinium Campaign - Object Specific
Reports']/folder[@name='campaign']/folder[@name='cached']

campaignAnalysisTabEmessageOnDemandFolder
Description
The campaignAnalysisTabEmessageOnDemandFolder property specifies the
location of the folder that contains the eMessage reports listed on the
Analysis tab of a campaign. The path is specified by using the XPath
notation.
Default value
/content/folder[@name='Affinium Campaign']/folder[@name='eMessage
Reports']

campaignAnalysisTabInteractOnDemandFolder
Description
Report server folder string for Interact reports.
Default value
/content/folder[@name='Affinium Campaign']/folder[@name='Interact
Reports']
Availability
This property is applicable only if you install Interact.

interactiveChannelAnalysisTabOnDemandFolder
Description
Report server folder string for Interactive Channel analysis tab reports.
Default value
/content/folder[@name='Affinium Campaign - Object Specific
Reports']/folder[@name='interactive channel']
Availability
This property is applicable only if you install Interact.
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Appendix B. Formatting the Cognos reports
Use the styles from the GlobalReportStyles.css file with some additional manual
formatting for the new IBM Cognos reports for your IBM EMM applications.
The IBM Cognos reporting integration components include a global report style
sheet, GlobalReportStyles.css. That way the styles in the new reports match the
styles that are used by the reports provided in the IBM EMM reports packages.
This appendix provides the following information for the various kinds of reports
(lists, charts, and so on).
v The styles that are implemented with the GlobalReportStyles.css file.
v

Style formatting is something that you must do manually when you author a
report, because there are certain cases in which the style cannot be provided by
the style sheet.

Global report styles
Use the styles included with the global report style sheet, GlobalReportStyles.css
for your new IBM Cognos report. The styles in the new reports must match the
styles that are used by the reports that are already provided in the IBM EMM
reports packages.
Table 26. Global report styles.
Item

CSS class name

Style

General font family

pg, pp

font-family: Arial, ...

Report title

ta

font-size: 10pt;

Page - Header

ph

padding-bottom:10px;
font-size:8pt;
font-weight:bold;

Page - Footer

pf

padding-top:10px;
font-size:8pt;
font-weight:bold;

Field Set Labels

fs

font-size:8pt;

Table

tb

border-collapse:collapse
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Table 26. Global report styles (continued).
Item

CSS class name

Style

Table - List Column
Title Cell

lt

text-align:left;
background-color:#F2F2F2; /*light grey*/
font-weight:bold;
border-top:1px solid silver;
border-left:1px solid silver;
border-bottom:1.5pt solid black;
border-right:1px solid silver;
padding-top: 13px;

Table - List Column
Body Cell

lc, lm

border:1px solid silver;

Table - Outer header

oh

background-color:#FFFFCC; /*light yellow*/

Table - List Footer

of, os

border-top:1.5pt solid black;

Crosstab

xt

border-collapse:collapse;

Crosstab - Default
Measure Cell

xm

border-top:1px solid silver;
border-left:1px solid silver;
border-bottom:1.5pt solid black;
border-right:1.5pt solid black;

Crosstab - Member
Label Cell

ml

background-color: transparent;
border:1px solid silver;

Crosstab - Outer Level ol
Total
Crosstab - Spacer

xs

background-color:#F7F7F7; /*offwhite*/

background-color: transparent;
font-weight: bold;

Chart

ch

Chart - Title

ct

border:1pt solid #E4E4E4;
font-size:10pt;
font-weight:bold;

Chart - Axis Labels

al

font-size:10pt;

Chart - Axis Line

at

color:#939393;

Chart - Gradient

In XML Report
Specification

Before the closing chart tag (</combinationChart>) in the XML
Report Specification, paste the following:
<fillEffects>
<chartGradient direction="up" fromColor="#F2F2F2"
toColor="#FFFFFF"/>
</fillEffects>
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Table 26. Global report styles (continued).
Item

CSS class name

Style

Chart - Chart Palette

In XML Report
Specification

Before the closing chart tag (</combinationChart>) in the XML
Report Specification, paste the following:
<chartPalette>
<chartColor value="#00508A"/>
<chartColor value="#376C37"/>
<chartColor value="#FB9A4D"/>
<chartColor value="#B8351F"/>
<chartColor value="#69817B"/>
<chartColor value="#473E9A"/>
<chartColor value="#5384AE"/>
<chartColor value="#61C2A3"/>
<chartColor value="#FF5656"/>
<chartColor value="#A583BB"/>
<chartColor value="#506079"/>
<chartColor value="#A0A080"/>
<chartColor value="#F1EDC1"/>
<chartColor value="#A6A6A6"/>
<chartColor value="#818181"/>
</chartPalette>

Report page styles
Use the styles included with the global report style sheet, GlobalReportStyles.css
for the report page.
Table 27. Report page styles.
Item

Style

Text

Arial font

Report title text

Arial 10 point

Page footer text

Arial 8 point

Field Set labels

Arial 8 point
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List report styles
Use the styles included with the global report style sheet, GlobalReportStyles.css
for the list report.
The following table shows formatting from the GlobalStyleSheet.css style sheet:
Table 28. List report styles
Item

Style

Cells

1 px silver line borders (unless otherwise
noted)

Column header

Light gray background; 1.5 pt black line
separates column header from rest of table

Summary header rows (list headers)

Light yellow background

Total row at bottom

Dark gray background; 1.5 pt black line
separates row from rest of table

Additionally, when you create a new list report, do the following to make it match
the existing reports:
v Use List Headers (and not List Footers) to display summarizations at the object
level.
v Manually right-justify any numbers that are displayed in List Headers. Unlike
List Footers, List Headers are not separated into the outer component and
summary component, which use a right-justified style by default. So when you
summarize information into a List Header, you must complete the extra step and
right-justify the values.
v Optionally add 1.5 pt solid black borders to group columns
Following is a list report that does not use the global styles.
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Following is a list report that uses the global styles.

Date formats for globalized versions
If you use a globalized version of the IBM EMM reports package, you see a
different date format in your list reports depending on which locale you use.
Cognos list reports use the date style medium.
The following table shows the date formats for list reports for all available locales.
Table 29. Cognos list reports date formats for globalized versions
Locale

Cognos list reports date format example

English

Mar 18, 2014

Brazilian Portuguese

18/03/2014

French

18 mars 14

German

18.03.2014

Italian

18/mar/2014
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Table 29. Cognos list reports date formats for globalized versions (continued)
Locale

Cognos list reports date format example

Japanese

2014/03/18

Korean

2014-03-18

Russian

18.03.2014

Simplified Chinese

2014-3-18

Spanish

18-Mar-14

Crosstab report styles
Use the styles included with the global report style sheet, GlobalReportStyles.css
for the crosstab reports.
Crosstab reports obtain the following formatting from the GlobalStyleSheet.css.
Table 30. Crosstab report styles.
Item

Style

Cells

Transparent background; 1 px silver line
borders

Measure cell (upper left)

1.5 pt black line separates the cell from the
rest of the crosstable

Outer level totals

Gray/offwhite background

Additionally, when you create a new list report, do the following to make it match
the existing reports.
v Use 1.5 pt black borders to separate summarizations from measures.
v Use 1.5 black borders to group logical column groupings.
v

General guideline: avoid summarizing both columns and rows in the same
report.

Following is a crosstab report that does not use the global styles.

Following is a crosstab report that uses the global styles and has 1.5 px borders
that are applied to show column groupings.
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Chart styles
Use the styles included with the global report style sheet, GlobalReportStyles.css
for the charts.
Charts obtain the following formatting from the GlobalStyleSheet.css.
Table 31. Chart styles.
Item

Style

Charts

1 pt light gray border

Titles and labels

10 point bold font

Additionally, when you create a new chart, do the following to make it match the
existing chart reports.
Use the default width, unless there is more than one chart on the report. When
you include multiple charts in a single report, set the chart width to 750px.
v To use gradients and color palettes, copy and paste the strings from the table in
“Global report styles” on page 133 into the XML report specification.
v General guideline: select the chart type based on the data you expect to be
returned.
v

–

Use line graphs as the chart type only when you can guarantee the report
retrieves continuous data.
– If there are multiple series, a stacked bar works better than a non-stacked
bar.
– As a best practice, use percentages only when the total percentage equals
100%. Pie charts tend to confuse people when the values do not add up to
100%.
v
If there are only two series on a chart and you display both the Y1 and Y2 axes,
as a best practice you must match the colors to the first two palette colors for
the axis labels.
Following is a chart that does not use the global styles.
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Following is a chart that uses the global styles and has additional formatting
applied.

Date formats for globalized versions
If you use a globalized version of the IBM EMM reports package, you see a
different date format in your chart reports depending on which locale you use.
Cognos chart reports use the date style short.
The following table shows the date formats for chart reports for all available
locales.
Table 32. Cognos chart reports date formats for globalized versions
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Locale

Cognos chart reports date format example

English

3/18/14

Brazilian Portuguese

18/03/14

French

18/03/14

German

18.03.14

Italian

18/03/14

Japanese

14/03/18

Korean

14-03-18

Russian

18.03.14
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Table 32. Cognos chart reports date formats for globalized versions (continued)
Locale

Cognos chart reports date format example

Simplified Chinese

14-3-18

Spanish

18/03/14

Dashboard report styles
Dashboard reports use the global styles with some manual formatting.
Be sure to format reports that are displayed in the Dashboard according to the
following guidelines so they fit properly in Dashboard portlets.
Table 33. Dashboard report styles.
Item

Style

Background color

Keep background color set to gray (hex
value F2F2F2).

Size

Specify size by using percentages whenever
possible. When sizing with a percentage is
not possibe, set the size to 323 pixels wide
by 175 pixels tall.

Subtitles

Put subtitles on the left side.

Dates

Put dates on the right side.

Legends

Center legends below the chart.

Lines in line charts

Display horizontal lines only. Do not display
vertical lines.

Axis line color

Keep axis lines set to black.

Grid line color

Keep grid lines set to gray (hex value
D9D9D9).

Lists (tables)

Display a maximum of 10 lines.
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Appendix C. Formatting the Campaign and eMessage Cognos
reports
Additional styling is done for Campaign and eMessage Cognos reports. The global
report styles are modified to add extra classes to override the styling of existing
classes to improve the look and feel of Campaign and eMessage reports.
The page class, newpg, is created to style Campaign and eMessage reports. All
reports are modified to use the newpg class for the page style. Child classes are
added to the newpg parent class in the GlobalReportStyles.css.
Use the new page class, newpg, for creating new report pages when styling
Campaign and eMessage Cognos reports
This appendix provides the following information for the various kinds of reports
(lists, charts, and so on).
v The styles that are implemented with the GlobalReportStyles.css file.
v Style formatting is something that you must do manually when you author a
report, because there are certain cases in which the style cannot be provided by
the style sheet.

Global report styles
Use the styles included with the global report style sheet, GlobalReportStyles.css
for your IBM Campaign and eMessage Cognos report.
Table 34. Global report styles.
Item

CSS class name

Style

Page - Header

ph

padding-bottom:10px;
font-size:8pt;
font-weight:bold;

Page - Footer

pf

padding-top:10px;
font-size:8pt;
font-weight:bold;

Table - List column
title cell

lt

text-align:left;
background-color:#FFF;
font-weight:bold;
border-left:0px solid silver;
border-bottom:1.5pt solid black;
border-right:1px solid silver;
vertical-align; top;
padding-top: 3px 5px;
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Table 34. Global report styles (continued).
Item

CSS class name

Style

Table - List column
body cell interior

lci

border-top:1px solid #A0A0A0;
border-bottom:1px solid #A0A0A0;
background-color: white !important;
text-align: right;
padding: 3px 5px;
vertical-align: middle;

Table - List column
body cell

lc

border-top:1px solid #ddd;
border-bottom:1px solid #ddd;
padding: 3px 5px;
text-align: left;
vertical-align: middle;

Table - List column
body measure cell

lm

vertical-align: top;
border:1px solid #ddd;
border-right: 0;
border-left: 0;
padding: 3px 5px;
text-align: right;

Crosstab - Totals first
row

tr

border-left: 2px solid black;
background-color: #bebebe !important;
font-weight: bold;
padding: 3px 5px;

Complex table total
-new class added

ctth

color: #000000;
background-color: #bebebe;
border-bottom:2px solid black;
padding: 3px 5px;
border-left: 2px solid #bebebe;

Table totals row

ttr

color: #000000;
background-color: #bebebe;
padding: 3px 5px;
border-left: 2px solid #bebebe;
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Table 34. Global report styles (continued).
Item

CSS class name

Style

Table totals row

ctr

color: #000000;
font-weight: bold;
border-left:2px solid black;
background-color: white;
border-bottom:1px solid #a2a2a2;

Table totals header

cth

color: #000000;
border-bottom:2px solid black;
border-left:1.5px solid white;
border-right:1.5px solid white;
font-weight: 100;

List - Inner header cell ih

border-top:1px solid #A0A0A0;
border-bottom:1px solid #A0A0A0;
padding: 3px 5px;
vertical-align: middle;

List - Outer header
cell

oh

font-weight: bold;
vertical-align: top;
background-color: #ddd;
border: 1px solid #CCCCCC;
border-right: 0;
border-left: 0;
padding: 3px 5px;
word-break:keep-all;

Outer header cell with ohl
top border

font-weight: bold;
vertical-align: top;
background-color: #ddd;
padding: 3px 5px;
word-break:keep-all;
border-top:2px solid black;
border-left:1.5px solid #ddd;
border-right: 5pt solid #ddd;
border-style:solid;
border-bottom:none;

Crosstab

xt

border-bottom: 2px solid black;
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Table 34. Global report styles (continued).
Item

CSS class name

Style

Crosstab - Member
label cell

ml

font-style: normal !important;
color: black;
font-weight: 300;
height: 30px;
border-left: none;
border-right: none;
border-bottom:1px solid #a2a2a2;

Crosstab - Member
label cell

cht

vertical-align: top;
background-color:transparent;
padding: 3px 5px;
text-align: left;

Crosstab - Member
value cell

mv

vertical-align: top;
white-space: nowrap;
border: 1px solid #a2a2a2;
padding: 3px 5px;
text-align: right;
border-left:none;
border-right:none;

Field set

fs

display: -moz-inline-block;
display: inline;
text-align: left;
font-size:8pt;
margin-right: 1446px;

Chart

ch

border:1pt solid #E4E4E4;

Chart - Title

ct

font-size:10pt;
font-weight:bold;

Chart - Axis labels

al

font-size:10pt;

Chart - Axis title

at

font-weight:bold;
text-align:center;
font-size:10pt;
color:#939393;
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Table 34. Global report styles (continued).
Item

CSS class name

Style

Chart - Chart Palette

In XML Report
Specification

Before the closing chart tag (</combinationChart>) in the XML
Report Specification, paste the following:
<chartPalette>
<chartColor value="#C7E0E9"/>
<chartColor value="#A8C9E5"/>
<chartColor value="#59A0BD"/>
<chartColor value="#497C91"/>
<chartColor value="#C9C6E4"/>
<chartColor value="#B1ADD8"/>
<chartColor value="#8D88C7"/>
<chartColor value="#7B78A4"/>
<chartColor value="#F0EEBB"/>
<chartColor value="#EEEA99"/>
<chartColor value="#E8E667"/>
<chartColor value="#B7B35C"/>
<chartColor value="#C0D0A0"/>
<chartColor value="#A8C179"/>
<chartColor value="#677E13"/>
<chartColor value="#768B4E"/>
</chartPalette>

List report styles
Use the styles included with the global report style sheet, GlobalReportStyles.css
for the list report.
The following table shows formatting from the GlobalStyleSheet.css style sheet:
Table 35. List report styles.
Item

Style

Cells

1 px solid very light gray border at the top
and bottom

Column header

White background; 1.5 pt black line at the
bottom separates column header from rest of
table

Summary header rows (list headers)

Light gray background

Total row at bottom

Dark gray background
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The following is a list report that uses the global styles.

Date formats for globalized versions
If you use a globalized version of the IBM EMM reports package, you see a
different date format in your list reports depending on which locale you use.
Cognos list reports use the date style medium.
The following table shows the date formats for list reports for all available locales.
Table 36. Cognos list reports date formats for globalized versions
Locale

Cognos list reports date format example

English

Mar 18, 2014

Brazilian Portuguese

18/03/2014

French

18 mars 14

German

18.03.2014

Italian

18/mar/2014

Japanese

2014/03/18

Korean

2014-03-18

Russian

18.03.2014

Simplified Chinese

2014-3-18

Spanish

18-Mar-14

Crosstab report styles
Use the styles included with the global report style sheet, GlobalReportStyles.css
for the crosstab reports.
Crosstab reports obtain the following formatting from the GlobalStyleSheet.css.
Table 37. Crosstab report styles.
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Item

Style

Cells

White background; 1 px medium light gray
border at top and bottom

Measure cell (upper left)

1px light gray border at bottom

Complex Table Row (ctr)

2px solid black left border, bold font

Complex Table Total (ctt)

Gray background, 2px solid black left border
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Table 37. Crosstab report styles (continued).
Item

Style

Complex Table Total (ctth)

Gray background; 2px solid black bottom
border and

Table Total Rows (ttr)

Gray background

The following is a crosstab report that uses the global styles.

Chart styles
Use the styles included with the global report style sheet, GlobalReportStyles.css
for the charts.
Charts obtain the following formatting from the GlobalStyleSheet.css.
Table 38. Chart styles.
Item

Style

Charts

1 pt light gray border

Titles and labels

10 point bold font

Additionally, when you create a new chart, do the following to make it match the
existing chart reports.
Use the default width, unless there is more than one chart on the report. When
you include multiple charts in a single report, set the chart width to 750px.
v To use gradients and color palettes, copy and paste the strings from the table in
“Global report styles” on page 143 into the XML report specification.
v
If there are only two series on a chart and you display both the Y1 and Y2 axes,
as a best practice you must match the colors to the first two palette colors for
the axis labels.
v

Following is a chart that uses the global styles and has additional formatting
applied.
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Date formats for globalized versions
If you use a globalized version of the IBM EMM reports package, you see a
different date format in your chart reports depending on which locale you use.
Cognos chart reports use the date style short.
The following table shows the date formats for chart reports for all available
locales.
Table 39. Cognos chart reports date formats for globalized versions
Locale

Cognos chart reports date format example

English

3/18/14

Brazilian Portuguese

18/03/14

French

18/03/14

German

18.03.14

Italian

18/03/14

Japanese

14/03/18

Korean

14-03-18

Russian

18.03.14

Simplified Chinese

14-3-18

Spanish

18/03/14

Dashboard report styles
Dashboard reports use the global styles with some manual formatting.
Be sure to format reports that are displayed in the Dashboard according to the
following guidelines so they fit properly in Dashboard portlets.
Table 40. Dashboard report styles.
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Item

Style

Size

Specify size by using percentages whenever
possible. When sizing with a percentage is
not possibe, set the size to 323 pixels wide
by 175 pixels tall.

Subtitles

Put subtitles on the left side.

Dates

Put dates on the right side.
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Table 40. Dashboard report styles (continued).
Item

Style

Legends

Center legends below the chart.

Lines in line charts

Display horizontal lines only. Do not display
vertical lines.

Axis line color

Keep axis lines set to black.

Grid line color

Keep grid lines set to gray (hex value
D9D9D9).

Lists (tables)

Display a maximum of 10 lines.
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Appendix D. Reports and reporting schemas by product
You can customize the reporting schemas in the Campaign Report Package by
adding contact or response metrics, attributes, or response types.
The reporting schemas in the Campaign Report Package can be customized in the
following ways:
v
v
v
v

Add contact or response metrics
Add custom campaign, offer, or cell attributes
Add response types
Configure the audience level for performance reports

v Create reporting schemas for additional audience levels.
The following table maps the individual IBM Cognos BI reports provided in the
Campaign Reports Package to the reporting schemas that support them.
Table 41. Mapping of IBM Cognos BI reports to the reporting schema

Campaign
Views schema

Campaign
Custom
Attributes
schema

What If Offer
Financial
Summary
report

X

X

Campaign
Detailed Offer
Response
Breakout

X

X

X

Offer Response X
Breakout,
Dashboard
version

X

X

Campaign
Performance
schema

Campaign
Offer
Response
Breakout

Offer Contact
Status
Breakout

X

Campaign
Financial
Summary by
Offer (Actual)

X

X

X

Campaign
Return on
Investment
Comparison

X

X

X

Campaign
Offer
Performance
by Month

X

X

Campaign
Performance
Comparison

X

X

Campaign
Response Rate
Comparison

X

X
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Performance
schema
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Table 41. Mapping of IBM Cognos BI reports to the reporting schema (continued)

Campaign
Views schema
Campaign
Performance
Comparison
with Revenue

Campaign
Custom
Attributes
schema

Campaign
Performance
schema

X

X

Campaign
X
Performance
Comparison by
Initiative

X

Campaign
Performance
Summary by
Cell

X

X

Campaign
Performance
Summary by
Cell with
Revenue

X

X

Campaign
Performance
Summary by
Cell and
Initiative

X

X

Campaign
Performance
Summary by
Offer

X

X

Campaign
Performance
Summary by
Offer with
Revenue

X

X

Campaign
X
Revenue
Comparison by
Offer

X

Offer
Performance
schema

Campaign
Summary

X

Offer
Campaign
Listings

X

Offer
Performance
Metrics

X

X

Offer
Performance
by Day

X

X

Offer
Responses for
Last 7 Days

X

X
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Campaign
Offer
Response
Breakout

Offer Contact
Status
Breakout

Table 41. Mapping of IBM Cognos BI reports to the reporting schema (continued)

Campaign
Views schema
Offer
Performance
Comparison

Campaign
Custom
Attributes
schema

Campaign
Performance
schema

Offer
Performance
schema

X

X

Offer Response X
Rate
Comparison

X

Offer
Performance
Summary by
Campaign

X

X

Campaign
Offer
Response
Breakout

Offer Contact
Status
Breakout

X

The following reports rely on the standard set of custom contact and response
metric attributes that are provided in Campaign:
v What If Offer Financial Summary
v
v
v
v

Campaign
Campaign
Campaign
Campaign

Detailed Offer Response Breakout
Financial Summary by Offer (Actual)
Performance Comparison with Revenue
Performance Summary by Cell with Revenue

v

Campaign Performance Summary by Offer with Revenue

eMessage Reports and Reporting Schemas
Different reports, such as Message Overview report, Detailed Link report,
eMessage Reports Processing Overview, and SMS Message Summary Report are
available in the eMessage Reports Package.
The following table maps the individual IBM Cognos BI reports provided in the
eMessage Reports Package to the IBM reporting schemas that support them.
Table 42. eMessage reports and reporting schemas
Mailing Performance Schema
Message Overview report

X

Detailed Link report

X

Detailed Link by Cell report

X

Detailed Bounce report

X

A/B Testing Performance
Report

X

eMessage Reports Processing X
Overview
SMS Message Summary
Report

X
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Interact Reports and Reporting Schemas
The Interact Report Package reports are supported by IBM reporting schemas. You
can customize the schemas to specify time periods, configure audience levels, and
create extra performance reporting schemas.
You can customize the reporting schemas in the Interact Report Package in the
following ways:
v Specify calendar time periods for performance reports
v Configure the audience level for performance reports
v Create extra performance reporting schemas for extra audience levels
The following table maps the individual IBM Cognos BI reports provided in the
Interact Reports Package to the IBM reporting schemas that support them.
Interactive
Channel /
Interact
Campaign
Interactive
Performance Deployment
View schema View schema History
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Interact
Interact
Runtime
Learning
View schema View schema

Campaign Interactive
Channel
Deployment
History

X

Campaign Interactive
Cell
Performance
Over Time

X

X

X

Campaign Interactive
Cell
Performance
by Offer

X

X

X

Campaign Interactive
Offer
Performance
Over Time

X

X

X

Campaign Interactive
Offer
Performance
by Cell

X

X

X

Campaign Interactive
Offer
Learning
Details

X

Interactive
Cell Lift
Analysis

X
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X

X

X

X

X

Interactive
Channel /
Interact
Campaign
Interactive
Performance Deployment
View schema View schema History
Interactive
Channel Channel
Deployment
History

X

Interactive
Channel Channel
Event
Activity
Summary
report

X

Interactive
Channel Channel
Interaction
Point
Performance
Summary

X

Interactive
Channel Channel
Treatment
Rule
Inventory

X

Interactive
Segment Lift
Analysis
Interaction
Point
Performance

Interact
Interact
Runtime
Learning
View schema View schema

X

X

X

X

X

X

X

X

X

X
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Before you contact IBM technical support
If you encounter a problem that you cannot resolve by consulting the
documentation, your company's designated support contact can log a call with
IBM technical support. Use these guidelines to ensure that your problem is
resolved efficiently and successfully.
If you are not a designated support contact at your company, contact your IBM
administrator for information.
Note: Technical Support does not write or create API scripts. For assistance in
implementing our API offerings, contact IBM Professional Services.

Information to gather
Before you contact IBM technical support, gather the following information:
v A brief description of the nature of your issue.
v Detailed error messages that you see when the issue occurs.
v Detailed steps to reproduce the issue.
v Related log files, session files, configuration files, and data files.
v Information about your product and system environment, which you can obtain
as described in "System information."

System information
When you call IBM technical support, you might be asked to provide information
about your environment.
If your problem does not prevent you from logging in, much of this information is
available on the About page, which provides information about your installed IBM
applications.
You can access the About page by selecting Help > About. If the About page is not
accessible, check for a version.txt file that is located under the installation
directory for your application.

Contact information for IBM technical support
For ways to contact IBM technical support, see the IBM Product Technical Support
website: (http://www.ibm.com/support/entry/portal/open_service_request).
Note: To enter a support request, you must log in with an IBM account. This
account must be linked to your IBM customer number. To learn more about
associating your account with your IBM customer number, see Support Resources
> Entitled Software Support on the Support Portal.

© Copyright IBM Corp. 1999, 2015
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Notices
This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.
IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:
IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.
For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:
Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan
The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.
This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.
Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:
IBM Corporation
B1WA LKG1
550 King Street
Littleton, MA 01460-1250
U.S.A.
Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.
The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.
Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.
Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.
All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.
All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.
This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.
COPYRIGHT LICENSE:
This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
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platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.
If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at "Copyright and
trademark information" at www.ibm.com/legal/copytrade.shtml.

Privacy Policy and Terms of Use Considerations
IBM Software products, including software as a service solutions, ("Software
Offerings") may use cookies or other technologies to collect product usage
information, to help improve the end user experience, to tailor interactions with
the end user or for other purposes. A cookie is a piece of data that a web site can
send to your browser, which may then be stored on your computer as a tag that
identifies your computer. In many cases, no personal information is collected by
these cookies. If a Software Offering you are using enables you to collect personal
information through cookies and similar technologies, we inform you about the
specifics below.
Depending upon the configurations deployed, this Software Offering may use
session and persistent cookies that collect each user's user name, and other
personal information for purposes of session management, enhanced user usability,
or other usage tracking or functional purposes. These cookies can be disabled, but
disabling them will also eliminate the functionality they enable.
Various jurisdictions regulate the collection of personal information through
cookies and similar technologies. If the configurations deployed for this Software
Offering provide you as customer the ability to collect personal information from
end users via cookies and other technologies, you should seek your own legal
advice about any laws applicable to such data collection, including any
requirements for providing notice and consent where appropriate.
IBM requires that Clients (1) provide a clear and conspicuous link to Customer's
website terms of use (e.g. privacy policy) which includes a link to IBM's and
Client's data collection and use practices, (2) notify that cookies and clear gifs/web
beacons are being placed on the visitor's computer by IBM on the Client's behalf
along with an explanation of the purpose of such technology, and (3) to the extent
required by law, obtain consent from website visitors prior to the placement of
cookies and clear gifs/web beacons placed by Client or IBM on Client's behalf on
website visitor's devices
For more information about the use of various technologies, including cookies, for
these purposes, See IBM's Online Privacy Statement at: http://www.ibm.com/
privacy/details/us/en section entitled "Cookies, Web Beacons and Other
Technologies."

Notices
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